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Preface

This ASG-Alliance User’s Guide tells you how to use ASG-Alliance (herein called
Alliance). Alliance is the ASG-Existing Systems Workbench component that provides
you with application-wide understanding, documentation, impact analysis, and change
request assessment to help you effectively manage and maintain existing applications.
Alliance allows you to quickly and accurately perform application analysis tasks. It is an
accurate tool you can use to assess the resources required for application changes along
with the impact of proposed system changes and failures.

Allen Systems Group, Inc. (ASG) provides professional support to resolve any questions
or concerns regarding the installation or use of any ASG product. Telephone technical

support is available around the world, 24 hours a day, 7 days a week.

ASG welcomes your comments, as a preferred or prospective customer, on this
publication or on any ASG product.

About this Publication

This publication consists of these chapters:

. Chapter 1, "Overview: The Alliance Process," reviews the concepts of Alliance.

. Chapter 2, "Getting Started," describes how to initiate a session and validate user
options.

. Chapter 3, "Discovering the Nature of the Application," gives instructions on how
to use the Query and Search facilities, and describes synonym and homonym
relationships.

. Chapter 4, "Using the Query Facility," provides instructions on how to perform
queries and searches.

. Chapter 5, "Determining Impacted Components," describes the relational
assessment process, hierarchical relationships, referential symbols and default

information display options, and instructions on generating both summary and
detailed impact analyses.

. Chapter 6, "Modifying the Impact Analysis," describes the impact generate options,
and gives instructions on how to generate impact options and work with impact
lists.
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Related Publications

vi

The documentation library for ASG-Alliance consists of these publications (where nn
represents the product version number):

Note:

ASG-Application Definition and Analysis User’s Guide (ALL0200-nnr) which
provides information on defining, analyzing, and refining the application definition.

ASG-Alliance Installation Guide (ALX0300-nn) which provides information about
installing ASG-Alliance.

ASG-Alliance User’s Guide (ALX0200-nn) which provides information on the use
of ASG-Alliance.

ASG-Center Installation Guide (CNX0300-nn) which contains installation and
maintenance information for ASG-Center, the common set of libraries shared by the
ASG-Existing Systems Workbench suite of products.

ASG-ESW Enhancement Summary (ESW1000-nr) highlights the new functionality
for this release.

To obtain a specific version of a publication, contact ASG Customer Support.
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ASG-Existing Systems Workbench (ASG-ESW)

ASG-ESW (herein called ESW) is an integrated suite of components designed to assist
organizations in enhancing, redeveloping, or re-engineering their existing systems. ESW
products use the Application Knowledge Repository (AKR) to store source program
analysis information generated by the Analytical Engine. Figure 1 represents the
components of ESW.

Figure 1 + ASG Existing Systems Workbench

Existing Systems Workbench I

ASG-Alliance for Application Understanding

ASG-AutoChange for Mass Change Projects
ASG-Bridge for Conversion Projects
ASG-Encore for Evolving COBOL Programs
ASG-Center ASG-Estimate for Resource Estimation
ASG-Insight for Program Understanding
ASG-Recap for Portfolio Analysis

. . ASG-SmartDoc for Program Documentation
Analytical Engine |«

A4

ASG-SmartEdit for COBOL Intelligent Editing

ASG-SmartQuest for Analyzing Abends

Application
Knowledge
Repository (AKR) - TS0
- CICs

- IMS

- ASM

- APS

- PLI

- TCA for Test Coverage Analysis
- DB2 Stored Procedure

ASG-SmartTest for Testing/Debugging

vii



ASG-Alliance User’s Guide

viii

This table contains the name and description of each ESW component:

ESW Product

ASG-Alliance

Herein Called

Alliance

Description

The application understanding component that is
used by IT professionals to conduct an analysis of
every application in their environment. Alliance
supports the analysis and assessment of the
impact of change requests upon an entire
application. Alliance allows the programmer/
analyst to accurately perform application analysis
tasks in a fraction of the time it would take to
perform these tasks without an automated
analysis tool. The impact analysis from Alliance
provides application management with additional
information for use in determining the resources
required for application changes.

ASG-AutoChange AutoChange

The COBOL code change tool that makes
conversion teams more productive by enabling
quick and safe changes to be made to large
quantities of code. AutoChange is an interactive
tool that guides the user through the process of
making source code changes.

ASG-Bridge

Bridge

The bridging product that enables field expansion
for program source code, without being required
to simultaneously expand the fields in files or
databases. Because programs are converted in
smaller groups, or on a one-by-one basis, and do
not require file conversion, testing during the
conversion process is simpler and more thorough.

ASG-Center

Center

The common platform for all ESW products.
Center provides the common Analytical Engine to
analyze the source program and store this
information in the AKR. This common platform
provides a homogeneous environment for all
ESW products to work synergistically.
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ESW Product Herein Called  Description

ASG-Encore Encore The program re-engineering component for
COBOL programs. Encore includes analysis
facilities and allows you to extract code based on
the most frequently used re-engineering criteria.
The code generation facilities allow you to use the
results of the extract to generate a standalone
program, a callable module, a complement
module, and a CICS server. Prior to code
generation, you can view and modify the
extracted Logic Segment using the COBOL
editor.

ASG-Estimate Estimate The resource estimation tool that enables the user
to define the scope, determine the impact, and
estimate the cost of code conversion for COBOL,
Assembler, and PL/I programs. Estimate locates
selected data items across an application and
determines how they are used (moves, arithmetic
operations, and compares). Time and cost factors
are applied to these counts, generating cost and
personnel resource estimates.

ASG-Insight Insight The program understanding component for
COBOL programs. Insight allows programmers
to expose program structure, identify data flow,
find program anomalies, and trace logic paths. It
also has automated procedures to assist in
debugging program abends, changing a
computation, and resolving incorrect program
output values.

ASG-Recap Recap The portfolio analysis component that evaluates
COBOL applications. Recap reports provide
function point analysis and metrics information,
program quality assessments, intra-application
and inter-application comparisons and
summaries, and historical reporting of function
point and metrics information. The portfolio
analysis information can also be viewed
interactively or exported to a database,
spreadsheet, or graphics package.

ASG-SmartDoc SmartDoc The program documentation component for
COBOL programs. SmartDoc reports contain
control and data flow information, an annotated
source listing, structure charts, program summary
reports, exception reports for program anomalies,
and software metrics.

X
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ESW Product Herein Called  Description

ASG-SmartEdit SmartEdit The COBOL editing component that can be
activated automatically when the ISPF/PDF
Editor is invoked. SmartEdit provides
comprehensive searching, inline copybook
display, and syntax checking. SmartEdit allows
you to include an additional preprocessor (for
example, the APS generator) during syntax
checking. SmartEdit supports all versions of IBM
COBOL, CICS, SQL, and CA-IDMS.

ASG-SmartQuest ~ SmartQuest The diagnostic tool for analyzing batch and CICS
transaction abends. SmartQuest has been
designed to make the maximum use of simple
point-and-shoot techniques to enable fast and
easy navigation through any data dump.

ASG-SmartTest SmartTest The testing/debugging component for COBOL,
PL/I, Assembler, and APS programs in the TSO,
MVS Batch, CICS (including file services), and
IMS environments. SmartTest features include
program analysis commands, execution control,
intelligent breakpoints, test coverage, pseudo
code with COBOL source update, batch connect,
disassembled object code support, and full screen
memory display.

Invoking ESW Products

The method you use to invoke an ESW product depends on your system setup. If you
need assistance to activate a product, see your systems administrator. If your site starts a
product directly, use the ISPF selection or CLIST as indicated by your systems
administrator. If your site uses the ESW screen to start a product, initiate the ESW screen
using the ISPF selection or CLIST as indicated by your systems administrator and then
typing in the product command on the command line.

The product names can also vary depending on whether you access a product directly or
through ESW. See "ESW Product Integration" on page xi for more information about
using ESW.




Preface

To initialize ESW products from the main ESW screen, select the appropriate option on
the action bar pull-downs or type the product shortcut on the command line.

Product Name (ESW Name) Shortcut  ESW Pull-down Options
Alliance (Application Understanding) AL Understand » Application
AutoChange (Conversion Set) CC Change » Conversion Set
Bridge BR Change » ASG-Bridge
Encore (Program Re-engineering) EN Re-engineer » Program
Estimate ES Measure P ASG-Estimate
Insight (Program Understanding) IN Understand » Program
Recap (Portfolio Analysis) RC Measure » Portfolio
SmartDoc (Program Documentation) DC Document » Program
SmartEdit SE Change » Program

Or

Change » Program with Options

SmartQuest SQV Understand » Abend/Dump

SmartTest (Testing/Debugging) ST Test » Module/Transaction

ESW Product Integration

Because ESW is an integrated suite of products, you are able to access individual ESW
products directly, or through the main ESW screen. As a result, different fields, values,
action bar options, and pull-down options display on a screen or pop-up depending on
how you accessed the screen or pop-up.

Certain ESW products also contain functionality that interfaces with other ESW products.
Using SmartTest as an example, if Alliance is installed, SmartTest provides a dynamic
link to Alliance that can be used to display program analysis information. If Insight is
installed and specified during the analyze, the Insight program analysis functions are
automatically available for viewing logic/data relationships and execution path. For
example, the Scratchpad option is available on the Options pull-down if you have Insight
installed.

xi
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Access to these integrated products requires only that they be installed and executed in
the same libraries.

Example 1

Figure 2 shows the Encore Primary screen that displays when you access Encore directly.

The Encore Primary screen contains these eight action bar menu items: File, View,
Extract, Generate, Search, List, Options, and Help.

Figure 2 « Encore Primary Screen

File Uiew Edtract Generate 3Zearch List Options  Help

RAEG-EnCore
CoHAHand ===
etttk debebbk kbbbt Aottt
ettt Hbtebk bbbkl Atk
Atk Htebk Bass s S o s 2 Aotk
Atttk Atttk Atttk etk =tk
Attt
Atttk

Copwright Allen systeds Group, Inc., an unpublished wark.
A proprietary product of A%G, Inc.  Use restricted to authorized licensees.
Uizit the ASG Zupport Web Zite at www.asg.cod

Xii
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Figure 3 shows the Encore Primary screen that displays when you access Encore through
ESW by selecting Re-engineer P Program from the ESW action bar menu. Notice that the
Primary screen name changes to ASG-ESW - Program Re-engineering when you enter
Encore through ESW. Also, the Logic menu item displays if Insight is installed.

Figure 3« ESW Encore Primary Screen

File Wjew Extract Generate $£earch Logic List Options Help

AFE-EZN - Prograd Re—engineering

ComAand ===
ettt Hbtebk bbbkl Atk
Aottt Akt bbbk Aotk
Atttk Atttk Aotttk etk Atk
etk etttk Aotttk etk Aok
Atk
etttk

copwright ALlen SysteWs Group, INcC., an unpublished vork.
A proprietary product of A%G, IncC. Use restricted to authorized licensesaz.
Visit The ASE Support Web %ite at wuw,asg.coM

Figure 4 shows the File - Analyze Submit pop-up that displays when you access
SmartTest directly. Figure 5 on page xiv shows the File - Analyze Submit pop-up that
displays when you access SmartTest through ESW.

Figure 4 « File - Analyze Submit Screen

File - Analyze ZubMit
CorAdand ===

E - Edit TCL 2 - Eubnit TCL

CoHpile and link JCL [PDE o sequentiall:
Data =&t nade

Analyze features [v-M]:
AEG-EMartTests ¥ Extended Analysiss N

AKR data set nawe
AER prograd nane  NEWDEHO [if overriding PROGRAR-IO0)

Analyze options:

CoHpile? [Y<H] « v o« v o o o o i) [7¥ if needad bY features)
Link load Hodule reusable® [Y-M] Y

xiii



ASG-Alliance User’s Guide

The actions shown on these screens can also vary. For example, the D - Doc Options
action is only available on the File Prepare Program screen (or File - Analyze Submit
screen) if SmartDoc is installed on your system. In Figure 4 on page xiii, the Doc Options
action is not displayed.

Figure 5« ASG-ESW - Prepare Program Screen (accessed through ESW)

A%E-EZW - Prepare PrOgrand
CoHHand ===

E - Edit JCL F - EubRit TJCL 0 — Doc Options

CoHpile and link JCL [PDE o sequentiall:
Data set name

Analyze features [v-N]:
Understand: W Testl Y Extended Analysizs N DocuHent: M
Re-engineeri W Abend-<Dunp:

AER data et nane

AKR prograd nade  NEMDEHO [if overriding PROGRAR-ID0]

Analyze options:

CoHpile? (YNl o o o o o 0 o o ¥ [v if needed by features)
Link 1oad Hodule reusable® [Y-M] T [Test and Abend-ODuHp onlyl

Notice that the Analyze features field in Figure 5 lists additional ESW products than
shown on Figure 4 on page xiii. This field is automatically customized to contain the
ESW products you have installed on your system. These are the names of the analyze

types:
ASG-Encore Re-engineer
ASG-Insight Understand
ASG-SmartDoc Document
ASG-SmartQuest Abend/Dump
ASG-SmartTest Test

Extended Analysis (ASG-SmartTest with Extended Analysis
Insight installed)

Xiv
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ASG uses these conventions in technical publications:

Convention

Represents

ALL CAPITALS

Initial Capitals on Each Word

lowercase italic
monospace

Monospace

Vertical Separator Bar (| )
with underline

Underline

ASG Customer Support

Directory, path, file, dataset, member, database,
program, command, and parameter names.

Window, field, field group, check box, button, panel (or
screen), option names, and names of keys. A plus sign
(+) is inserted for key combinations (e.g., Alt+Tab).

Information that you provide according to your
particular situation. For example, you would replace
filename with the actual name of the file.

Characters you must type exactly as they are shown.
Code, JCL, file listings, or command/statement syntax.

Also used for denoting brief examples in a paragraph.

Options available with the default value underlined (e.g.,
YIN).

Denotes a cursor-selectable field or line.

ASG provides support throughout the world to resolve questions or problems regarding
installation, operation, or use of our products. We provide all levels of support during
normal business hours and emergency support during non-business hours.

ASG Third-party Support. ASG provides software products that run in a number of
third-party vendor environments. Support for all non-ASG products is the responsibility
of the respective vendor. In the event a vendor discontinues support for a hardware and/or
software product, ASG cannot be held responsible for problems arising from the use of

that unsupported version.

XV
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Intelligent Support Portal (ISP)

Online product support is available at: http://www.asg.com/support/support.asp via the
ASG Intelligent Support Portal (ISP). Your logon information for ISP online support is:

Customer ID = NNNNNNNNN
Password = XXXXXXXXXX

where:

NNNNNNNNNN is your customer ID supplied by ASG Product Distribution.
XXXXXXXXXX is your unique password supplied by ASG Product Distribution.

The ASG-Intelligent Support Portal User's Guide provides instructions on how to use the
ISP and is located on the ASG Support web page.

Telephone Support

Xvi

To expedite response time, please have this information ready:

Product name, version number, and release number

List of any fixes currently applied

Any alphanumeric error codes or messages written precisely as displayed
A description of the specific steps that immediately preceded the problem

Verify whether you received an ASG Service Pack or cumulative service tape for this
product. It may include information to help you resolve questions regarding installation of
this ASG product. The Service Pack instructions are in a text file on the distribution media
included with the Service Pack. You can access the latest software corrections and Service
Packs via the ISP.

The severity code (ASG Customer Support uses an escalated severity system to prioritize
service to our clients. The severity codes and their meanings are listed below.)

Severity Codes and Expected Support Response Times

Severity Meaning Expected Support Response Time
1 Production down, critical situation Within 30 minutes

2 Major component of product disabled Within 2 hours

3 Problem with the product, but customer has ~ Within 4 hours

work-around solution

"How-to" questions and enhancement Within 4 hours
requests


http://www.asg.com/support/support.asp

Preface

The Americas

Phone Fax E-mail

800.354.3578 1.703.464.4901

United States and
Canada

support@asg.com

Europe, Middle East, and Africa (EMEA)

During normal business hours, we recommend that you call the Central Support number
first (except in South Africa).

Phone Fax E-mail

Central Support 00.800.3544.3578 44.1727.812018 support.emea@asg.com
English 44.1727.736305 44.1727.812018 support.uk@asg.com
French 33.141.028590 33.141.028589 support.fr@asg.com
German 49.89.45716.200 49.89.45716.400 support.de@asg.com
Italian 39.0290450025 support.it@asg.com
Dutch 31.30.241.6133 support.nl@asg.com
Spanish 34.913.523.800 34917.156.961 support.es@asg.com
South Africa 800.201.423 support.sa@asg.com

Asia Pacific (APAC)

Phone Fax E-mail
Central Support 61.3.9645.8500 61.3.9645.8077 support.au@asg.com
Australia 800.637.947 61.3.9645.8077 support.au@asg.com
Hong Kong 800.96.2800 support.hk@asg.com
Japan 81.3.5326.3684 81.3.5326.3001 support.au@asg.com
Singapore 65.224.3080 65.224.8516 support.sg@asg.com

All Other Countries (Also for any non-working numbers)

Phone

Fax

E-mail

All other countries

1.239.435.2201

support@asg.com

If you receive a voice mail message, follow the instructions to report a production-down
or critical problem. Leave a detailed message including your name and phone number.
An ASG Customer Support representative will be paged and will return your call as soon
as possible. Please have available the information described previously when the ASG
Customer Support representative contacts you.

Xvii
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ASG Documentation/Product Enhancements

Xviii

Submit all product and documentation suggestions to ASG’s product management team
at http://www.asg.com/asp/emailproductsuggestions.asp.

If you do not have access to the web, FAX your suggestions to product management at
(239) 263-3692. Please include your name, company, work phone, e-mail ID, and the
name of the ASG product you are using. For documentation suggestions include the
publication number located on the publication’s front cover.


http://www.asg.com/asp/emailproductsuggestions.asp

Overview: The Alliance Process

This chapter presents an overview of Alliance in these sections:

About Alliance 1
Step 1 - Assessing Your Task 4
Step 2 - Defining the Application 4
Step 3 - Analyzing and Refining 6
Step 4 - Discovering the Nature of the Application 9
Step 5 - Running Queries or Using the Query Facility 10
Step 6 - Determining Impacted Components 11
Step 7 - Evaluating Components 13
Step 8 - Using Impact Analysis Results to Implement Change Request 15

About Alliance

Alliance assesses the impact of change upon your application and helps you accurately
determine the required resources. With Alliance, you have an automated, interactive tool
to analyze and understand the nature and relationships of application components.

[
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These are some of the benefits of using Alliance for your maintenance requirements:

Increased expediency. Using Alliance gives you increased expediency in modifying
your application. After you define and analyze the application, Alliance enables you to
spend less time manually determining the scope of a maintenance task.

Saved resources. Alliance saves resources in helping you determine how large the
requirement is. You no longer need to deploy an entire team to assess the task at hand.

Reduced errors. The potential of human error is reduced. With impact analysis results
generated by Alliance, you work from reliable data. As a result, the possibility of a
system failure when the change is rolled into a production environment is minimized.

Increased application information. The application information analysis results
Alliance provides gives you valuable maintenance tools for the application life cycle.
Reuse this base of information to expedite future change requests.

Enhanced understanding of application components. The analysis information
generated by Alliance, based on your application definition, provides a complete
understanding of the components that comprise your applications and the relationships
between those components.

The Alliance process is relatively simple. Nevertheless, ASG recommends you use the
default options until you can anticipate the result of changing those values. Altering
default settings can make these procedures unnecessarily time- and resource-intensive.

As illustrated in Figure 6 on page 3, you can outline the process in eight steps. These
guidelines facilitate your understanding of Alliance.

This publication gives detailed instructions on performing each step in subsequent
chapters, referenced under each heading. The ASG-Application Definition and Analysis
User’s Guide describes the first three steps in the Alliance process in full detail.



Figure 6 « Alliance Process Out

line
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Step 1 - Assessing Your Task

At this stage, define the assigned task and determine the affected applications and
components.

For step-by-step instructions, see the ASG-Application Definition and Analysis User’s
Guide.

Defining Your Requirements

Identify the change and impact upon the application. For example, you can determine
what components of the Manufacturing application are affected by euro conversion
processing, and use that information to develop a conversion project plan.

Gathering Information About Related Application Components

Begin gathering information to define the application to Alliance. This is an iterative
process. Record information about the application components and organize this
information using a series of worksheets. Copy and fill out the worksheets as needed to
begin the application definition process. See the ASG-Application Definition and
Analysis User’s Guide for more information.

Step 2 - Defining the Application

In Step 2, you create the initial application definition. First, allocate repository space for
data storage. This is called the Application Knowledge Repository (AKR). Then, define
the information gathered about the application to Alliance. This collection of information
establishes the application boundaries. Alliance identifies the components you have
targeted for assessment and generates the impact results within these boundaries.

Allocating Your AKR

The AKR is the repository for all of the information used by the ESW family of
components. The ESW provides you with both online and batch utilities for managing the
AKR. You can allocate a new AKR, or use an existing one. Each AKR can contain
multiple applications, or you can allocate separate AKRs for each application.
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An application is a group of programs and associated components that accomplishes a
particular function. You can group all of the applications used by a business unit within
an AKR. For example, typical applications within an accounting AKR could include
these items:

. Accounts Payable

. Accounts Receivable
. General Ledger

. Fixed Assets

. Inventory

. Purchasing

Also, you could allocate an AKR for each major business unit in your company (for
example, manufacturing, accounting, and sales) for management convenience.

After the AKR is allocated, you can start defining your application to Alliance.

For step-by-step instructions, see "Allocating the AKR" on page 181.

Establishing Application Boundaries

To establish the application boundaries, create an application definition, which is an
inventory of related programs and associated component definitions. Using this
inventory, Alliance executes an analysis to understand the application components and
relationships. Application definitions are reusable. You can open an existing one as well
as create a new one. You can also import an application definition from text files.

When you create the application definition within the AKR, specify these libraries and
members Alliance includes in its application analysis:

. Program source

. Load module

. JCL
. CICS
. IMS
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You can also specify attributes for each library and member in the definition. For
example, you could add this information:

. Analysis parameters

. Copy libraries

. Procedure libraries

. Macro libraries

. CA-IDMS information

If a library contains multiple categories of members (for example, PROGRAM and
INCLUDE members), you must define the library separately for each category.

Step 3 - Analyzing and Refining

At this stage, you analyze and refine the application definition. Building an application
definition is an iterative process.

These are the steps for building an application:

1 Run the analysis.

2 Review the results.

3  Make modifications.

4  Run the analysis again until you reach an accurate application definition.

When the Alliance Application Analytical Engine (AAE) analyzes the items in the
application definition, it determines the application components and their relationships.
The AAE also generates information about the definition. The first part of this
information contains statistics and diagnostics about the components that were analyzed.
The second organizes the analyzed components into three types: dead, discovered, and
missing. You can use both sources to refine the application definition throughout the
iterative process of defining an application.

With each analyze job, Alliance produces a summary report of analysis statistics and
diagnostic messages called the VIAARPT. This report helps you to understand how the
job ran, specifies the return code from the individual analysis of each member, and
identifies analysis errors (for example, you might forget to define a copy library or miss a
syntactic error). This file is temporary and is not stored in the AKR.
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Alliance identifies discovered, missing, or dead application entities inside your
application. With each analyze job, you can assess these components to determine their
validity. This verifies the accuracy of the collected data and allows you to discover
unaccounted aspects in the application.

Analyzing the Application

The analysis of your application is generated from the inventory of application
components specified in your application definition. Alliance performs these types of
analysis:

. Full analysis — analyzes every member in the application at one time, and can
require a large amount of resources.

. Incremental analysis — analyzes only the members you select. This analysis allows
you to perform your application analysis in phases to alleviate heavy resource
demands.

. Auto analysis — similar to an incremental analysis except the analyzer selects the
members that need to be analyzed. This analysis selects the members that you did
not analyze that contain bad return codes, or that you modified since the last
analysis.

Y ou must completely analyze an application to obtain accurate results from an impact
analysis. An analyze resource estimate table is located in the ASG-Application Definition
and Analysis User’s Guide.

The last step in the application process is Semantic linking, which determines how the
application components relate to each other. Semantic linking can be a resource-intensive
phase of the analyze job, and must be done before you can use the AKR for impact
assessment.

If you want to analyze a large application and lack the resources to run a full analysis,
disable the semantic linking option and perform an incremental analysis on sections of

your application while you refine your application definition.

These are the steps for performing an incremental analysis on sections of your
application:

1 Submit the selected components for analysis.
2  Review the results.

3  Modify the application definition.

4  Resubmit as necessary.

After creating an accurate application definition and analyzing all the components in the
application, enable the semantic linking option and run an analysis.
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Resolving Analysis Errors

Occasionally, lack of CPU time, low space allocation, and other operating system
problems prevent the application analysis from completing. However, you can restart the
analysis after resolving the problem, unless you change Alliance’s default setting for
recovery.

With each analysis, Alliance produces the VIALOG, a log file of errors, and the
VIAARPT, a summary report of run-time statistics and diagnostic messages. Use these
tools to find out why an error occurred, where it occurred, and to help you determine a
fix. Also, you can look up explanations in the online help or see the detailed listing
located in the ASG-Application Definition and Analysis User’s Guide.

Note:

Semantic linking is a common cause of abends stemming from excessive CPU usage.

Refine Definition

After you resolve all analysis errors, begin refining the application definition. First,
research the components the analysis detected as discovered, missing, or dead. Then,
rerun the application analysis, resolve errors, and research dead, discovered, or missing
components until you understand and accept these components, or there are none. A clean
output ensures the accuracy of a Alliance impact assessment.

Research Components Identified as Dead, Discovered, or Missing

The analytical engine produces these three component lists to assist you in refining the
application definition:

. Dead components—These components are in the application definition, but appear
unused by the other components. You might need to search for and add a
component that references the dead component. Review the dead component list to
determine if the components are used in any other application. If you are sure the
component is completely unused, you may want to remove it from the system.
However, delete unused components cautiously. Components that appear to be dead
may not actually be dead.

. Discovered components —These are components referenced in the application, but
not included in the application definition. For example, a load module execution in
your JCL that is missing from the application definition. Review the discovered
components list and determine if you need to add the discovered components and
attributes.

. Missing components —These components were present at the time of the original
definition, but can no longer be found. Perhaps you renamed or deleted a library.
Review the missing components list to determine if they were renamed. If a
component is renamed or deleted, remove the reference to the old name. Add a
renamed component to the definition with its new name.
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To refine the application definition, review each identified item to determine if any action
should be taken. After you refine the definition, resubmit the application for incremental
analysis and semantic linking. Then the application analysis is complete and you can
build the list of data items for an impact analysis.

Step 4 - Discovering the Nature of the Application

In Step 4, examine the application analysis results to familiarize yourself with aspects of
the application possibly impacted by the change. Now that the process of defining and
analyzing the application components has given you an understanding of the whole
application, evaluate the results to identify the components within the requirement
parameters.

Alliance includes a Query facility that generates cross-reference reports and Search
facilities that sort out equivalent components. Queries and searches are optional, but ASG
recommends you use them. They narrow the selection criteria and help you understand
the entities and relationships you want the Impact facility to analyze.

You can save all queries, searches, and impact analyses results for future use in one or
more sequential files, called worklists. After a worklist is open, information is
automatically saved when the display changes or the current activity ends.

Generating Cross-reference Reports

System cross-reference reports display application-level data, such as the dataset name,
the job name, and step name where the dataset is used. Program cross-reference reports
display program-specific (local) information, such as called and calling program and
copybooks in programs inside the application.

Alliance provides a set of template queries that address common questions. Run these
queries to display system-level and program-level cross-reference results on the
application in standard views. Later, when you are closer to determining the starting
points for impact assessment, use the Alliance query language to customize these
template queries, or to create new ones to show specific relationships.

For step-by-step instructions, see "Generating Cross-reference Reports" on page 26.

Running Searches

The search feature is an important factor in refining the scope of your analysis. For
example, use the search function to detect synonyms (components that contain the same
data) to reduce the number of entities selected for analysis without diminishing the
accuracy of the results. Use homonyms (components with the same name) to help
identify entities that should be analyzed.
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The Alliance search features enable you to conduct application-wide searches from the
Query or the Impact facility. Use the search function to locate specific entities and data
items matching the criteria strings you define.

These are the items Alliance evaluates when identifying synonyms:

. Assignments

. Parameters

. Renames and redefinitions

. Parents and children

. Indirect and implied dependencies

. Utilities

When identifying homonyms, Alliance detects data items with the same name.

Synonyms and homonyms exist at both application and program (local) levels.

For step-by-step instructions, see "Running Searches" on page 32.

Step 5 - Running Queries or Using the Query Facility

10

At this stage, identify the components possibly impacted by the change and submit the
list to the Alliance Impact facility. This list is called the impact entity list (or simply the
impact list). The more narrow the scope of the analysis with a precise impact list, the
more accurate the information obtained for impact assessment.

These are the steps for limiting the impact analysis to relevant entities:

1 Build an impact list consisting of pairs of entity kinds and unique names that match
your defined selection criteria. The objective is to build an impact list based on the
understanding gained in "Step 4 - Discovering the Nature of the Application" on

page 9.

2 Customize the Alliance standard queries to display application information about
specific entities you want included in the analysis.

3 Use the search feature to refine the entities included in the analysis.
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After determining the combination of entity kinds and unique names to include in the
impact list, Alliance matches the impact list against the open application to derive a list of
components for impact analysis. The selections you make from this list, also known as
the selection list, are the starting point for the impact analysis evaluation of all
relationships. Selecting items for the base selection list is the first action of "Step 6 -

Determining Impacted Components" on page 11.

Performing Custom Queries

The next step is to uncover more details by modifying existing queries or creating new
ones based on the information gathered through standard queries and searches. For
example, you might want to look up specific entities and their relationships.

Construct custom queries using the syntax supported by Alliance. An Alliance query
consists of these two definition blocks:

. The ENTITY RELATIONSHIP BLOCK — names the application entities (such as
programs, FDs, PROCs, and JCL) included in the query and the relationships used
in the search for application information.

. The ATTRIBUTES BLOCK — enables you to select data to be included in the
query results and to format the display differently than the default format.

For step-by-step instructions, see "Performing Custom Queries" on page 47.

Searching for Specific Entities

After extracting system and program cross-reference data from the application analysis
results, use the advanced search options to locate specific entities possibly impacted by
the change. You can conduct application-wide searches for specific entities, entity kinds,
and literal search strings from the Impact or Query facility.

These searches enable you to track individual entities, entity groups, and the occurrence
and location of literal strings. These search results contribute to the field of entities to
determine the starting points for the impact list.

For step-by-step instructions, see "Searching for Specific Entities" on page 72.

Step 6 - Determining Impacted Components

At this stage, generate the first round of impact analysis results based upon the list of
items selected for impact assessment. The Alliance impact analysis automates the
research process necessary to investigate the impact of change on an application. It
evaluates the dataflow and logical and physical relationships to determine the impact of
changes on an application.

11
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Alliance produces both summary and detailed impact analysis information. The summary
impact analysis identifies components impacted by the change. The detailed impact
analysis explains the summary analysis results and shows the physical, logical, and
dataflow relationships transversed. The summary and detailed analyses output displays
on the Impact Facility screen. You can save the results of each impact analysis to a
worklist.

Like the application definition, impact analysis is an iterative process. For example, after
reviewing the components in the summary analysis, you might use the detailed impact
analysis to examine the impact relationship of each component. Evaluating the impact
results may lead you to change some settings for impact generate or display options, and
modify the base selection list. Then, you would run the impact analysis again.

Building List of Possible Targets

You can build an impact list with unique entities that are affected by the change after you
determine the components of interest for the change request. Unless you want to include
all the entity kinds in your application in the impact list, you must define selection criteria
to limit the number of entities the impact analysis targets. To use the selection criteria,
specify the full name of each impacted entity kind, or use text patterns to identify entity
groups.

You can generate a new impact list each time you run the impact analysis on an
application, or you can save the impact list to a worklist for future use in this or other
impact analyses. After you specify an impact list, you can create the base selection list the
Impact facility uses to evaluate all relationships.

For step-by-step instructions, see "Building the List of Possible Targets (Impact List)" on

page 75.

Selecting Items to be Analyzed

12

After you specify the type of impact analysis (detailed or summary) the Impact facility
matches the entities in the impact list to those in the open application to create a list of
targets to select from. The components you select comprise the base selection list.

After you select entities for the impact analysis, specify the scope of the analysis by
defining impact generate options. These options control how the impact analysis
evaluates data flow and hierarchical relationships. If this is an initial impact analysis,
ASG recommends you use the defaults for these options. After you set the impact
generate options, start the impact assessment.

For step-by-step instructions, see "Selecting Items to be Analyzed" on page 82.
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Determining Impacted Components and Relationships (Summary Impact

Analysis)

The summary impact analysis lists all of the components affected by the proposed
change. It also displays the summary information for each impacted entity kind and the
number of occurrences for each. From this information, you can determine the task size
and the resources needed for implementation. After you review the list of impacted
entities and the number of changes involved, expand the summary information through
detailed analysis to see how these impacted entities were found, and how they are related.
For step-by-step instructions, see "Locating Impacted Components and Relationships

(Summary Impact Analysis)" on page 83.

Listing Relationships of Impacted Items (Detailed Impact Analysis)

The detailed impact analysis displays the paths taken to generate the summary analysis
results. The display is hierarchical, with each level representing an impact relationship
path to a new component. Follow the path of a component by expanding and collapsing
the display. You can also display the Detailed Information pop-up that contains data
about the component at the cursor location.

Alliance builds impact analysis by layering related components. The detailed analysis
shows what each layer is and why the layer was applied to the member of the base
selection list.

Various options control the information shown for each entity. The defaults are name,
entity kind, and containing component. You can change the detailed impact options to
display additional information to the right of the original entity in the Impact Facility
screen.

After you generate the impact analysis results, you can evaluate the impacted
components.

For step-by-step instructions, see "Listing the Relationships of Impacted Items (Detailed
Impact Analysis)" on page 85.

Step 7 - Evaluating Components

At this stage, evaluate any components in the impact analysis results that warrant further
investigation. This evaluation leads to these two choices:

. Determine if the hierarchical and data flow relationships traversed during impact
analysis need to be adjusted. To do this, change the Impact Generate options.

. Alter the base selection list and/or the items in your impact list.

13
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The second choice is recommended because you should change the Impact Generate
options cautiously. Inappropriate use can cause inaccurate results and tie-up system
resources.

Changing the Impact Generate Options

The impact generate options affect the way the impact analysis traverses the data flow
and the hierarchical component relationships. For example, you might decide to include
entities that the base selection member assigns value to or from, or to include data
movement and comparison within programs for statements other than direct moves (i.e.,
alternate assignments).

For step-by-step instructions, see "Changing Impact Generate Options" on page 97.

Refining the Base Selection List

In some cases, you may need to change the components of the base selection list to
include data that was not included in a previous analysis. For example, you might find an
item that is not needed in the impact assessment and decide to remove it from the base
selection list. Or, you might decide to add items to the impact list you did not initially
plan to analyze.

For step-by-step instructions, see "Refining the Base Selection List" on page 110.

Rerunning the Impact Analysis

14

The last step of this iterative process is to rerun the impact analysis until you gather
enough data to proceed with the change. Rerun the Alliance impact analysis after you
perform these tasks:

. Finish reviewing the results of the last impact analysis.
. Finish investigating the paths traversed by components related to the change.

. Verify that the impact generate options or the base selection list require no changes.

The results of the final iteration of this process shows all application components
impacted by the change.

For step-by-step instructions, see "Rerunning the Impact Analysis" on page 113.
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Step 8 - Using Impact Analysis Results to Implement Change
Request

At this stage, begin organizing and implementing the change request. Prior to performing
any other action, save the impact analysis results from the final iteration of the process to
a worklist.

Assessing Project Size

Use the entity counts in the impact analysis results to provide an immediate indication of
the size of the task.The capability of the available resources and the complexity of the
change request must also be given consideration, but are outside the scope of this
discussion.

Determining and Assign Resources

Assign resources to implement the change. You can break the worklist up and distribute it
to the assigned resources so that each has an exact list of the components that they are
responsible for changing.

Evaluating Individual Tasks

Prior to implementing the change, execute a detailed impact analysis against the
individual components to show how each component relates to the application
components. The Query facility reveals specific relationships of interest. Additionally,
you can use the Search facilities to further clarify the role of the component being
changed.

15
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Getting Started

This chapter describes how to initiate Alliance and set user options, and consists of these

sections:
Section Page
Initiating a Session 17
Verifying User Options 18

Initiating a Session

Note:
The method you use to start ESW products depends upon your system configuration.

To start Alliance directly, follow this step:

» Use the ISPF selection or CLIST, as indicated by your systems administrator. After you
activate the session, the Alliance Primary screen displays.

To use the ESW screen to start individual products

1 Initiate the ESW screen using the ISPF selection or CLIST, as indicated by your
systems administrator.

2 Select Understand P Application from the ESW Primary screen to start the product.

The ESW - Application Understanding or Alliance Primary screen displays. During the
installation, ESW product options are customized for your site. If you are using the
product for the first time, you might want to perform the procedures in the next sections
to ensure that installation defaults meet your needs.
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Verifying User Options

During installation, options that define the operating environment are set to default
values. These are the options that you can modify:

Product parameters that control Alarm settings and the use of confirmation pop-ups
Product allocation of DASD information for the log, list, and work files

Log and list file processing options

Script file allocations

PF key assignments

Specifying Product Parameters

18

To verify or change product parameters

1

Select Options » Product parameters from the Alliance Primary screen and press
Enter. The Options - Product Parameters pop-up displays (see Figure 7).

Figure 7 « Options - Product Parameters Pop-up

Options - Product Parameters
Command ===

Specify parameter information.

Alarm . « +« « « . . ¥ES  (¥essMo)

Confirm submit . . WO i¥esfNo Confirmation displayed before Submit)
Confirm delete . . ¥YE: (¥essNo Confirmation displayed hefore Delete)
AMF %tats Required YEE® (YessMo If I[SPF Stats required for AMF)
Confirm save . . . ¥ES (¥Yess/Mo Sawve results to Work List)

Review the information and make any necessary changes.

Specify whether the Application Maintenance Facility (AMF) requires the ISPF
statistics (time datestamp) to determine if a source member was modified.

Choose NO for the AMF Stats Required Field to allow the AMF to use a potentially
expensive calculation to determine if members without ISPF statistics were

modified.

See the ASG-Application Definition and Analysis User’s Guide for more details.

Press PF3 to save changes and exit.
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Specifying Product Allocations

Use product allocations options to specify the product allocations of DASD information
for the Log, List, and Work files.

Alliance allocates the Log file if it encounters an internal error, such as an abend. The
Log file contains ESW error messages. The List file contains printed output and is
allocated when you issue a request to print.

The analysis work file is a temporary AKR file that contains intermediate results while an
analyze job is running. This file should be as large as the space requirements for the
application itself. Use the other work file parameters for other temporary files allocated
during other processing.

To verify product allocation settings

1 Select Options » Product allocations from the Alliance Primary screen and press
Enter. The Options - Production Allocations pop-up displays (see Figure 8).

Figure 8 « Options - Product Allocations Pop-up

File Edit VYiew Facility Options Help

Options - Product Allocations
Command ===

Specify allaocation infFormation.

Log File List File

Gereric unit . . . SRTDA STS0A [Group name or unit address)
Volume serial . . . SRTSO1 SRTS01 (Blank for default wolume)

(Analysis) Work File Work File [Other)
Gereric unit . . 5rsha SVSDA LGroup hame or unit address)
Volume serial o o 0 - ______ (Blanl: for default wolumes)
Space wnits . . . . CTLS CYLS LELKS, TRES ar CYLS)
Primary space . . . G5O 5 [Space units)
Secondary space . . GO1@ 5 [Space units)

Alternate node . . ________

2 Review the information and make any necessary changes.
3 Press PF3 to save changes and exit.

Processing Log and List Files

Use Log and List file processing options to specify the settings for processing the Log
and List files. The Options - Log/List Definition pop-up also defines printing or deletion
options.

19



ASG-Alliance User’s Guide

To verify or change the setting for processing

1 Select Options » Log/List from the Alliance Primary screen and press Enter. The
Options - Log/List Definition pop-up displays (see Figure 9).

Figure 9 « Options - Log/List Definition Pop-up

Options - Log-List Definition
CoHAand ===}

specify Log-List options. Then press PF key fob action.

nptions Log List
Process option . .« . . . . E FO
Prinary tracks | 1
Eecondary tracks . 2 5
Lines per page . . . . . . 56 56
Eyzout Class . . . w0 ow s * *

Process options: PE [print<keep], PO [print-delete], K, or O.

Tob statedent infordation:
<-UIALZZ  TOB [DEUTRE,253200],

e HEGCLASE=A
£ IMZERT '~ROUTE PRIMNT MODE.UZER' HERE IF MEEDED.
sk

PFd=Cu=stodi zed MaWes PF3=Proces= 1og file PFesProcess list file

2 Verify that the allocation and disposition choices conform to your site standards and
make the necessary changes.

3 Enter the appropriate information in the Job statement information field, if required
for printing the Log or List file.

4  Press PF3 to save changes and exit.
To customize the Log or List dataset name
1 Specify the K or PK process option on the Options - Log/List Definition pop-up.

2 Customize the dataset where the log or list file is allocated. By default, Alliance
allocates the Log, and List files with this syntax:

USERID.ALNnnnnn . VIAXXXXX

where:

nnnnn is a sequential number from 00001 to 99999.
xxxxx 18 LOG for Log and LIST for List files.

If you specified a TSO prefix, the prefix appends to the beginning of the file name
allocated for the Log and List files.

20
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To define a dataset name

1

From the Options - Log/List Definition pop-up, press PF4. The Options - Log/List
Name Customization pop-up displays (see Figure 10).

Figure 10 « Options - Log/List Name Customization Pop-up

gptions - Lag-List MaHe CustoHdization
CoMHand ===

You can define a custonized name when wou choose option PR [print<kespl or
K [kespl by specifying Ulser]. Specifying Y(es] on ProWpt later lets wou
define a CUstod naHe as wou process each logslist file. Otherwise,
specify data set name and file Hode. Then press Enter.

options Log List
File MaHing « « « « « = = E E Ul=er] or Z[usted]
ProHpt later for DEN . . . Yles] ar Nlo)

The following are needad if U[ser) and Wio) are specified aboue

Log Data set naMe [2aq]
File Hode . . _ olvervritel or Alppend]

Li=t Data =zet nawWe [Zeq)
File Hode . . _ olverwrite] or Alppend]

Type U in the File Naming field for Log and/or List to indicate a user-defined dataset
name and press Enter.

If you specify N in the Prompt later for DSN field, you must enter a dataset name in
the corresponding Dataset name field, and specify Overwrite or Append in the File
Mode field.

If you specify Y in the Prompt later for DSN field, Alliance prompts you for the
dataset name during file processing. For example, if you specify Yes in the Prompt
later for DSN field for the Log file, the Log Name Customization pop-up displays

(see Figure 11).

Figure 11 » Log Name Customization Pop-up

Log Mame Custodization
CoMHand ===

The current log file's data set name iz shown below. To khave 3 CustoM
naHe, specify a new sequential data zet naWe. IFf it already edists, it
has to have LRECL=137 and RECFH=V'; and specify the file HOode. Then press
Enter.

current Data set nawe I '
Custod Data set nane
File Hode . . . _ ofverwrite]l or Alppend]
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Allocating Script Files

22

A script file automates a sequence of commands and screen interactions. Typically, you
use a script file for Batch processes, such as definition changes or Batch queries.

During the installation, you specify default script files for the site. Script file allocation
options specify the default dataset names or the concatenation sequence for your session.

To display or change the script files

1 Select Options P Script file allocations from the Alliance Primary screen and press
Enter. The Options - Script File Allocations pop-up displays (see Figure 12).

Figure 12 « Options - Script File Allocations Pop-up

Options - Script File Allocations
Command ===%

R - Restore default Script allocations
Enter desired Script file concatenatiaon.

Script file data set names:

2 Review the current default script file dataset names.

Note:

When initializing for defaults, the lines are filled from the bottom to allow
concatenation.

3 Enter the dataset names for the new script files in the Script file dataset names field,
if needed. The files are concatenated in the order entered.

4  Type R on the command line and press Enter to restore the default.

5  Press PF3 to save any changes and exit.



2 Getting Started

Assigning PF Keys

PF key assignment options specify PF key functions. Figure 13 shows the Options - PF
Key Definition pop-up with default settings. These default PF key assignments apply
only if no PF key assignments are listed in the screen or pop-up. Fixed PF key
assignments listed at the bottom of screens and pop-ups override these defaults.

Figure 13 » Options - PF Key Definition Pop-up with Default Settings

Options - PF Key (B1-12) Definition
Command ===%

Press Enter to process changes andfor to display alternate keys.
Press PF3/15 (END) to exit.

Humber of PF keys: 12 Terminal type: 3278

PFE1 HELP
PFOZ SPLIT
PFE3 END
PFEd4 RETURN
PFES RFIND
PFOE RCHAMGE
PFET UP
PFEE DOWH
PFE3 SWAP
PF10 LEFT
PF11 RIGHT
PF12 CAMCEL

To verify the current PF key assignments

1 Select Options » PF keys from the Alliance Primary screen and press Enter. The
Options - PF Key Definition pop-up displays showing current PF key settings.

2 Type over the current setting to change the function of a PF key.

3 Press PF3 to save changes and exit.
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Discovering the Nature of the Application

This chapter describes how to use the Query and Search facilities, defines synonym and
homonym relationships, and contains these sections:

Section Page

Generating Cross-reference Reports 26
Running Searches 32
Saving and Printing Query/Search Results 43

As described in the overview, Alliance includes a Query facility that allows you to
generate cross-reference reports on the results of the application analysis. After you refine
the definition of the application, identify components possibly impacted by the change.
You can then use this information to specify selection criteria for the entities you want the
Impact facility to analyze.

Save the results of each query to one or more worklists so you can access the data when
building the list of possible candidates for the impact analysis. After you open a worklist,
Alliance automatically saves the information when the display changes or the current
activity ends.

Alliance also provides Search facilities that identify components that contain the same
data, have the same name, or make use of literals. You can use this information to refine
the candidates for impact assessment. Use both the Impact and the Query facility to
perform searches.
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Generating Cross-reference Reports

Alliance provides a set of cross-reference reports, or template queries, that answer
common questions about the components in the applications. System cross-reference
reports provide information about system-level components in the application (e.g.,
databases, jobs, and library members). Program cross-reference reports provide
information about programs and the components related to and contained within
programs [e.g., data items, records, and copymembers (includes)].

After you review the application components through these standard views and are closer
to determining the starting points for impact assessment, use Alliance’s query language to

customize these template queries or to create new ones that display specific relationships.

For step-by-step instructions, see "Using the Query Facility" on page 47.

Generating System Cross-reference Reports

26

To generate a report with system cross-reference information

1 Select View » System Cross Reference Information from the Alliance Primary
screen and press Enter. The System Cross Reference Information pop-up displays.

These are the available system cross-reference reports:

Report Name Displays

CICS File cross-referenced by ¢ CICS file DD

Program . Program

CICS Map cross-referenced by «  CICS maps

Program . Mapsets
. Program names
DSN cross-referenced by Job ¢ DSN

. DD

. STEP name

. JOB name

. PROC name

. PROC STEP

. PROC JOB name




3 Discovering the Nature of the Application

Report Name Displays

DSN cross-referenced by ¢ DSN
Copybook . Record

. Size

. Copybook
IMS DBD cross-referenced by ¢ IMS DBD
Segment . Segment

. Segment fields
IMS PSB cross-referenced by ¢ IMS PSB
Program .

Program name

Job cross-referenced by JCL
library

JOB name
JCL library name

Member name containing the JCL

Job cross-referenced by * JOB library DSN
JOBLIB . JOB name
. JOB name

Job cross-referenced by Load
Module

JOB STEP name

Load Module name

If a PROC is executed:

PROC name
PROC STEP
PROC STEP load module

Member containing the job
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Report Name Displays

Job cross-referenced by . JOB name

STEPLIB «  JOB STEP name
. JOB STEP STEPLIB DSNs
If a PROC is executed:
. PROC name
. PROC STEP
. PROC STEP STEPLIB DSNs
Job cross-referenced by FD * JOB name

. JOB STEP name
. JOB STEP DD name
. FD name

. FD within the executed program
associated with the DD

. Records defined to the FD within the
executed program

If a PROC is executed:

. PROC name

. PROC STEP name

. PROC STEP DD name

. FD within the executed program
associated with the DD

. Records defined to the FD within the
executed program

JOBCAT cross-referenced by Job  * JOBCAT DSN
. JOB name

Load Module cross-referenced by ~*  Load module name

CSECT . CSECT name, and optionally, the

CSECT source library name

. Source library member name
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Report Name Displays

Load Module cross-referenced by
Job

Load module name
STEP name executing the load module

JOB containing STEP executing the
load module

If the STEP executing the load module is
contained in a PROC, lists:

STEP executing the PROC

JOB containing the STEP that
executed the PROC

DD and DSN used by the STEP

PROC cross-referenced by Load ¢
Module

PROC name
STEP name

PROC load module executed in the
STEP

PROC Library where the PROC
resides

STEPCAT cross-referenced by Job *

STEPCAT DSN
JOB using the STEPCAT
STEP name

Select one of the listed reports and press Enter.

Note:

For step-by-step instructions on saving and printing query information, see "Saving
and Printing Query/Search Results" on page 43.

Press PF3 to close the report and return to the previous screen.
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Generating Program Cross-reference Reports

30

To generate a report with program cross-reference information

1

Select View » Program Cross Reference Information from the Alliance Primary
screen and press Enter. The Program Cross Reference Information pop-up displays.

These are the available program cross-reference reports:

Report Name Displays

Called program
cross-referenced by Caller

CALLed program entry name

CALLed program name, and
optionally, CALLing program name

Source library name where CALLed
program resides

Member name in source library

Caller program
cross-referenced by Called

CALLing program name

CALLed program entry name, and
optionally, CALLed program name

Source library name where
CALLing program resides

Member name in source library

CICS Transactions cross-referenced
by Program

Transaction name

Program name containing the
transaction

Source library where program
resides

Member name in source library

Copybook cross-referenced
by Program

Copybook name

Name of program using copybook,
and optionally, the member and
library where copybook resides
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Report Name Displays

Data item cross-referenced * Data item name

by Program +  Program name containing data item

definition

. Source library where program
resides

. Member name containing the

program
FD name cross-referenced FD name using the record
by Record . Record name

. Data item names in record

. Program name containing FD
Program cross-referenced *  Program name

by CICS transaction . CICS transaction executing the

program
Program cross-referenced y Program name
by File . FD name within program
. DD name associated with the FD in
the execution JCL
. DSN associated to the DD in the
execution JCL
Program cross-referenced y Program name
by Copybook . Copybook used by program
. Program source library name
. Member name of program in source
library
Program cross-referenced y Program name
by Data item . Dataname

. Copybook containing the data item
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2 Select a report and press Enter.

Note:

For step-by-step instructions on saving and printing query information, see "Saving
and Printing Query/Search Results" on page 43.

3 Press PF3 to close the report and return to the previous screen.

Running Searches

The Alliance search function familiarizes you with the application components possibly
impacted by the change. You can conduct application-wide searches from the Query or
the Impact facility to isolate the specific components that match the criteria you define.
Save all of the search results to a worklist to use them when you determine the list of
components possibly impacted by the change.

Searches help you to determine the components to use for impact analysis. To reduce the
number of entities selected for impact analysis without affecting the accuracy of the
change assessment, identify synonyms (components that contain the same data) before
submitting the list of impacted items for analysis. Identify homonyms (components with
the same name) to find components with the same use.

To find additional items requiring impact analysis, identify components that use literals
related to the change request. Run searches to narrow the focus of your understanding of
the application to the components surrounding the change request. For step-by-step

instructions, see "Searching for Specific Entities" on page 72.

Understanding Synonym Relationships

32

These are the relationships Alliance evaluates when identifying synonyms:

. Assignments . Implied dependencies
. Parameters . Indirect dependencies
. Renames and redefinitions . Utilities

. Parents and children

Synonyms and homonyms exist at both application and program (local or global) levels.
The same relationships occur at each level and you can specify local, or both local and
global levels for each search. Application level synonyms expand the scope of the search
to the entire application. Use program level synonyms to limit the search to a single
program. This eliminates components outside the selected program from the results. The
results reference globally-visible components that have a synonym relationship within the
program.
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Figure 14 illustrates application and program level synonyms.

Figure 14 « Application and Program Level Synonyms

PGM1
FD XYZ.

01C.
05 A1 PIC X(2).
05 A2 PICX (2).

01A  PICX@)
77B  PICX().

.I\./iOVE ATOB.
MOVE B TO C.
WRITE C.

SELECTS =

DD1

| DSN=ABC.XYN.DSN |

DD2

I~

PGM2
FD XYZ.
|~ SELECTS DD2
01z
05 A1 PIC X(2).
05 A2 PIC X (2).

01Y  PICX@).
772 PICX@).

READ XYZ.
MOVE ZTO Y.
MOVE Y TOX.

Application Level Scope

Program Scope for PGM1

C.

“
&

<

Program Scope for PGM2

-

@

@

Local Synonyms for A of PGM1

B
Cc

Local synonyms will not include
the connection from C to Z,
because it is outside the scope

of PGM1.

Application Level Synonyms for A of PGM1

X<NO®@

For example, if A is the Employee Name field and B the 401K Participant field, and the

data in B comes from A, A and B are synonyms. The synonym relationship is
independent of the direction of the data movement between them.

You can control how Alliance calculates synonyms by specifying options to the
application analytical engine before you submit the application definition for analysis.
For step-by-step instructions on changing analyze options, see the ASG-Application

Definition and Analysis User’s Guide.
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Assignments

34

When Alliance finds a component directly assigning data to another it defines those

components as synonyms.

Figure 15 illustrates a synonym relationship by assignment.

Figure 15 « Synonyms - Assignment

MOVEATOB

/N

A and B have a direct relationship, A and B are Synonyms.

Alliance recognizes these statements as data movement between components:

NATURAL COBOL PL/T CICS IDMS MS SQL
ACCEPT ACCEPT ALLOCATE SEND MAP ACCEPT INSERT FETCH
COMPRESS MOVE ASSIGN RECEIVE MAP | END GET UPDATE

CORRESPONDING TRANSACTION
GET MOVE DECLARE WRITE WRITE REPLACE
GET SAME READ DELETE READ FIND
GET REWRITE LOCATE READPREV OBTAIN
TRANSACTION
DATA
INPUT WRITE READ READNEXT GET
REINPUT SORT RETURN REWRITE
SEPARATE MERGE REWRITE
MOVE RETURN WRITE
MOVE ALL RELEASE
READ
READ WORK FILE
WRITE
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Parameters
Alliance recognizes actual and formal parameters as synonyms.
Figure 16 illustrates a synonym relationship by parameters.
Figure 16 » Synonyms - Parameters
PGM1 PGM2
CALL PGM2 USING(A) PROCEDMRE DIVISION
A
) \ USING
Actual Parameter =z
Formal Parameter
A and B refer to the same data, A and B are Synonyms.
File I/O

Notice that you make the connection from the DD selected within the program to a DD
defined within the execution method (e.g., a JCL job) by understanding the load module
referenced in the execution method. The load module is affiliated to the program source
code and the selected DD within the program is associated to the DD within the execution
method.

To make this synonym relationship you must first properly define the load module for the
source to the application and define the method of executing the load module to the

application inventory (e.g., the execution JCL).

Figure 17 illustrates a synonym relationship by affiliation.

Figure 17 « Synonym Relationship by Affiliation

| DSN - XYZ.EMPLOYEE.DATAFILE |

/ N\

| DD - EMPDATA | | DD - EMPDATA |
| FD - OUTFILE I( )I FD - INFILE |

OUTFILE and INFILE
refer to the same data,
OUTFILE and INFILE are synonyms.
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Renames and Redefinitions

When component A is renamed or redefined as component B, the two components share
the same data and are synonyms. Figure 18 illustrates a synonym relationship by
rename/redefinition.

Figure 18 » Synonyms - Renames and Redefinitions

01 A PIC X(6).

05 B1 PIC X(3).
05 B2 PIC X(3).

|—- 01 B REDEFINES A.

A and B will share the same data, A and B are synonyms.

Parents and Children

In a hierarchical data structure, you can define parent and child components as synonyms
when the data they contain overlaps exactly. For example, if A is the parent and B is the
only child of A, A and B are synonyms.

Figure 19 illustrates a synonym relationship by hierarchical definition.

Figure 19 « Synonyms - Parent/child Hierarchy

01 A
05 B.

> [10c1PIC X3).[] ¢
10 C2 PIC X(3).| |~

A and B refer to the same data, A and B are synonyms

Indirect Dependencies

When you define two components as synonyms, the synonyms of one become the
synonyms of the other. For instance, when A and B are defined as synonyms, all
synonyms of A indirectly become synonyms of B.
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Figure 20 illustrates a synonym relationship by indirect dependency.

Figure 20 « Synonyms - Indirect Dependencies

MOVEATOB
MOVEBTO C

Working from the previous example, a direct synonyms relationship
exists between A and B. The second statement creates a direct
synonyms relationship between B and C.

MOVEATOB
MOVEB TO C

The relationship between A and B, and B and C causes an indirect
dependency between A and C, through B.

When two components are identified as synonyms, synonyms of one become synonyms
of the other. These relationships are indirect dependencies regardless of the direction of
the assignment chain. When A and B are defined as synonyms, all synonyms of B
become indirect synonyms of A.

Figure 21 illustrates a multi-level synonym relationship by indirect dependency,
regardless of the direction of the relationship.

Figure 21  Indirect Dependencies - Multiple Levels

MOVEATOB /\/\/-\
MOVEBTO C
MOVECTOD

MOVE E TO D

C, D and E have an indirect relationship to A.

A, B, C, D and E are synonyms of each other. Note, E is indirectly
related to A regardless of the direction of the data flow.
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Implied Dependencies

38

When two components are identified as synonyms, and each component has hierarchical
children, the children of each component are checked for size and offset to determine if
they are synonyms of the other component’s children. When A and B are defined as
synonyms, Al is checked against B1, A2 is checked against B2, and so on. For example,
each child of A is compared to the children of B for size and offset to determine if the

compared items are synonyms of each

Figure 22 illustrates synonym relationships by implied dependency.

other.

Figure 22 » Implied Synonyms from Hierarchical Children

01 A.
05A1 PIC X.
05A2 PIC X(2).
05A3 PIC X.

01 B.
05 B1
05 B2
05 B3
05 B4

A1 size: 1
offset: 0
A2 size: 2
offset: 1
A3 size: 1
offset: 3

PIC X.

PIC X

PIC X.
PIC X.

¥\

MOVEATOB ° °

Aand B
are synonyms

A1 and B1 B1 size: 1
are synonyms offset: 0
A2 and B2 B2 size: 1
are NOT offset: 1
synonyms
A3 and B4 B4 size: 1
are synonyms offset: 3




Using Utilities
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When an input file passes data to an output file through a utility program, the files are
considered equivalent and are identified as synonyms.

This table lists the utilities Alliance supports and the names of their input and output files.
Field rearrangement by the utilities is not supported.

Utility DD for Input File DD for Output File
ICEMAN SORTIN SORTOUT, SORTOFnn
IDCAMS (all) (all)

IEBCOPY SYSUTn SYSUTn

IEBGENER SYSUTn SYSUTn

IERRCO00 SORTIN SORTOUT, SORTOFnn
IGHRCO00 SORTIN SORTOUT, SORTOFnn
SORT/MERGE SORTIN SORTOUT, SORTOFnn
SYNCSORT SORTIN SORTOUT, SORTOFnn

Searching for Application Level Synonyms

Perform searches from both the Impact and the Query facility. You can access these
facilities from the Facility pull-down on the Alliance Primary screen.

To search for application-level synonyms

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

Select Search » Synonyms and press Enter.

Select Data Item Synonyms » Application-level synonyms and press Enter.
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4

In the Dataitem field of the Synonym Criteria pop-up, choose one of these actions:

. To only list data items with an exact name, type the complete name of the data
item.

. To list data items that have a pattern in their name, type a text pattern.
. To list all data items in the application, leave the asterisk (*).

Note:
ASG recommends that you not list all synonyms, as it is time intensive.

Press Enter to initiate the search for data items that match the criteria you defined.

The Synonym Selection pop-up displays showing the list of data items. Specify the
data items Alliance identifies synonyms for.

Type any non-blank character in the selection column beside the data items you want
to select and press PF4 (Synonyms) to initiate the search for synonyms.

The Synonym View screen displays showing the list of synonyms Alliance
identified. The data items you selected are highlighted with their synonyms listed
below. Use the standard ISPF scroll keys to display the qualification information for
each synonym.

Note:

For step-by-step instructions on saving and printing search information, see "Saving
and Printing Query/Search Results" on page 43.

Press PF3 and then Enter to exit the Synonym View pop-up. The search results are
not saved.
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Searching for Program Level Synonyms

Program-level (or local) searches identify synonyms within a selected program.

To search for program-level synonyms

1

10

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

Select Search » Synonyms and press Enter.
Select Data Item Synonyms » Program-level synonyms and press Enter.

Type any character in the selection column beside the program displayed in the
Synonym - Program Selection pop-up and press Enter.
In the Dataitem field of the Synonym Criteria pop-up, choose one of these actions:

. To only list data items with an exact name, type the complete name of the data
item.

. To list data items that have a pattern in their name, type a text pattern.

. To list all data items in the application, leave the asterisk (*).
Press Enter.

The Synonym Selection pop-up displays showing the list of data items. Specify the
data items Alliance identifies synonyms for.

Type any non-blank character in the selection column beside the data items you want
to select and press PF4 (Synonyms).

The Synonym View screen displays listing the identified synonyms. The data items
you selected are highlighted with their synonyms listed below them. Use the
standard ISPF scroll keys to display the qualification information for each synonym.
For step-by-step instructions on saving and printing search information, see "Saving
and Printing Query/Search Results" on page 43.

Press PF3 and then Enter to exit the Synonym View pop-up. The search results are
not saved.
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Searching for Homonyms

Alliance defines homonyms as data elements that have identical names across an
application. Data elements with identical names usually are used with similar intent.
Identifying them enables you to ensure thoroughness in implementing change requests.
You can use this information to accomplish data rationalization tasks as well. Because
data elements that come from the same copybook (include) have the same name, Alliance
provides an option to remove them from the homonym output.

To search for homonyms

1

42

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

Select Search » Homonyms and press Enter.

In the Name field of the Homonym Criteria pop-up, choose one of these actions:

. Type the complete name of the data item to list only data items with that exact
name.

. Type a text pattern to list data items that have that pattern in their name, as
well as the number of definitions for that dataname.

. Leave the asterisk (*) to list all data items in the application. This is a time
intensive procedure and ASG does not recommend it.

Type any non-blank character in the selection column beside the Include Copybook
Items field if you want Alliance to count items in copybooks as homonyms when the
copybook appears in more than one program.

Press Enter. The Homonym Selection pop-up displays a data item list. Specify the
data items Alliance identified homonyms for.

Type any character in the selection column beside the data items you want to select
and press PF4 (Homonyms).

The Homonym View screen displays a list of homonyms Alliance identified. Each
dataname definition is listed with this information:

. Homonym name . Program name
. Definition level of the dataname e Qualification for the dataname

. Defined picture of the dataname
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Use the standard ISPF scroll keys to display the qualification information for each
homonym identified.

For step-by-step instructions on saving and printing search information, see Saving
and Printing Query/Search Results.

Press PF3, then Enter to exit without saving the search results.

Saving and Printing Query/Search Results

To save search results information to a new worklist

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

Choose Worklist » New Worklist and press Enter. The New Worklist pop-up
displays.

Type a unique name and description. You may also provide an optional dataset
name. Press Enter.

If you do not provide a dataset name, the Impact or Query Facility screen returns
with the name of the new worklist displayed in the message area. For example:

<userid>.ALNnnnnn.VIAWKLST
where:
<userid> isyour TSO user ID or prefix.

nnnnn is a sequential number assigned by Alliance.
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To save search results to an existing worklist

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

Select Worklist » Open Worklist and press Enter. The Open Worklist pop-up
displays.

Type any character in the selection column beside the name of the worklist you want
to edit and press Enter.

To edit an existing worklist

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

Select Worklist P Edit worklist and press Enter. The Open Worklist pop-up displays.

Type any character in the selection column beside the name of the worklist you want
to edit and press PF4. The worklist displays on your default editor screen.

Note:

If SmartEdit is installed at your site, the SmartEdit editor displays. Otherwise the
ISPF editor displays.

Select File P Save to save your changes.

Select File P Exit to return to the original screen.
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To print search results

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

Select File P Print current results and press Enter.
The search results are copied to an Alliance list file.

Select Options » Log/list and press Enter. The Options - Log/list Definition pop-up
displays.

Type PK (Print/Keep) or PD (Print/Delete).

Press PF6 to close and process the list file.
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Using the Query Facility

This chapter describes how to perform queries and searches, and contains these sections:

Section Page

Performing Custom Queries 47
Understanding Query Language Syntax 48
The ATTRIBUTES BLOCK 52
The SELECTION BLOCK 63
Using Queries 65
Building the List of Possible Targets (Impact List) 75

To refine the information collected so far, determine the selection criteria to locate the
unique entity kinds and names constituting the impact list. The more narrow the scope of
the analysis, the more accurate the information obtained for the impact assessment.

Use the Alliance query language to customize the template queries or to create new

template queries to display application information about the entities included in the
analysis. You can also run new searches to locate entities impacted by the change.

Performing Custom Queries

To locate specific entities in your application and their relationships with other entities,
modify the existing queries or create new queries using the syntax supported by Alliance.

To locate specific entities in your application and their relationships with other
entities

1 Use your system editor to create a file that contains the query source.



ASG-Alliance User’s Guide

2 Modify or specify the source as needed and define the new query to Alliance.

3  Execute the query.

Understanding Query Language Syntax

The structure of a Alliance query consists of these definition blocks:

Definition Block Description

ENTITY RELATIONSHIP Names the application entities (such as programs, FDs,

BLOCK PROCs, JCL) you want to include in the query and the
relationships you want to use in the search for application
information.

ATTRIBUTES BLOCK Selects data to be included in the query results and

changes the format.

SELECTION BLOCK Allows AND/OR logic between attributes or entities, and
grouping of elements with the Select statement.

Query Structure Example

Figure 23 shows an example of a query structure that displays all FDs used in all
programs.

Figure 23 » Query Structure Example

000001 ENTITY RELATIONSHIP BLOCK
000002 *

000003 FD IN PROGRAM

000004 *

000005 ATTRIBUTES BLOCK

000006 *

000007 FD

000008 WIDTH 12

000009 BLANK WHEN REPEATED
000010 SORT DESCENDING
000011 BREAK INSERT BLANK LINE
000012 *

000013 PROGRAM

000014 WIDTH 12

000015 BLANK WHEN REPEATED
000016 SORT DESCENDING
000017 BREAK INSERT PAGE
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Query Results Example

Figure 24 shows the results of the query structure specified in Figure 23 on page 48. This
table contains the specified formatting instructions:

Structural Element Description

WIDTH n Specifies user-defined column widths.

BREAK INSERT BLANK Inserts blank line between each change in the FD name.
LINE

BREAK INSERT PAGE Inserts page break for each change in the program name.

SORT DESCENDING Sorts results in descending order on both the FD and the
program columns.

Figure 24 « Query Results Example

Name : EXQUERY1 - EXAMPLE QUERY 1
FD PROGRAM

R R R R R R R R R R TOP OF DATA khkkhkhkkkhkhkhkkhkkkkkkkkkkkhkkkkkk

MASTERIN VIAIDEMO
MASTER-RPT VIAIDEMO
——————————————————————————————————————————————————————— |Page break|
DAILY TOTALS VIAIDEM1

R R R R R R R R R R BOTTOM OF DATA khkkhkhkhkhkhkhkhkhkkkkkkkkkkkkkkkk

Query Syntax Rules

These are the query syntax rules:

. The first two keywords in the query definition must be ENTITY_RELATIONSHIP
BLOCK in capital letters.

. Query statements can start anywhere on the line.
. Multiple statements are allowed in a single line.

. Comment lines, identified with a period (.) or asterisk (*) placed in column 1, can
be located anywhere in the query definition.
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For readability, start each phrase on a new line and use comment lines to separate major
sections. Figure 25 illustrates these syntax rules.

Figure 25 « Query Language Syntax - ENTITY_RELATIONSHIP BLOCK Example

000001 .This is a comment line
ENTITY RELATIONSHIP BLOCK
000003
000004 entityl relationshipl entity2
000005 entity2 relationship2 entity3
000006
000007
000008 entityN relationshipN entityN+1

The ENTITY_RELATIONSHIP BLOCK
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Use the ENTITY RELATIONSHIP BLOCK to specify the chain of entities displayed.
Entities linked by relationships are also specified in the ENTITY RELATIONSHIP
BLOCK. The valid links are specified in "Valid Entities and Relationships," on page 115.
Internally, this block specifies the analysis data from the AKR that Alliance uses to
derive the query results.

If the ENTITY RELATIONSHIP BLOCK specifies, for example:
FD IN PROGRAM

then the default query results show all FDs that occur in all PROGRAMSs. This is the way
the display is formatted:

FD PROGRAM

On the other hand, if the ENTITY RELATIONSHIP BLOCK specifies, for example:

FD IN PROGRAM
PROGRAM IN MEMBER

then the query results show all FDs that occur in all programs and the LIBRARY
MEMBERS containing the PROGRAMs. The is the way the display is formatted:

FD PROGRAM MEMBER

With each additional entity specified, Alliance adds a new column with default entity
titles and field widths to the display.
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In the previous example, you might be inclined to change the display to show all FDs and
the library MEMBERS containing FDs by using the statement FD IN MEMBER, but this
is not a valid entity-relationship combination.

Note:

To prevent the display of PROGRAM when the column width of PROGRAM is set to
zero, use the ATTRIBUTES BLOCK statement. For more information, see "The
ATTRIBUTES BLOCK" on page 52.

These are the ENTITY _RELATIONSHIP BLOCK syntax rules:

. The first entity specified in the ENTITY RELATIONSHIP BLOCK is called the root
entity for the query (for example, entityl in Query language
syntax - ENTITY RELATIONSHIP BLOCK example). This is any valid
application entity.

. All remaining links must begin by naming an entity specified in a previous line.
Otherwise, the syntax does not form a valid entity.

You can perform these tasks:

. Specify a continuous search path through the application information by repeating
an entity that occurred at the end of the preceding line.
For example:

—  Entity?2 in the Query Language Syntax - ENTITY_ RELATIONSHIP BLOCK
Example displays at the end of the first line and the beginning of the second.

—  Entityl is related to entity2, entity?2 is related to entity3, and so on.
This forms the continuous search path.

. Begin a new search path through the application information by repeating the first
entity that occurs in one line on several subsequent lines. To ensure correct
interpretation, ASG recommends that you change the format of the output to
delineate the paths. Figure 26 and Figure 27 on page 52 show a query result with
multiple paths.

Figure 26 = Example of Multiple Paths in a Query

000001 ENTITY RELATIONSHIP BLOCK
000002 COPYMEMBER IN PROGRAM

000003 COPYMEMBER IN MEMBER

000004 MEMBER IN LIBRARY

000005

000006 ATTRIBUTES BLOCK

000007 COPYMEMBER

000008 ON CHANGE INSERT BLANK LINE
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The ENTITY_RELATIONSHIP BLOCK syntax shown in Figure 27 specifies a report
showing all COPYMEMBERSs and the PROGRAMs using them. In addition, this query
requests the listing of all library MEMBERSs containing the COPYMEMBER and the
LIBRARY(s) containing those MEMBERs.

Figure 27 « Query Results Showing Multiple Paths Example

Name: VIABQCPS - Copybook / Program cross-reference

COPYMEMBER PROGRAM MEMBER LIBRARY

COPY0005 VIAIO40 n/a n/a <==COPYMEMBER IN PRORAM

COPYO0005 n/a COPYO00005 ASG.VIA.SOURCE <==COPYMEMBER IN MEMBER
MEMBER IN LIBRARY

COPYO0010 VIAIO40 n/a

COPYO0010 n/a ASG.VIA.SOURCE

For example:

. The COPYMEMBER is in the PROGRAM and also in the library MEMBER.

. The library MEMBER s in the LIBRARY.

. The PROGRAM is not in the MEMBER or in the LIBRARY.

. The MEMBER and LIBRARY columns are for the COPYMEMBER and not for
the PROGRAM.

To avoid ambiguity, the display shows separate output on different lines with one line for
the COPYMEMBER IN PROGRAM relationship, and one line for the COPYMEMBER
IN MEMBER and the MEMBER IN LIBRARY relationship. The letters n/a display
where there is no relationship.

The ATTRIBUTES BLOCK
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After entities and their relationships are defined through the ENTITY_RELATIONSHIP
BLOCK, the ATTRIBUTES BLOCK lets you perform these tasks:

. Specify attributes of entities and actions on attributes.
. Apply selection criteria to the generated results.
. Modify the format of the results.

. Request additional information for specific entities.
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The ATTRIBUTES BLOCK and all of its statements are optional. Specify attributes for
any, all, or none of the entities named in the ENTITY RELATIONSHIP BLOCK. Figure 28
is an example of the ATTRIBUTES BLOCK.

Figure 28 « Query Language Syntax - ATTRIBUTES BLOCK Example

ENTITY RELATIONSHIP BLOCK
PROGRAM HAS DATA
ATTRIBUTES BLOCK
PROGRAM
SORT DESCENDING
BLANK WHEN REPEATED
DATAITEM
SORT ASCENDING
BLANK WHEN REPEATED
TITLE "DATA NAMES"
WIDTH 35

These are the ATTRIBUTES BLOCK syntax rules:
. Keywords can be placed anywhere on the line.
. Multiple statements are allowed in a single line.

. The first item in the ATTRIBUTES BLOCK must be an entity named in the
ENTITY_RELATIONSHIP BLOCK. Any number of attributes statements can follow
this entity name. All statements apply to this entity until another entity is named.

. Optional keywords within each statement are shown between braces ({and}).

. The vertical bar (|) denotes an OR condition, indicating that only one of the
keywords can be selected.

For readability, each statement should be indented and separated. These are the valid
attributes and actions for the ATTRIBUTES BLOCK:

. SELECT
. TITLE

. WIDTH
. SORT

. FORMAT BLANK WHEN REPEATED
. BREAK ON CHANGE INSERT

. POSITION

. DATAITEM entity attributes

. DSN entity attributes

. LANGUAGE entity attribute
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SELECT
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The SELECT attribute selects or discards data from the query result producing a subset of
the data from the AKR. The SELECT clause is followed by the condition including an
operator and selection criterion. Depending on the entity ATTRIBUTE, you might enclose
the selection criterion in quotes.

You may specify multiple selection criteria for an entity kind. When you specify more
that one selection criterion, each is joined by AND or OR.

This is the syntax of the SELECT clause:

SELECT <entity> WHEN <attribute> <operator> <value>
where:

entityis PROGRAM, DATAITEM, etc.

attributeis NAME, SIZE, PICTURE, etc.

The WHEN keyword is optional. Parentheses are not allowed. Use an asterisk (*) as a
wildcard in the 'text' string to specify characters, for example:

'"ABC*' Indicates any name beginning with ABC.
'"*ABC'  Indicates any name ending with ABC.

'*ABC* ' Indicates any name containing ABC.

As the query retrieves data during its execution, the entity value is compared to the string,
and then selected or discarded, depending on the operator. You may enter only one select
statement for each entity. If you specify, for example:

RECORD
SELECT WHEN EQ "*MASTER*" AND NE "PAY-MASTER"

then only RECORD entities that contain the text MASTER anywhere in their name and
that are not named PAY-MASTER are included in the query result.



TITLE

WIDTH
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SELECT criteria are evaluated sequentially, by order of appearance. Every SELECT
criterion is evaluated. When all SELECT criteria have been evaluated, the data selection
indicator is tested to determine whether the data should be included in the results. Use
multiple SELECT criteria carefully to ensure that the results contain the data you expect.
If you specify, for example:

RECORD
SELECT WHEN EQ "*MASTER*" AND NE "PAY-MASTER"
OR EQ "*TRANSACTION*" AND NE "HOLD-TRANS*"

then the query result includes:

. RECORD entities that contain MASTER anywhere in their name and are not
named PAY-MASTER

. RECORD entities that contain TRANSACT ION anywhere in their name and
whose name does not begin with HOLD-TRANS

The TITLE attribute changes the column title. The default column title is the entity kind
name exactly as it is specified in the ENTITY_RELATIONSHIP BLOCK (including
capitalization). For example, use this attribute to change the FD entity title to File
Description. The title itself can be any text and must be enclosed in single or double
quotes, provided that the ending quote matches the starting quote. This feature enables
you to embed quotes in the title, as in "Job’s PROC".

The WIDTH attribute changes the width of the column. The default width is wide enough
to prevent truncation. You must specify a positive numeric integer for the column width.
If the WIDTH attribute specifies, for example:

WIDTH 10
then the column width for the entity is 10 characters.
To hide a column, specify a width of zero (0). Although this prevents entities from being

displayed, they are still required in the query syntax to define the search path for the
retrieval of application data from the AKR.
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For example, you could modify the query defined in Figure 26 on page 51 to include a
WIDTH 0 statement for the entity MEMBER, as shown in Figure 29.

Figure 29 « Example of WIDTH 0 Attribute in a Query

000001 ENTITY RELATIONSHIP BLOCK
000002 COPYMEMBER IN PROGRAM
000003 COPYMEMBER IN MEMBER
000004 MEMBER IN LIBRARY
000005

000006 ATTRIBUTES BLOCK

000007 COPYMEMBER

000008 ON CHANGE INSERT BLANK LINE
000009

000010 MEMBER

000011 WIDTH O

Figure 30 shows the result of the modified query.

Figure 30 « Example of Query Results Showing WIDTH 0

Name: VIABQCPS - Copybook / Program cross-reference
COPYMEMBER PROGRAM LIBRARY

COPY0005 VIAIO40 n/a

COPYO0005 n/a ASG.VIA.SOURCE

COPYO0010 VIAIO40 n/a

COPY0010 n/a ASG.VIA.SOURCE

SORT

The SORT attribute sorts the query result in ascending or descending order. You may
choose a different sort order for each entity in the result.

This statement must be used for any entity that has a BREAK or a FORMAT BLANK
WHEN REPEATED attribute specified.

FORMAT BLANK WHEN REPEATED

The FORMAT BLANK WHEN REPEATED attribute causes blanks to print in the place
of the text value of an entity if that text is the same as the preceding line. This statement is
used to enhance the readability of the output. The FORMAT keyword is optional, but you
must specify the SORT attribute.
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BREAK ON CHANGE INSERT

POSITION

The BREAK ON CHANGE INSERT attribute causes a blank line or a page break to be
inserted between two lines in the query result when the value of an entity changes on two
consecutive lines. Use this statement to enhance the readability of the output.

On the screen, a page break is denoted by a line of dashes (- - -). For printed reports, a
physical page break occurs. The BREAK keyword is optional.

The POSITION attribute is used to place a column of the output before or after another.
This statement does not affect the order data is retrieved. Specify the target position by
name or by column number.

For example, if the only selected entities are FD and PROGRAM, you could specify the
FD attribute POSITION AFTER PROGRAM or POSITION AS 2 to display the
PROGRAM column first. Specifying the FD attribute POSITION BEFORE PROGRAM
is unnecessary because that is the default order.

For example, to position a column after a dataitem attribute such as LEVEL, type this
statement:
"POSITION AFTER DATAITEM: LEVEL"

DATAITEM Entity Attributes

Include extended entity attributes in the ATTRIBUTES BLOCK for the entity kind
DATAITEM. These entity attributes provide additional columns in the query result to
display more information about a data item entity besides its default NAME attribute.

In addition to DATAITEM attributes, the CRUD attributes (Create, Read, Update, and
Delete) are now valid on these entities:

. FD

. DD

. IDMS record
. DB2 table

. IMS segment
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Include multiple entity attributes in a query, as shown in Figure 31. The entity
ATTRIBUTE keyword is required for each attribute included in the query. All attributes
can be used with entity attributes.

Figure 31 « Example of Multiple Entity Attributes in a Query

000026 ATTRIBUTES BLOCK

000027 DATAITEM

000028 TITLE "DATA ITEM"
000029 SORT ASCENDING
000030 FORMAT BLANK WHEN REPEATED
000031 ATTRIBUTE REF
000032 ATTRIBUTE SIZE
000033 ATTRIBUTE LEVEL
000034 ATTRIBUTE OFFSET
000035 ATTRIBUTE POSITION
000036 ATTRIBUTE REDEFINES

This table lists valid entity attributes in alphabetical order. Figure 32 on page 60 and
Figure 33 on page 61 show a query where these attributes are used.

Attribute SELECT Clause

Name Description Must Specify

ARITH Specifies if a data item is part of an Positive number or zero,
arithmetic statement. not enclosed in quotes

COND Specifies if a data item is part of a Positive number or zero,
conditional statement. not enclosed in quotes

CREATE Specifies if a data item is part of a create Y or N

activity, as defined by ESW.

DELETE Specifies if a data item is part of a delete Y or N
activity, as defined by ESW.

LANGUAGE Specifies the language that generates the =~ COBOL, PL/I, ASM, or
entity kind. See "LANGUAGE Entity NATURAL
Attribute" on page 62 for more details.

LEVEL Indicates a level number of the data item, Positive number or zero,
as coded in source module. not enclosed in quotes

MOD Indicates the number of modifications of  Positive number or zero,
data item, as defined by ESW. This not enclosed in quotes

includes occurrences of the dataname
where its value is being tested or used.
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Attribute SELECT Clause

Name Description Must Specify

OCCURS Specifies if a data item is the subject of, or  Positive number not
is subordinate to the subject of an enclosed in quotes

OCCURS clause. The resulting display
shows the number of occurrences, as
specified in the OCCURS clause. A blank
or zero result indicates that the data item
has no associated OCCURS clause.

OFFSET Indicates the distance (in bytes) from the  Positive number or zero,
start of the record to the data item entity ~ not enclosed in quotes
(that is, how many bytes in the record
precede the data item).

PICTURE Lists the PICTURE clause of the data item. Alphanumeric character
The PICTURE column does not identify  enclosed in quotes
packed fields.

To determine whether field is packed, use
entity attribute SIZE in conjunction with
PICTURE.

POSITION Indicates the first byte of the data item Positive number, not
relative to the owning record (that is, the  enclosed in quotes
position of the first byte of the data item).

READ Specifies if the data item is part of aread Y or N
activity, as defined by ESW.

REDEFINES Lists the object of a REDEFINES clause or Alphanumeric character
a data item that is subordinate to the object enclosed in quotes

of a REDEFINES clause.
REF Indicates the number of references to the  Positive number or zero,
data item, as defined by ESW. This not enclosed in quotes

includes occurrences of the dataname
where its value is being tested or used.

SIZE Lists length (in bytes) of the data item Positive number or zero,
field. not enclosed in quotes
UPDATE Specifies if the data item is part of an YorN

update activity, as defined by ESW.
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Attribute SELECT Clause

Name Description Must Specify

USE Indicates the number of uses of the data Positive number, not
item, as defined by ESW. This includes enclosed in quotes
occurrences of the dataname where its
value is being tested or used.

VALUE Lists the content of a VALUE clause for  Alphanumeric character
the data item. enclosed in quotes

You can include these in the statement, MOVE A TO B:
. USE and REF with data item A
. MOD and REF with data item B

You can include these in the statement, IF A = B:
. USE, REF and COND with data item A
. USE, REF and COND with data item B

In Figure 32, the query includes the entity attributes LEVEL, SIZE, PICTURE, and
REDEFINES. Notice that the entity attribute REDEFINES uses the WIDTH attribute.

Figure 32 « Example of DATAITEM Entity Attributes in a Query

ENTITY RELATHIPSHIP BLOCK
DATAITEM DEFINED-IN PROGRAM

ATTRIBUTES BLOCK
DATAITEM
TITLE "Data item"
SORT ASCENDING
FORMAT BLANK WHEN REPEATED
ATTRIBUTE LEVEL
ATTRIBUTE SIZE
ATTRIBUTE PICTURE
ATTRIBUTE REDEFINES
WIDTH 15

PROGRAM
TITLE "PROGRAM"
SORT ASCENDING
FORMAT BLANK WHEN REPEATED
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Figure 33 shows the result of the modified query.

Figure 33 « Example of Query Results with DATAITEM Entity Attributes

Query Facility Rld-0MLT
Command ===r _ Scroll ===: C5R
Mame: DTHMATTR - SAMFPLE QUERY TO SHOW ATT 1 of 71
N
Data item lewel =ize  picture redefines
CCWS-C-1 o1 119
CCW5-C-2 o1 120
CCWS-E-1 o1 120
CCWS-E-2 o1 10a
CCWS-E-2-2 o2 43
CCWS-E-3 o1 12e
CCWS-E-4 o1 =10
CCME-E-4-1 oz 3 REA
CCWS-E-4-2 o2 3 HRR
CCWS-H-1 o1 120
CCWS-H-2 o1 120
CCME-H-3 o1 120
CEYS-PGH- I a1 T H(3)
CH-18%a e COMPUTELD-A
DSN Entity Attributes

Include extended entity attributes in the ATTRIBUTES BLOCK to provide information
about a dataset name entity for the entity kind DSN, in addition to its default attribute
name.

The entity attribute DISPOSITION specifies the characteristics of a DSN, as established in
the JCL member of reference. The SELECT clause for the DISPOSITION attribute must
contain NEW, OLD, MOD, or SHR. The DISPOSITION entity attribute is valid for DSN
only.

Figure 34 is an example of the syntax for a query containing a DSN entity with the
DISPOSITION attribute.

Figure 34 « Example of a DSN Entity with the DISPOSITION Attribute in a Query

000001 ENTITY RELATIONSHIP BLOCK
000002 DSN IN DD

000003 ATTRIBUTES BLOCK

000004 DSN

000005 TITLE ’'DATASET NAME’
000006 ATTRIBUTE DISPOSITION
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Figure 35 shows the results of a query containing a DSN entity with the DISPOSITION
attribute.

Figure 35 « Example of Query Results with a DSN Entity and the DISPOSITION Attribute

Query Facility REBET-AL
Command ===r _ Scroll ===r C5R
Mame:  DSHWDRISF - A SAMPLE QUERY TO SHOW DSH WITH DISP 1 of 44
DATASET MAME disposition DD
DEY.LOADLIE SHR: STEFLIE
LEY. FTAP SHR FTAF
DEY.CDS. MOHITOR SHR: COMOHRAN
DEY. INPUT. TOCDS SHR COPATRIN
DEY.CDS. VLD TREHS HEW COPYRAOUT
DEY. LOADLIE SHR STEFLIE
DEV.FTAP SHR: FTAF
DEY. C'S. REFREHCE SHR TEXTREF
DEY.CDS. MOMHITOR SHR: COMONRAN
DEY. CDS. VLD TRHS SHR COPATRIN
DEV. CD'S. COCHUREF HEW COCHOREF
DEY.CDS. BACSFILE HEW BACSTAPE
DEY.LOADLIE SHR: STEFLIE
DEY. CLS. REFREHCE SHR TEXTREF

LANGUAGE Entity Attribute
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The entity attribute LANGUAGE displays the language that generated the entity kind. The
languages include COBOL, PL/I, Assembler, and NATURAL. The LANGUAGE attribute
is valid for these entities:

. PROGRAM/PROCEDURE/FUNCTION e RECORD/STRUCTURE/DSECT
J ENTRY J DATAITEM
. FD/FILEVAR/DCB . CSECT

Figure 36 shows a query that includes the entity attribute LANGUAGE.

Figure 36 « Example of the LANGUAGE Attribute in a Query

goaaal ENTITY_RELATIONSHIF EBLOCK
QREEEZ FROGRAM HAS DATAITEM
QA2

oaEaa4 ATTRIBUTES BLOCK

Qoaaas DATARITEM WIDTH 12

QRAEEE ATTRIEBUTE LANGUAGE WIDTH & TITLE "LAMG"
QEAAAT ATTRIBUTE SIZE WIDTH 4

QaAAES ATTRIBUTE OFFSET WIDTH 4 TITLE "0OFST"
oaaaas ATTRIEUTE CREATE WIDTH 1 TITLE "C"
gEaa1E ATTRIEBUTE READ WIDTH 1 TITLE "R"
QEEE11 ATTRIBUTE UPDATE WIDTH 1 TITLE "U"
oaEaa12 ATTRIBUTE DELETE WIDTH 1 TITLE "D"
ooaaLs ATTRIEBUTE POSITIOM WIDTH 3 TITLE "POS"
QEEE 14 ATTRIEBUTE LEWEL WIDTH 3 TITLE "LWL"
oaEaa1s ATTRIBUTE OCCURS WIDTH 2

QaEAA1E ATTRIBUTE PICTURE WIDTH 1@

ooaaLy ATTRIEBUTE YALUE WIDTH 3
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Figure 37 shows the results of a query that includes the entity attribute LANGUAGE.

Figure 37 « Example of Query Results with the LANGUAGE Attribute

Query Facility AEBBEY -AL
Command === Scroll ===r CER
Mame:  PGMWLANG - A SAMFLE QUERT TO SHOW PROGRAM WITH LAM 1 of 200...
FROGRAM CATAITEM LAMG  SIZE OFST C R U [ POS LYL URS PICTURE VYALLE
Cha3A334  BACS-DATE COEOL E BHHHHN 1 a1
ChOZA334  BACS-DD COBOL 2 BHHHH 1 083 93
C0AZA334  BACS-MM COBOL 2 ZHHHHN 2 0F 99
ChO3A334  BACS-TT COEOL 2 4 HHHHN 5 0F 33
ChA3A384 BACS-DATE-x=x COBOL 4 BHHHHN 1 81
ChAZA334  BACS-DATE-XE COBOL 3 IHHHHN 2 03 HEE
ChAZA334  HEXT-BACS-DA COBOL 4 BHHHHN 1 a3 902
C0O3A334  WA-ACCUMULAT COEOL 13 BHHHHN 1 a1
ChA3A3E34  WA-HO-0F-WOR COBOL 3 BHHHHN 1 83 2303) +0
C0AZA334  WA-POUT-REC- COBOL 3 THHHH 4 @©5 59(5) +0
C0AZA334  WA-POUT-REC- COBOL e EHHHHN 7T 0F S905) +0
C0O3A334  WA-POUT-CASH COEOL -] SHHHH 10 B35 5309)v393 4@
cha3A3e3d4  WD-DTYMAMIC-C COBOL =] BHHHHN 1 a1

o] BHHHHN 1

ChoZA334  DATES COBOL Qs ®ig 'SEME

The SELECTION BLOCK

After you define the selection criteria in the ATTRIBUTES BLOCK, the SELECTION
BLOCK lets you append additional syntax to a SELECT clause, enhancing query
capabilities to allow these functions:

. AND/OR logic between attributes
. AND/OR logic between entities

. Grouping of elements with parentheses ‘( and )’

The SELECTION BLOCK and all of its statements are optional. Specify attributes for any,
all, or none of the entities named in the ENTITY RELATIONSHIP BLOCK.
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Figure 38 is an example of the SELECTION BLOCK.

Figure 38 * Query Language Syntax - SELECTION BLOCK Example

ENTITY RELATIONSHIP BLOCK
PROGRAM HAS DATAITEM
ATTRIBUTES BLOCK
PROGRAM
SORT ASCENDING
DATAITEM
SORT ASCENDING
BLANK WHEN REPEATED
TITLE "DATA NAMES"

WIDTH 35
SELECTION BLOCK
SELECT DATA ITEM WHEN (NAME = '*YEAR*') AND
(SIZE > 1)
SELECT PROGRAM WHEN (NAME = 'ABC*')

These are the SELECTION BLOCK syntax rules:

. The first item in the SELECTION BLOCK must be an entity named in the
ENTITY RELATIONSHIP BLOCK. Any number of attribute statements can
follow this entity name. All statements apply to this entity until another entity is
named.

. Optional keywords within each statement are shown between braces ({and}).

. The vertical bar (|) denotes an OR condition, indicating that you can select only one
of the keywords.

. Keywords can be placed anywhere on the line.
. Multiple statements are allowed in a single line.

. For readability, each keyword should be indented and separated.
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Using Queries

Qualifying Entities in Queries

When an entity is used multiple times within a query, you must qualify it to ensure that
the desired search path is created. For example, in a query designed to display
program-calling chains, you need to specify the programs and the entries that they call.
Then, the query contains the program containing the called entry and any entries that
program calls. Repeat this process until the calling chain is exhausted.

In Figure 39, the query contains two references to the entity PROGRAM. The second
reference to PROGRAM must be qualified by ENTRY to correctly inform the query
processor that ENTRIES called by the second reference to program are to be generated.

If the PROGRAM name was not qualified in this line, it would be unclear whether
PROGRAM refers to the calling program or the called program. Without qualification,
the first occurrence of PROGRAM is assumed.

Figure 39 « Example of Qualified Entity Names in a Query

PG CALLS ENTRY

PGM CALLS

This is the code for this query:

ENTITY_RELATIOHSHIP
PROGEAM CALLS ENTEY
ENTRY IN PROGRAM
ENTRY .PROGRAM CALLS

65



ASG-Alliance User’s Guide

Aliasing Entities in Queries

Some queries require additional entity qualification. For example, extensive entity name
qualification is necessary to provide the complete search path for the query in order for it
to trace the flow of CALLs from program to subprogram on many levels.

Figure 40 shows an example of extensive entity qualification in the
ENTITY RELATIONSHIP BLOCK of a query.

Figure 40 « Example of Extensive Entity Qualification in a Query

000001 ENTITY RELATIONSHIP BLOCK

000002 =*

000003 PROGRAM CALLS ENTRY

000004 PROGRAM.ENTRY IN PROGRAM

000005 PROGRAM.ENTRY .PROGRAM CALLS ENTRY

000006 PROGRAM.ENTRY .PROGRAM.ENTRY IN PROGRAM

000007 PROGRAM.ENTRY .PROGRAM.ENTRY.PROGRAM CALLS ENTRY
000008 PROGRAM.ENTRY . PROGRAM.ENTRY . PROGRAM.ENTRY IN PROGRAM

In this query, entity qualification quickly becomes difficult to follow. Entity aliasing
provides a way to simplify the entity qualification required to complete the query.

To use entity aliasing, follow this step:
» Specify any name in parentheses after the entity name.

The name in the parentheses becomes the alias for the entity immediately preceding
the alias name, including the complete qualification for the entity, as shown in

Figure 41.

Figure 41 « Example of Entity Aliasing in the ENTITY_RELATIONSHIP BLOCK of a Query

000100 ENTITY RELATIONSHIP BLOCK

000200 =*

000300 PROGRAM CALLS ENTRY

000400 PROGRAM.ENTRY (PROG-ENT-1) IN PROGRAM

000500 (PROG-ENT-1) . PROGRAM CALLS ENTRY
000600 (PROG-ENT-1) PROGRAM.ENTRY (PROG-ENT-2) IN PROGRAM
000700 (PROG-ENT-2) PROGRAM CALLS ENTRY

In this example:

. PROG-ENT-1 becomes the alias for PROGRAM.ENTRY.

. PROG-ENT-2 becomes the alias for (prog-ent-1).PROGRAM.ENTRY, that is,
PROGRAM.ENTRY.PROGRAM.ENTRY.

In both cases, Alliance interprets the actual query statement as if it contains the
substituted name.

66



4 Using the Query Facility

Use entity aliasing in the ATTRIBUTES BLOCK with the same properties that you used in
the ENTITY_RELATIONSHIP BLOCK. Figure 42 shows an example of a query with entity
aliasing in the ATTRIBUTES BLOCK.

Figure 42 « Example of Entity Aliasing in the ATTRIBUTES BLOCK of a Query

000001 ATTRIBUTES BLOCK
000002 =

000003 PROGRAM

000004 TITTLE 'A calls'
000005 SORT ASCENDING
000006 WIDTH 10

000007 PROGRAM

000008 TITLE "Start Pgm"
000009 SORT ASCENDING
000010 (prog-ent-1)

000011 WIDTH O

000012 (prog-ent-1) . PROGRAM
000013 TITLE "A calls"
000014 WIDTH 10

For an alphabetical listing of all entities recognized by Alliance, see "Valid Entities and
Relationships" on page 115.

Creating Custom Queries

Whether modifying standard queries, editing an open query, or creating a new query,
follow these same procedures to generate custom queries.

. Create a new query language source file (see page 70).
. Define the query to Alliance (see page 70).
. Execute the query (see page 71).

Creating New Query Language Source Files

To modify standard queries or to construct entirely new displays, create new files
containing the query language source needed to produce the display. These files define
the displays that show when you make a selection from the System Cross Reference
Information pop-up.
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These are the system cross-reference source files:

File Name Report Name

VIABQCDD CICS file cross-referenced by program

VIABQMAP CICS map cross-referenced by program

VIABQDSC DSN cross-referenced by copybook

VIABQDSN DSN cross-referenced by job

VIABQDSG IMS DBD cross-referenced by segment

VIABQSEG IMS PSB cross-referenced by program

VIABQIJBS Job cross-referenced by JCL library

VIABQJBL Job cross-referenced by JOBLIB

VIABQLMO Job cross-referenced by load module

VIABQSTL Job cross-referenced by STEPLIB

VIABQREC Job cross-referenced by FD

VIABQIJBC JOBCAT cross-referenced by job

VIABQLMP Load Module cross-referenced by CSECT
VIABQLMD Load Module cross-referenced by job

VIABQPRC PROC cross-referenced by load module

VIABQSTC STEPCAT cross-referenced by job

VIABQDBF NATURAL database cross-referenced by Adabas EDT
VIABQDFF Adabas FDT cross-referenced by FDT field
VIABQDDM NATURAL database cross-referenced by Natural DDM
VIABQDMF NATURAL DDM cross-referenced by DDM field
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These are the program cross-reference source files:

File Name Report Name

VIABQCLD Called program cross-referenced by caller
VIABQCLS Caller program cross-referenced by called
VIABQTRN CICS transactions cross-referenced by program
VIABQCPS Copybook cross-referenced by program

JCL INCLUDE:S cross-referenced by JCL
VIABQDAT Dataitem cross-referenced by program
VIABQFD FD name cross-referenced by record
VIABQPTR Program cross-referenced by CICS transaction
VIABQFIL Program cross-referenced by file
VIABQCPY Program cross-referenced by copybook

JCLs cross-referenced by JCL INCLUDESs
VIABQDCP Program cross-referenced by data item
VIABQPDM Program cross-referenced by NATURAL DDM
VIABQWKF Program cross-referenced by NATURAL workfile

To modify a template query source file

1 Locate the name of the member containing one of the standard queries.

The files containing the query language source are installed in this dataset:

ASG.CENTER.CNTL

where ASG and CENTER are defined by the installer at your site.

2 Use your system editor to modify the source file as needed. For query language
syntax information, see "Understanding Query Language Syntax" on page 48.

3 To preserve the original source file, save the changed file under a new member name.
Otherwise, the changed version replaces the original query source.
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To edit an existing query source file while the query results are displayed

1

4

5

Select Facility » Query from the Alliance Primary screen and press Enter. The Query
Facility screen displays.

Select Edit » Query and press Enter. The system editor screen displays showing the
query source file.

Modify the source file definition as needed.
Type CREATE to create a new member in the same or a different dataset.

Type CANCEL to avoid modifying the original query source.

To create a new query source file

1

2

Open your system editor.
Create a source file.

The file must be sequential or a member of a PDS, and contain 80-byte fixed length
records.

Use the information in "Understanding Query Language Syntax" on page 48 to
specify the contents of the file.

Save the file under a new member name in the default dataset
(ASG.CENTER.CNTL) or in a different one.

Defining a Query to Alliance

After you create a new query language source file, you must define the query to Alliance.

To define the new query

1 Select Facility » Query from the Alliance Primary screen and press Enter. The Query
Facility screen displays.

2 Select Facility » Query and press Enter.

3 Select File » New query and press Enter. The New Query pop-up displays.
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Type the name, description, and dataset name of the file containing the query in the
appropriate fields. If the dataset is a PDS, include the member name in the dataset
name.

Note:
If you enter a dataset member that does not exist, you receive a Member Not
Found message. To create the member, press PF4 to display a blank query editor
screen .

To edit the query, press PF4. To immediately generate results, press PF5.

Press PF3 to record and open the query, or press PF12 to cancel.

Executing a Custom Query

Generate query results from the Query facility after you create a new source file and
define the query to Alliance.

1

For step-by-step instructions on saving and printing query information, see "Saving and
Printing Query/Search Results" on page 43.

To execute the query when the query is not open

1

Select Facility » Query from the Alliance Primary screen and press Enter. The Query
Facility screen displays.

Select File » Open query and press Enter.

Type any character in the selection area to the left of the query name on the
Open query pop-up and press Enter.

Press PF5 to generate the query. The Query Facility screen displays the query results.

Note:

The message QUERY OPEN FAILED displays if a syntax error is encountered.
Press PF1 to display more information about the error.

Press PF3 to close the query and return to the previous screen.
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To execute the query when the query is already open

1 Select Facility » Query from the Alliance Primary screen and press Enter. The Query
Facility screen displays.

2 Select File » Open query and press Enter. Select a query from the list on the Open
Query screen.

3 Select Generate » Query Results and press Enter. The Query Facility screen displays
the results of the query.

Note:

The message QUERY OPEN FAILED displays if a syntax error is encountered.
Press PF1 to display more information about the error.

4  Press PF3 to close the query and return to the previous screen.

Using the Local Synonym Query

The query facility in Alliance enables you to query program-level local synonyms using
the LOCALSYNONYM relationship. Issue the Entity-Relationship DATAITEM
LOCALSYNONYM DATAITEM within your query to have Alliance generate local
synonyms in the given program. The relationship SYNONYM continues to work as
before. This generates global synonyms across an application.

Searching for Specific Entities

72

As the information collected brings you closer to building a list of possible targets, use
more involved search options to focus on specific entities possibly impacted by the
change. Besides the identification of synonyms and homonyms, use the search function to
conduct application-wide searches for the location of specific entities, entity kinds, and
literal strings. Run searches from the Impact or the Query facility. For step-by-step
instructions on synonym/homonym identification, see "Running Searches" on page 32.

To search for specific entities

1 Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

2 Select Search » Entities and press Enter.
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3  Inthetext field of the Search Entities Selection Criteria pop-up, perform one of these
actions:

. To list only entities with an exact name (a maximum of 40 characters), type
the complete name of the entity.

. To list all entities that match a pattern, type the partial name of the entity

using wildcards (*).

4 Select one or more entity kinds and press Enter. The Search pop-up displays showing
the list of entities.

5  Type any character in the selection column beside the entities you want to select and
press PF4.

The Search View screen displays with the list of entities Alliance identified. Each
entity definition is listed with this information:

. Entity name

. Entity kind

. Qualification for the entity name

For step-by-step instructions on saving and printing search information, see "Saving
and Printing Query/Search Results" on page 43.

6  Toexitthe Search View pop-up without saving the search results, press PF3 and then
Enter.

Figure 43 shows an example of entity search results in the Search View screen.

Figure 43 « Example of Entity Search Results

File Edit Wiew Worklist oOptions Help
Fearch View DEZ7269
CoHRand ===k _ ZCroll ===k CER
1 of 1VE
R
ZEARCH RESULTE
Base Target HI
Requested Entities . DATAITEH
HNaHe Kind Qgualification
A-CHILD1 DATAITEH A-PARENT OF A-RECORD OF HOUVEL OF VIR0
A-CHILDZ2 DATAITEH A-PARENT OF A-RECORD OF HOUEL OF UIAE0
A-DATE DATAITEH HOUEL OF VIASOFT WCUST.COBOL[DEZT26%)
A-PARENT DATAITEH A-RECORD OF HOVEL OF DIASOFT.CUST.COEOQ
A-RECORD DATAITEH HOUEL OF WIASOFT .CUST . COBOL[DEZT26%)
E-DATALITEH DATAITEH HOVEL OF WIASOFT.CUST.COBOL[DE2726%9]
E-DATE DATAITEH HOUEL OF VIASOFT WCUST.COBOL[DEZT26%)
C-DATAITEH DATAITEH HOUEL OF VIASOFT .CUET.COBOL[DEZT26%)
C-DATE DATAITEH HOUEL OF WIASOFT .CUST . COBOL[DEZT26%)
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To search for literal strings

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

Select Search P Literals and press Enter.

In the text field of the Literal Criteria pop-up, type a text search pattern to list entities
having that pattern in their name (a maximum of 38 characters). Press Enter. The
Literal Selection pop-up displays showing the list of entities.

Type any character in the selection column beside the entities you want to select and
press PF4. The Literals View screen displays with the list of entities Alliance
identified. Each literal is listed with this information:

. Literal name

. Location of use

For step-by-step instructions on saving and printing search information, see "Saving
and Printing Query/Search Results" on page 43.

To exit the Literals View pop-up without saving the search results, press PF3 and
then press Enter.

Figure 44 shows an example of entity search results in the Literals View screen.

Figure 44 « Example of Literal Search Results

File Eait Uiew Worklist oOptions Help

Literals Uiew AREBEY-AL
Conmand ===3x _ fcroll ===k CER
1 of &
B
Literal =earch Results:
Litaral Location of Use
TOP 0OF DATH
LI VIAAL1®.ABEEY . COBOL[C01 S0PGEH)
t1loa VIAALL®.ABEEY . COBOL [ CDZEAPEH)
12 VIAALL1®.ABEEY . COBOL [ COLBEPGH)
WIAALL O ABEEY . COBOL [ CO2AERGH ]
WIAALL1 8. ABEEY . COBOL [ CDOSAPGH)
WIAAL1 8. ABBEY . COBOL [ CD1 S0PGH)
VIAAL1E.ABBEY . COBOL [ G011 SAPGH)
+1223 VIAAL1E.ABBEY . COBOL[CD110PGH)

BOTTOH OF DATA
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Building the List of Possible Targets (Impact List)

The impact list is the tool Alliance uses to derive the base selection list, which is the
starting point for the impact assessment. An impact list consists of the unique entities
(names and kinds) from an application. Use the impact list to find potential impact
analysis targets when you generate an impact analysis. You can save the impact list to a
worklist for future use in this or in other impact analyses. In addition, you can create an
impact list from components in one application and use it to select targets in other
applications.

When you have gathered enough cross-reference and synonym/homonym data, start the
impact analysis by building the impact list. To build the impact list, you define selection
criteria to which Alliance compares all of the entities in the application to identify
possible candidates. For step-by-step instructions on starting the impact analysis and
generating a base selection list, see "Selecting Items to be Analyzed" on page 82.

Figure 45 shows an example of the Impact Entity List screen.

Figure 45 « Example of an Impact Entity List

File Eait UView Worklist oOptions Help

Literals Uiew AEEBEY-AL
CoHHand ===} _ FCPOll ===} CIR
1 of &
ek
Literal fearch Results:
Literal Location of Use
TOP OF DATA
a5 UIAALL & .ABBEY . COBOL [CO1 S0P GH]
a8 UIAALL 8. ABBEY . COBOL [CO2EAPGH ]
t1z VIAALL 8. ABBEY J COEOL [CO1BEPGH )

UIAALL & .ABBEY . COBOL [COZOERGH ]
UIAALL 8. ABBEY . COBOL [ COBSAPGH ]
UIAALL 8. ABBEY . COBOL [ G011 S0P GH ]
UIAALL 8. ABBEY . COBOL [CO1SAPGH]
1223 UIAALL 8. ABBEY . COBOL [CO110PGH]
EOTTOH OF DATAH

Note:

If you do not specify the impact list, Alliance submits all of the entity kinds in the
application for analysis.
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To create an impact list

1 Select File » Open application from the Alliance Primary screen and press Enter. The
File - Open Application pop-up displays (see Figure 46).

Figure 46 * File - Open Application Pop-up

File - Open Application
CoHHand ===

Type AKR information and application name. Then press Enter.
Application Knowledge Repository [AKR]:

Data set naWe . . . 'HEG.ALLEARF.AEKR’
Application naWe . . QCCTE-PYEL  [blank or pattern for list)

UoluMe serial . . . [if not cataloged)

Password o w0 w0 w s s [if password protected)

2 Type the AKR dataset name in the Dataset name field on the File - Open Application
pop-up.

3 If you know the name of the application you want to open, type the name in the
Application name field and press Enter. Otherwise, leave the field blank.

Or

To choose an application from the list, enter a text pattern and press Enter. The
File - AKR Application Director pop-up displays.

4  Select Facility » Impact and press Enter.

5  Select File » New impact list and press Enter.

6  Type a unique name and description for the impact list on the New Impact pop-up
and press PF4. The Impact Entity List pop-up displays. Since this is a new impact

list, there are no defined entities listed. Y ou can also use this pop-up to add and delete
entities.
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Press PF4 on the Impact Entity List pop-up. The Impact Entities Selection Criteria

screen displays (see Figure 47).

Figure 47 « Impact Entities Selection Criteria Screen

Impact Entities Selection Criteria
Command === Scroll ===* C5R

Textl #*
Entity kind {(Default = ALL]

ARERA

CATALOG
CICS-TRANSACTION
COLUMN
COPYMEMEERINCLUDE
Csh

CSECT

CURSOR

DATABASE
DATAITEM

DED

DD

DsH

PFE=5elect all PFE=Unselect all

On the Impact Entities Selection Criteria screen, perform one of these actions:

. Type the full name of an entity.

. Type a pattern for selection in the Text field.

Note:

If you enter a pattern and want to limit the entity kinds selected, specify one or more
entity kinds by entering any character in the selection column to the left of the

entity name.
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9  Press Enter. The Add Impact List Entity screen (see Figure 48) displays showing the
entity names that matched the specifications on the Impact Entities Selection Criteria
screen. The list is scrollable.

Figure 48 « Add Impact List Entity Screen

Add Impact List Entity

Command ===* Scroll === LC5R
Select desired entries then press the Add keuy. 1 of 30853
Previously selected entries are marked with an asterisk.
Text: =*
Text Entity Kind
_ ‘CDhose’ ENTRY
_ ‘cpoesc’ EMTRY
_ ‘cbhion’ ENTRY
_ ‘cbioe’ EMTRY
_ 'CDhisn’ ENTRY
_ ‘CcDise’ EMTRY
_ ‘cbhzon’ ENTRY
_ ‘cbzoe’ EMTRY
_ ‘cbzoc’ ENTRY
_ ‘cbzop’ EMTRY

PFS=%elect all PFGE=Unselect all PFlO=Add

10 Type any character in the selection column beside the desired entity name. You can
select as many entities as needed.

11 When finished selecting entries, press PF10 to add the entries and return to the
Impact Entity List screen (see Figure 49).

Figure 49 « Impact Entity List Screen

Inpact Entity List
CoMHand ===k FCroll ===} CER

Press PF key for actions. Delete requires selection 1 of 2695
of entryls].

Current Sort Kewl MAHE

Entity Kind NaHe
_ PROGRAR-PROCEDOURE-FUNCTION «BRCE-DATE
_ PROGRAR-PROCEDURE-FUNCTION CDOSC-ERROR-CODES
_ PROGRAR-PROCEDOURE-FUNCTION DATEG-YY
_ PROGRAR-PROCEDURE-FUNCTION ME-DATES-TY
_ PROGRAH-PROCEDURE-FUMCTION ME-ETY
_ ENTRY ' CDAsE’
_ ENTRY e
_ ENTRY 'CcOieR’
_ ENTRY ':D1RE!
_ ENTRY 'CD1SE’

FFd=Rdd entity PF3=Delete entity FPF&=Change Zort

12 To add entries, press PF4.

Or

To delete entries, select the entry and press Enter.
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13  Press PF3 to return to the New Impact pop-up.
14 Press PF3 again to return to the Impact Facility screen.

15 Select File » Options to save or delete the impact list.

Or

Select Impact Facility » Edit to modify the option list. Use this impact list with any
open application.

Press Enter.
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Determining Impacted Components

This chapter describes the impact analysis and impacted componets, and contains these
sections:

Section Page

Selecting Items to be Analyzed 82
Locating Impacted Components and Relationships (Summary Impact 83
Analysis)

Listing the Relationships of Impacted Items (Detailed Impact Analysis) 85

As described in the overview, at this stage you identify and list the components possibly
impacted by the change and then submit the list to the Alliance Impact facility. To assess
the impact of change on the application, Alliance evaluates the flow of data and
hierarchical and entity relationships. Alliance uses the list of items selected for impact
assessment to derive a base selection list of components and to produce summary and
detailed analysis results.

The summary impact analysis identifies and locates the components impacted by the
change. The detailed impact analysis retraces the results of the summary analysis by
showing the path of each component included in those results to the members of the base
selection list. Based on your review of the first round of results, research any unknown
entity discovered and then modify the initial parameters to rerun the analysis.
Step-by-step instructions on how to investigate the results of the impact analysis are
located in "Modifying the Impact Analysis" on page 97.

Save each round of results to a worklist. When the impact assessment is completed, you
might use results as one of these:

* A guide for the detailed investigation of individual programs, JCL, database
definitions, and other components.

Input to ASG’s ESW or other editing tool to implement the required changes.

. A scheduling tool to manage people and resources required to implement the
proposed changes.
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Selecting Items to be Analyzed

82

As shown in Figure 50, Alliance automatically creates a base selection list from the
entities you select from the impact list during the first summary analysis. If a worklist is
open, the base selection list is saved to that worklist.

Figure 50 « The Impact Facility Process

Impact List

Analyzer

Selection

Synonyms,
Assignments,
Parents,
Children

Remove I "
Referential Rmpa;:
Answers esults

Base
Selection

(Generate
Pop-up)

To generate a base impact analysis

1 Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

2 Select File » Open impact.

Or
Select File » New impact.
Press Enter.

3 Select or enter impact name and press PF5. The Select Impact Generation Entities
screen displays.
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4 Select the items to be analyzed. The list of selected items is called the base selection
list (see Figure 51). It is comprised of the occurrences of entities in the open
application that match the open impact list.

Figure 51 « Example of a Base Selection List

Summary Impact - Select Impact Generation Entities

Command ===* Scroll === LCER
Select the items from which the impact list will 1 of 5435
be generated.

Text Entity Kind Qualification >
) >
_ 'Coase’ EMTRY YIAAL1G. ABBEY.C
_ 'Coase’ EMTRY YIAAL1G. ABBEY.C
_ 'Ccoasct EMTRY YIAAL1G. ABBEY.C
_ 'Ccoasct EMTRY YIAAL1G. ABBEY.C
_ 'Ccoasct EMTRY YIAAL1G. ABBEY.C
_ 'Ccoasct EMTRY YIAAL1G. ABBEY.C
_ 'Ccoasct EMTRY YIAAL1G. ABBEY.C
_ 'Ccoasct EMTRY YIAAL1G. ABBEY.C
_ 'CDhimA’ EMTRY YIAAL1G. ABBEY.C
_ 'CDhimB’ EMTRY YIAAL1G. ABBEY.C
_ 'CDhimB’ EMTRY YIAAL1G. ABBEY.C
_ 'CDhimB’ EMTRY YIAAL1G. ABBEY.C

PFZ=0Optionas PFd=Generate PFS=%elect all PFG6=Hide entity kind

5  Use PF2 to review or designate the impact options to be applied to the impact
analysis.

6  Press PF4 to generate the impact analysis.

7 Review the analysis results, change base selection list, and refine impact options,
then rerun the impact analysis.

Locating Impacted Components and Relationships (Summary
Impact Analysis)
The summary analysis constitutes the first level of impact assessment results. After
selecting the items for the base selection list, specify the options that control how the

analysis is generated and execute the summary analysis. After reviewing the summary
analysis results, generate a detailed analysis to expand the information.
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To generate a summary impact analysis

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Select Generate » Summary and press Enter. The Summary Impact - Select Impact
Generation Entities pop-up displays, showing all occurrences of entities in the open
application matching those in the open impact list. The type of each entity is listed

along with qualification information that provides details on the occurrence location.

Type any character in the selection column beside the data items you want analyzed
and press Enter.

Or
Press PF5 to select all of the entities.
Press PF2 to view or change the impact generate options (see Figure 52).

Figure 52 « Impact Generate Options Screen

Impact Generate Options
Command ===%

Zelect desired Impact Generate Optiaons.
Include Base Selection in results
Include Copy Detail in results

Baze Impact Targets: Application Azzignments

Targets Lewvel Synonyms To From Alternates
/  Basze Selectiaon i _ _ _
£ Parents of Base Selection I

Children of Base Selectian _

Expanded Impact Targets: Application Azzignments

Targets Lewvel Synonyms To From Alternates
S Baze Impact Targets S _ _ _
S Parents of Base Impact Targets S _ _ _

Children of Base Impact Targets

PFd=Restore A5G Default Ontions PFS=Detailed Options

These options control the type and format of the information displayed as the result
of impact analysis, as well as the components of the base selection list. If this your
first time performing the impact analysis, ASG recommends that you use the option
defaults.

Note:

For step-by-step instructions on modifying default impact generate options, see
"Specifying New Impact Generate Options" on page 108.

Press PF4 to select default options.
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6  Press PF3 to return to the Summary Impact.

7 Press PF4 to generate the summary impact analysis. Analysis results display on the
Impact Facility screen (see Figure 53).

8 Save, append, and print the summary impact analysis results to a worklist.

9  Use the standard ISPF scroll keys to display the qualification information for each
entity identified.

Figure 53 « Impact Analysis Results - Impact Facility Screen

File Edit ¥iew Search Generate Worklist Options Help

Impact Facility ABBEY-AL
Command ===3> scroll ===* C:ER
Wame: ABBEY-AL - DATE IWPACT FOR TESTING 1 of 1229
ik
Impact Base Target List
Name kind Parent
'CDESE’ ENTRY YIAALL1A,. ABBEY.CO
'CDESE’ EMTRY YIAALL1A,.ABBEY.CO
‘CDASCY EMTRY YIAALLE. ABBEY. CO

Impact Generation Options

Include Base Selection im results
Include Copy Detail in results

Base Impact Targets: Application Assignments
Taragets Level Sunonums To Fram Alternates

Listing the Relationships of Impacted Items (Detailed Impact
Analysis)

Alliance builds the impact analysis by layering related components. The detailed analysis
shows what each layer in the summary analysis is and why the layer was applied to the
member of the base selection list. With detailed analysis, retrace all paths taken to
generate the summary analysis results.

Various information options control the information shown for each entity. The defaults
are name, entity kind, and containing component. Change the impact generate options to
modify the default display. After you have a base of summary and detailed analysis
results, look up unknown components to refine the input options and rerun the impact
analysis. For step-by-step instructions on modifying default impact generate options and
investigating unknown components, see "Modifying the Impact Analysis" on page 97.
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Detailed impact analysis results display hierarchically, with each level representing an
impact relationship path to a new component. When a single component is related to
several entities, these paths are represented at the same offset. The first component to the
left is the base selection entity. Figure 54 is an example of detailed analysis results.

Figure 54 « Example of Detailed Impact Analysis Results

File Edit Uiew Search Generate Worklist oOptions Help

Inpact Facility
Connand ===

Hanz: by Impact - Description

TOF OF DATA

Fcroll

Appll
S s

l of nn

s

[Selection One)

|

+- [Eelated Component)
[

| +- (Eelated Component]
[

|
- [Related Component]

I
- [Related Component]

| [

| - [Related Component)
|

|

I
- [Eelated Component)

- [Related Component)
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Understanding Detailed Analysis

The impact generate options determine the types of relationships assessed. The order in
which the assessment is performed is constant.

To perform a relationship assessment

1 Alliance identifies components hierarchically-related to base selection entities and
makes independent groups. Hierarchically-related entities are parents and children
of the application components you selected (see Figure 55).

Figure 55 ¢ Step 1 - Parents and Children of Base Selection Entities

Parents

1

Base Selection

Children

2 Alliance finds synonyms and local assignments (entities within the scope of the
target component that have direct and indirect data movement to and from one
another) for each group (see Figure 56).

Figure 56 » Step 2 - Synonyms and assignments

Application Level <:E{> Farents
Synonyms

Aprlcation Leve <E{> Base Se@@m&
Synonyms

Application Level <:E{> Children
Synonyms

&7
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3 Alliance groups accumulated components into a single base impact target group (see
Figure 57).

Figure 57 « Step 3 - Base Impact Targets

Application Level
Synonyms

Parents

<:E> Assignments TofFrom

Application Level
Synonyms

<;E> Base Selection Assignmerts ToFrom

Application Level

Children
Synonyms

<E> Assignments TofFrom

4  Alliance creates the expanded impact target group by identifying the parents and
children and the local assignments of the base impact target group (see Figure 58).

Figure 58 « Step 4 - Expanded Impact Targets

Application
Level Synonyms

Azsignments ToFrom

Base Impact Targets

Application
Lewel Synonyms

Aszignments ToFrom

¥
A pplication " -
Lewel Synonyms <E> Chilciren Assighments TofFrom

Expanded Impact Targets
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5  Alliance repeats step 3 and step 4 until no new component is discovered (see
Figure 59).

Figure 59 « Step 5 - Example of Entity Relationships

Stegin Job

DD has
]

Data ltem
in Record

Record Used
by FD

Hierarchical Relationships

Hierarchically-related components (parents and children) vary with the definition of the
entity. This table lists the parents and children of specific entity kinds recognized by

Alliance:
Entity Kind Parents Children
CICS mapset none CICS map, CICS map field
COBOL dataitem Containing group All within the group name
including rename, components until level
redefine, and 01, 66, or 77 (i.e. up to
88 level items the record level)
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Entity Kind Parents Children

IDMS area IDMS subschema, IDMS IDMS logical record, IDMS
schema record, IDMS map

IDMS logical record  none IDMS record

IDMS schema none IDMS subschema, IDMS area,

IDMS logical record, IDMS
record, IDMS map

IDMS subschema

IDMS schema

IDMS area, IDMS logical
record, IDMS record, IDMS
map

IMS DynAllocMacro  none DD, DSN

IMS segment none IMS segment

JCL job none JCL step, JCL DD

JCL INCLUDE none JCL step, JCL DD

JCL PROC none JCL step, JCL DD

JCL step none JCL DD

Segment none Segment

Senseg none Senseg

SQL column The owning Table or View  none

SQL database SQL Stogroup SQL tablespace, SQL table,
SQL view, SQL column

SQL Stogroup none SQL database, SQL tablespace,
SQL table, SQL view, SQL
column

SQL table or view none SQL columns within the table
or view

All others none none
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Referential Symbols

As the Application Analytical Engine (AAE) analyzes individual components within the
application, it encounters references to entities that are defined elsewhere. The AAE
marks each of these references to the entity to connect it to the definition of the entity,
and to the other references to the entity. These references are known as referential
symbols. The connecting process is the semantic linking phase of the analysis.

As the impact analysis traverses relationships (that is, parents, children, assignments,
synonyms, and entity relationships) to generate results, it uses referential symbols to step
from entity to entity in the relationship chains. Each referential symbol found during the
impact analysis is substituted by the appropriate definition symbol and removed from the
results.

Figure 60 illustrates the removal of referential symbols.

Figure 60 » Referential Symbol Removal

.. PGM1.
This will be removed

from the resullts. EILE CONTROL
\ SELECT EMPLOYEE ASSIGN T(ﬁ EMPFILE. )

| Reference Symbol I

Entity: EMPFILE

Enfity Kind: DD | Definition Symbol }—l
/ //BATCHRUN JOB (Xxx)...
This will be included

, Js EXEC PGM=PGM1...
in the resuits. (JEMPFILE) DD DSN=ABC.EMPFILE...
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In cases where the definition symbol does not exist within the application, a single
referential symbol is kept in the results of the impact analysis, as shown in Figure 61.

Figure 61 » Referential Symbol Inclusion

This will NOT be
removed from the PGM1.
results since there is
no definition symbol FILE CONTROL
to include. \ SELECT EMPLOYEE ASSIGN TQEMPFILE,
|
Entity: EMPFILE | Referenoel Symbol_|
Entity Kind: DD *
Definition Symbol
?
Execution JCL was not
defined to the
application.

Information Display Options
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You can control the display and type of the information shown in detailed impact analysis
results. The defaults for the display are connecting lines between related components and
an initial value of 4 for the number of levels shown. These are the defaults for the
information:

. Name
. Entity kind
. Containing component

. Connecting lines

Other options include:
. Containing component description
. Impact relationship

. Entity-relationship-entity information



5 Determining Impacted Components

For a complete description of impact generate options, see "Changing Impact Generate
Options" on page 97. For step-by-step instructions on modifying default impact generate
options, see "Specifying New Impact Generate Options" on page 108.

Depending on the display options you select, you can view this information to the right of
the components in the Impact Facility screen or in the Detailed Information pop-up for
the selected component. The information displayed pertains to the component at the
cursor location and the relationship it has to the component that caused it to show at its
current position in the results.

Figure 62 describes cursor placement.

Figure 62 * Detailed Information Pop-up - Cursor Placement Description

File Edit Uiew 3Zearch Generate WMorklist Options Help

IHpact Facility Lppll
ComAand ===F _ scroll === CER
Hahe: iy Impact - Descrption 1 ':'fm‘}}}_
TOFr OF DATA
[Selection One)
|
+- [Related Component & ----- Place mursor here to report on component & and its

[ relationship to Selection One.
| +-[Eelated Component B)

[

| -[Belated Component C) ----- Place cursor here to report on component C and its
| | relationship to Component 4.

| - [Eelated Component [N

| |
| - [Eelated Component E] ----- Place mursor here to report on Component E and

its relathipshuip to Component D

To generate a detailed impact analysis

1 Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

2 Select Generate » Detailed and press Enter. The Detailed Impact - Select Impact
Generation Entities pop-up displays all of the occurrences of entities in the open
application that match in the open impact list. The type of each entity is listed along
with qualification information providing details on the occurrence location.
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To select a data item for analysis, type any character in the column beside the data
item and press Enter.

Or

To select all entries, press PF5.
Press PF2 to view or change the impact generate options.

These options control the type and format of the information that the impact analysis
displays, as well as the components of the base selection list. If you are performing
the impact analysis for the first time, ASG recommends you use the defaults for these
options.

Note:

For step-by-step instructions on modifying default impact generate options, see
"Specifying New Impact Generate Options" on page 108.

Press PF4 to generate the detailed impact analysis. Analysis results display on the
Impact Facility screen.

You can save, append, and print the detailed impact analysis results to a worklist.
Use the standard ISPF scroll keys to display the qualification information for each
entity identified.

Figure 63 shows an example of the information displayed on the Impact Facility
screen after you generate the detailed impact analysis.

Figure 63 « Example of Detailed Impact Analysis Results
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5 Determining Impacted Components

To expand or collapse a path on the Impact Facility screen

1 Select View » Zoom In

Or
Select View » Zoom Out.
Press Enter.

2 Choose one of these options:
. Place the cursor on the desired component and press Enter.
. Place the cursor on the desired component.
. Press PF6 to Zoom In or PF5 to Zoom Out.

To display the Detail Information pop-up on the Impact Facility screen

1 Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

2 Select View P Details and press Enter.

3 Place the cursor on the desired component and press Enter.
Or

Press PF4 to display the Detail Information pop-up (see Figure 64).

Figure 64 » Detailed Information Pop-up

Detailed Information

Name ! CHECK_DATA OF PRIMT_CHECK OF PRMTCHK OF PRHTCHK
Entity Kind ! RECORD/DSECT/STRUCTURE, DATAITEM

Contalning Component: PRNTCHK OF PRMTCHK OF PRNTCHK OF YIAEXW TESTPL
Impact Relationship @ (E-R) DATA ITEM DATE IS IM RECORD CHECK_DATA,

4  Review the information. Use the standard ISPF scroll keys to display the
qualification information for each entity.

5 Press PF3 to exit.
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To view the Direct Path to an Impact result
1 Select View » Zoom Direct Path and press Enter.

2 Place the cursor on the desired component and press Enter. Alliance collapses all
lines except the detailed impact answers that show the path to the selected line.
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Modifying the Impact Analysis

This chapter describes the impact generate options, gives instructions on how to generate
impact options and work with impact lists, and contains these sections:

Section Page

Changing Impact Generate Options 97
Refining the Base Selection List 110

—_
—_
|98]

Rerunning the Impact Analysis

As described in the overview, at this stage you generate the first round of impact analysis
results, based upon the list of items you select for impact assessment. You can modify
impact generate options, change the base selection list, and execute new impact analysis
to retrace unknown components in the analysis results. Refine impact analysis parameters
and eliminate unknown components to limit the impact assessment to entities germane to
the change. Then, use these results to determine what actions need to be taken and
whether the current flow of data between components is redirected.

Changing Impact Generate Options

Impact generate options affect how the impact analysis traverses the data flow, as well as
the hierarchical relationships of the components. Using this new information, you might
modify the composition of the base selection list to include application components you
did not initially plan to analyze, such as application-level synonyms and local
assignments.
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You might also include additional hierarchical relationships to the results, depending on
the nature of the application and the task at hand. Use the Impact Generate Options screen
to specify parents and children of the selected targets, as well as application-level
synonyms and assignment synonyms of parents and children. Figure 65 shows the Impact
Generate Options screen with ESW defaults marked with a slash (/).

Figure 65 « Impact Generate Options Screen

Impact Generate Options
Caommand ===

Zelect desired Impact Generate Options.
Include Base Selection in results
Include Copy Detail in results

Base Impact Targets: Application Assignments

Targets Lewel Synonyms To Fram Alternates
# Base Selection i _ _ _
# Parents of Base Selection /

Children of Base Selection

Expanded Impact Targets: Application Aszignments

Targets Level Synonyms To Fram Alternates
£ Base Impact Targets /! _ _ _
/  Parents of Base Impact Targets /! _ _ _

Children of Base Impact Targets

PFd4=Restore ASG Default Ovotions PFS=Detailed Ootions

The options on the Impact Generate Options screen are available for these two groups:

. "Step 3 - Base Impact Targets" on page 88

. "Step 4 - Expanded Impact Targets" on page 88.

For a description of the impact analysis relationship assessment process, see
"Understanding Detailed Analysis" on page 87.

The Impact Generate Options screen also provides access to the detailed impact analysis
options that control the display of connecting lines, the number of levels displayed when
the data is collapsed, and the amount of information with each entity.

For a description of the options available for detailed analysis, see "Detailed Impact
Generate Options" on page 104.

For step-by-step instructions on modifying Impact Generate Options, see "Specifying
New Impact Generate Options" on page 108.




6 Modifying the Impact Analysis

Base Impact Targets Options

Base impact targets options consist of three levels: base selection, parents of base
selection, and children of base selection.

Base Selection

The base selection refers to the entities chosen from the Select Impact Generation Entities
pop-up (see "Selecting Items to be Analyzed" on page 82). The Base Selection option is
an ESW default that cannot be deleted. These are the options available for base selection:

Option Description

Application Level Includes application-level synonyms of the selected entities in
Synonyms the analysis.

Activates the Assignments To and Assignments From options.
ESW default for Base Selection.

Assignments To Includes entities that the selected entities assign value to in the
analysis.

For example, if A is the selected entity; A assigns value to B; B
is included in the analysis.

Assignments From Includes entities that the selected entities are assigned value
from in the analysis.

For example, if A is the selected entity; A is assigned value from
B; B is included in the analysis.

Assignments Includes data movement and comparisons within programs for
Alternates statements other than direct moves in the analysis.

Statements that make up this relationship are those where the
data in a variable alters the value of another variable, or where
one data item is compared to another.

Local or global synonyms calculations are not affected.

All languages and language levels supported by Alliance can
use this feature.
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Parents of Base Selection

Parents of base selection refers to the parents of entities chosen from the Select Impact
Generation Entities pop-up. The Parents of Base Selection option is an ESW default.
These are the options available for the parents of base selection:

Option Description

Application Level Includes application-level synonyms of the parents of the
Synonyms selected entities in the analysis.

Activates the Assignments To and Assignments From options.

ESW default for Parents of Base Selection.

Assignments To Includes entities that the parents of the selected entities assign
value to in the analysis.

For example, if A is the selected entity; B is the parent of A, and
B assigns value to C; C is included in the analysis.

Assignments From Includes entities that the parents of the selected entities are
assigned value from in the analysis.

For example, if A is the selected entity; B is the parent of A, and
B is assigned value from C, C is included in the analysis.

Assignments Includes data movement and comparisons within programs for
Alternates statements other than direct moves in the analysis.

Statements that make up this relationship are those where the
data in a variable alters the value of another variable, or where
one data item is compared to another.

Local or global synonyms calculations are not affected.

Alllanguages and language levels supported by Alliance can use
this feature.
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Children of Base Selection

Children of base selection refers to the children of entities chosen from the Select Impact
Generation Entities pop-up. If you select this option, all entities that are children of the
selected entities are included in the analysis. These are the options available for children
of base selection:

Option Description

Application Level Includes application-level synonyms of the children of the
Synonyms selected entities in the analysis.

Activates the Assignments To and Assignments From options.

Assignments To Includes entities that the children of the selected entities assign
value to in the analysis.

For example, if A is the selected entity; B is the child of A, and
B assigns value to C; C is included in the analysis.

Assignments From Includes entities that the children of the selected entities are
assigned value from in the analysis.

For example, if A is the selected entity; B is the child of A, and
B is assigned value from C, C is included in the analysis.

Assignments Includes data movement and comparisons within programs for
Alternates statements other than direct moves in the analysis.

Statements that make up this relationship are those where the
data in a variable alters the value of another variable, or where
one data item is compared to another.

Local or global synonyms calculations are not affected.

Alllanguages and language levels supported by Alliance can use
this feature.
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Expanded Impact Targets Options

Expanded Impact Targets options include all entities selected for analysis as a result of
the options set under Base Impact Target options. All base impact targets go into any
expanded impact targets option. Expanded impact targets options consist of three levels:
base impact targets, parents of impact targets, and children of impact targets.

Base Impact Targets

Base impact targets are the entities selected for analysis as a result of the options set for
the base selections. The Base Impact Targets option is an ESW default that cannot be
deleted. These are the options available for base impact targets:

Option Description

Application Level Includes application-level synonyms of the base impact targets in
Synonyms the analysis.

Activates the Assignments To and Assignments From options.

ESW defaults for Base Impact Targets.

Assignments To Includes entities that the base impact targets assign value to in the
analysis.

Assignments From Includes entities that the base impact targets are assigned value
from in the analysis.

Assignments Includes data movement and comparisons within programs for
Alternates statements other than direct moves in the analysis.

Statements that make up this relationship are those where the data
in a variable alters the value of another variable, or where one data
item is compared to another.

Local or global synonyms calculations are not affected.

All languages and language levels supported by Alliance can use
this feature.
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Parents of Base Impact Targets

The term parents of base impact targets refers to the parents of all entities selected for
analysis under that option. These are the options available for parents of base impact
targets:

Option Description

Application Level Includes application-level synonyms of the parents of the base
Synonyms impact targets in the analysis.

Activates the Assignments To and Assignments From options.

ESW default for Parents of Base Impact Targets.

Assignments To  Includes entities that the parents of the base impact targets assign
value to in the analysis.

Assignments Includes entities that the parents of the base impact targets are
From assigned value from in the analysis.

Assignments Includes data movement and comparisons within programs for
Alternates statements other than direct moves in the analysis.

Statements that make up this relationship are those where the data
in a variable alters the value of another variable, or where one data
item is compared to another.

Local or global synonyms calculations are not affected.

All languages and language levels supported by Alliance can use
this feature.

Children of Base Impact Targets

The term children of base impact targets refers to the children of all entities selected for
analysis under that option. These are the options available for children of base impact
targets:

Option Description

ApplicationLevel Includes application-level synonyms of the children of the base
Synonyms impact targets in the analysis.

Activates the Assignments To and Assignments From options.

Assignments To  Includes entities that the children of the base impact targets assign
value to in the analysis.
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Assignments Includes entities that the children of the base impact targets are
From assigned value from in the analysis.

Assignments Includes data movement and comparisons within programs for
Alternates statements other than direct moves in the analysis.

Statements that make up this relationship are those where the data in
a variable alters the value of another variable, or where one data item
is compared to another.

Local or global synonyms calculations are not affected.

All languages and language levels supported by Alliance can use
this feature.

Detailed Impact Generate Options
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The Detailed Impact Generate Options pop-up contains options that control the display of
connecting lines, the number of levels initially displayed on the Impact Facility screen for

detailed analysi

s, and the amount of information shown with each entity. Figure 66 shows

the Detailed Impact Generate Options pop-up with ESW defaults marked with a slash (/).

Figure 66 » Detailed Impact Generate Options Pop-up
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Display Options

These are the options available to control the display of information for detailed impact
analysis:

Option Description

Draw Connecting Controls the display of the connecting lines drawn from component
Lines to related component.

This is the ESW default for display options.

Initial Number of  Controls the number of levels shown upon initial display of the
Levels to Display  detailed impact analysis results. The number of levels specified
must be between 1 and 2,147,483,647 (MAXINT).

The default value is 4.
This option is ignored if Display All Levels is selected.

Display All Levels Forces all levels of impact relationship to be drawn on initial
display.

The ESW default is to disable this option.

Note:
The summary impact results do not necessarily match the detailed
impact results if you do not turn on the Display All Levels detailed
impact option.

Information Display Options

The options available to control the information displayed on the Impact Facility screen
for each entity in detailed impact analysis results are listed in this table.

Note:

To view data for disabled information options in the Impact Facility screen, display the
Detail Information pop-up for each component.
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These are the default information options:

Option Description

Name Includes the name of the component.
ESW default is enabled.

Entity Kind Includes the entity kind of the component as recognized by
Alliance.

A component can be defined as more than one entity kind. For
example, (DATAITEM, RECORD).

ESW default is enabled.
Containing Includes the name of the component in the application where the
Component entity was found.
ESW default is enabled.
Containing Specifies the type of the containing component. These are the
Component possible types:
Description ASM CICS-BMS CICS-CDS
CICS-FCT CICS-PCT CICS-PPT
COBOL IMS-MFS IMS-DBD
IMS-DFSMDA IMS-PSB JCL
LOADMOD PL/
Note:

The value of UNKNOWN displays when the containing
component is a dataset and its language type cannot be isolated.

Impact Relationship  Includes the nature of the impact relationship. Possible
relationships are listed on page 107.

ESW default is disabled.
Entity-Relationship-  Includes the specific relationship when the components are
Entity Information related because of an entity-relationship-entity connection.
ESW default is disabled.
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These are the possible impact relationships displayed when the Impact Relationship
option is enabled:

Relationship Name Description

CALL TO {PGM} Related items are used as actual and formal
parameters in a CALL statement.

{I/O ACTIVITY} [TO/FROM] Related items are used in an I/O activity to the

THE SAME FILE LOCATION same file location. The nature of the activity
displays when possible. /O ACTIVITY: READ,
CREATE, UPDATE, DELETE.

{I/O ACTIVITY} [TO/FROM] The related items are used in an I/O activity to the

THE SAME DATA BASE same database component. The nature of the

COMPONENT activity displays when possible. I/O ACTIVITY:
READ, CREATE, UPDATE, DELETE.

DEFINITION Related items refer to the same information by
definition, for example A REDEFINES B.

{INSTRUCTION} [TO/FROM] Related items are linked by an instructed data
{RELATED COMPONENT} flow. For example on a program level, if data was
moved from one item to the other.

These are the instructions for
causing data movement:

COBOL ACCEPT, MOVE, MOVE CORRESPONDING

I/O OPERATIONS READ, REWRITE, WRITE, SORT, MERGE,
RETURN, RELEASE

IDMS ACCEPT, END TRANSACTION WRITE,
FIND,OBTAIN, GET

SQL FETCH, UPDATE

IMS INSERT, GET, REPLACE

CICS SEND MAP, RECEIVE MAP, WRITE, READ,

READPREV, READNEXT, REWRITE

ENTITY RELATIONSHIP Related items are found in an
entity-relationship-entity connection.

[PARENT/CHILD] Related items are connected because a parent or
child has an impact relationship.
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Figure 67 shows the format of the data shown on the Impact Facility screen. If you
disable any of the information options, the information is removed from the pattern and
the remaining information stays in the same sequence. Use the Detail Information pop-up
for each component to view the data.

Figure 67 * Information Options Format

{name} {(entity kind)} {OF containing component{ (description)}} {- impact
relationship{ (entity-relationship-entity) }}

Containing Impact
Name Component Relationship

I I | \

+- PAYFILE (FD) OF PGM2 (COBOL) - ENTITY RELATIONSHIP (RECORD USEDBY FD)

\ \ \ I

Entity Kind Containing Entity-Relationship-Entity

Component
Description

Specifying New Impact Generate Options
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To change impact generate options

1 Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

2 Select Generate » Summary and press Enter.

Note:
If you have already generated impact analysis results without an open worklist, a
warning displays telling you to open or create a worklist, or confirm that you do not
want to save the current data.

3  To display the Impact Generate Options pop-up, press PF2 on the Select Impact
Generation Entities pop-up.

Choose one of these actions:

a  To select an option in the Targets column, type any character to the left of the
option.

b  Select Application Level Synonyms options by typing any character beneath
that column, next to the appropriate target level.

¢ Select Assignments by typing any character in the To, From, or Alternates
column.



6 Modifying the Impact Analysis

1

For information about base and expanded impact targets options, see "Base Impact
Targets Options" on page 99 and "Expanded Impact Targets Options" on page 102.

When you have finished selecting options, press PF3 to return to the Select Impact
Generation Entities pop-up.

To reset default impact generate options

1

4

5

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Select Generate » Summary and press Enter.

On the Select Impact Generation Entities pop-up, press PF2 to display the Impact
Generate Options pop-up.

Press PF4 to restore the defaults.

Press PF3 to return to the Select Impact Generation Entities pop-up.

To change detailed impact generate options

1

6

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Select Generate P Detailed and press Enter.

On the Select Impact Generation Entities pop-up, press PF2 to display the Impact
Generate Options pop-up.

Press PF5 to display the Detailed Impact Generate Options pop-up.

Specify the desired options and press PF3 to return to the Impact Generate Options
pop-up.

Press PF3 again to return to the Select Impact Generation Entities pop-up.

To reset default detailed impact generate options

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Select Generate P Detailed and press Enter.

On the Select Impact Generation Entities pop-up, press PF2 to display the Impact
Generate Options pop-up.
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4  Press PF5 to display the Detailed Impact Generate Options pop-up.
5  Press PF4 to restore the defaults.
6  Press PF3 to return to the Impact Generate Options pop-up.

7 Press PF3 again to return to the Select Impact Generation Entities pop-up.

Refining the Base Selection List

Modify the composition of the base selection list to recover data not found in previous
analyses. Depending on the situation, you can perform these tasks:

. Revise the impact list from where the base selection list is derived.

. Rebuild the base selection list you specified in the Select Impact Generation
Entities pop-up.

. Revise impact generate options that determine the base and expanded impact
targets.

Revising an Impact List

To modify an existing impact list (open)

1 Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

2 Choose Edit » Impact list and press Enter. The Impact Entity List pop-up displays
with the list of previously defined impact list entities.

To modify an existing impact list (closed)

1 Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

2 Select File » Open impact list and press Enter.

3 In the Open Impact List pop-up, type any character in the selection column to the left
of the impact list you want to modify and press Enter.

4  Press PF4 (Edit). The Impact Entity List pop-up displays with the list of previously
defined impact list entities.
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To add components to an open impact list

1

From the Impact Entity List pop-up, press PF4 (Add). The Impact Entities Selection
Criteria pop-up displays.

Type the full name of an entity kind.
Or
Type a pattern for selection in the Text field.

Note:

If you enter a pattern and want to limit the entity kinds selected, specify one or more
entity kinds by typing any character in the selection column to the left of the entity
name.

Press Enter. The Add Impact List Entity pop-up displays (Figure 48 on page 78)
showing the list of entity names matching the text entered on the Impact Entities
Selection Criteria pop-up. The list is scrollable.

Type any character in the selection column beside the desired entity name. Select as
many entities as needed.

Press PF10 to add the entries and return to the Impact Entity List pop-up.
Press PF3 to return to the Open Impact List pop-up.

Press PF3 again to return to the Impact Facility screen.

To remove components from an open impact list

1

On the Impact Entity List pop-up, select the entities you want to remove by typing
any character in the selection column to the left of the entity name.

Press PF5 (Delete).

Caution! The deletion takes place instantly, without a confirmation message
allowing you to cancel.

Press PF3 to return to the Impact Facility screen.

111



ASG-Alliance User’s Guide

To save the updated impact list

1

Select File P Save impact list from the Impact Facility screen and press Enter. The
message [impact list name] HAS BEEN SAVED TO IMPACT
DEFINITION displays confirming that the original impact list updated with the new
information.

Or

Select File P Save impact list and press Enter to preserve the original impact list and
store the impact list under a new name.

The Save Impact As pop-up displays with the name and description of the original
impact list.

Type the name and description of the new impact list in the Name and Description
fields and press Enter.

The Impact Facility screen returns with the message [impact 1ist name]
HAS BEEN SAVED TO IMPACT DEFINITION confirming the creation of the
new impact list.

Rebuilding the Base Selection List
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To rebuild the base selection list

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Select Generate » Summary and press Enter. The Summary Impact - Select
Impact Generation Entities pop-up displays showing all entities in the open
application that match in the open impact list. The type of each entity is listed along
with qualification information that provides details on the occurrence location.

To specify the new entity names to be analyzed, type any character in the selection
column beside the data items you want to select.

Or
To select all entities, press PF5.
Proceed with the analysis.

For step-by-step instructions on generating summary and detailed analysis results,
see "Locating Impacted Components and Relationships (Summary Impact
Analysis)" on page 83 and "Listing the Relationships of Impacted Items (Detailed
Impact Analysis)" on page 85.
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Rerunning the Impact Analysis

As described in the overview, the final stage in the refining process is rerunning the
impact analysis. Iterate the impact analysis until you get the results you need to proceed
with a change request implementation.

To rerun the impact analysis

1 Review the results of previous impact analysis.

2 Investigate the paths traversed by components related to the change.

3  Refine analysis parameters by modifying the impact list, base selection list, and
impact generate options.

For instructions on generating summary and detailed analysis results, see "Locating
Impacted Components and Relationships (Summary Impact Analysis)" on page 83 and
"Listing the Relationships of Impacted Items (Detailed Impact Analysis)" on page 85.
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Appendix A

Valid Entities and Relationships

Alliance recognizes these entities by multiple names:

. FD, FILEVAR, or DCB

. PROGRAM, PROCEDURE, or FUNCTION

. RECORD, DSECT, or STRUCTURE

These are the entities recognized by Alliance (listed in alphabetical order):

AREA

CATALOG
CICS-TRANSACTION
COLUMN
COPYMEMBER

CSD

CSECT

CURSOR

DATABASE
DATAITEM

DBD
DCB/FD/FILEVAR
DD
DSECT/RECORD/STRUCTURE
DSN

ENTRY

FCT

LOADMODULE

LOGICALRECORD

MAP

MAPFIELD

MAPSET

MEMBER

PCB

PCT

PPT

PROC
PROCEDURE/PROGRAM/FUNCTION
PROGRAM/PROCEDURE/FUNCTION
PSB

RECORD/DSECT/STRUCTURE
SCHEMA

SEGFIELD

SEGMENT
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FCTCSD
FD/FILEVAR/DCB
FILEVAR/FD/DCB
FUNCTION/PROGRAM/PROCEDURE
IDMS

IDMS MAP

IDMS RECORD
IMS-TRANSACTION
IMS-FORMAT
IMSDYNALLOCMACRO
JOB

LIBRARY

SENFIELD

SENSEG

SQL

STEP

STOGROUP
STRUCTURE/RECORD/DSECT
SUBSCHEMA

TABLE

TABLESPACE

VIEW

These are the relationships recognized by Alliance (listed in alphabetical order):

ALTERNATE LINKED-BY
CALLED-BY LINKS

CALLS LOCALSYNONYM
DEFINED-IN REFERENCED-BY
EXECUTED-BY REFERENCES
EXECUTES SELECTED-BY
HAS SELECTS
HOMONYM SYNONYM

IN USEDBY
INCLUDES USES

IS
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These are the entity-relationships recognized by Alliance (listed in alphabetical order):

Definitions of Valid Entities in Alliance Query Usage

AREA HAS IDMSRECORD Identifies records located in
logical areas of IDMS
schemas.

AREA IN PROGRAM Identifies logical areas of

PROCEDURE IDMS schemas in programs.
FUNCTION

AREA IN SUBSCHEMA Identifies local areas in IDMS
databases that are defined
within subschemas.

CATALOG USEDBY JOB Identifies catalogs used by
jobs in an application.

CATALOG USEDBY STEP Identifies catalogs used by
Job Steps in an application.

CICS-TRANSACTION EXECUTED-BY PROGRAM Identifies all CICS

PROCEDURE transactions executed by
programs within an
FUNCTION application.
CICS-TRANSACTION EXECUTES PROGRAM Identifies programs executed
PROCEDURE by CICS transactions within
an application.
FUNCTION

CICS-TRANSACTION IN CSD Identifies CICS transactions
in CSD files.

CICS-TRANSACTION IN PCT Identifies CICS transactions
within PCTs.

COLUMN IN PROGRAM Identifies relational database

PROCEDURE fields as referenced in a
program.
FUNCTION

COLUMN IN TABLE Identifies fields within
relational database tables.

COLUMN IN VIEW Identifies fields within
relational database views.

COPYMEMBER HAS DATAITEM Identifies copymembers that
are directly included by the
copymember. Same applies
to JCL INCLUDES.

COPYMEMBER IN COPYMEMBER Identifies copymembers that

directly include
copymembers.
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COPYMEMBER

Definitions of Valid Entities in Alliance Query Usage

MEMBER

Identifies members that
contain a copybook. Same
applies to JCL INCLUDES.

COPYMEMBER

IN

PROGRAM
PROCEDURE
FUNCTION

Identifies copymembers
referenced by programs
defined to an application.
Identifies JCL INCLUDES
referenced by JCL defined to
an application.

COPYMEMBER

INCLUDES

COPYMEMBER

Identifies copymembers
referencing data items
defined in a copymember.
Same applies to JCL
INCLUDES.

COPYMEMBER

USEDBY

COPYMEMBER

Identifies copymembers that
directly and indirectly
include copymembers (nested
copies). Same applies to JCL
INCLUDES.

COPYMEMBER

USEDBY

MEMBER

Lists copymembers that are
included in program
members. Also lists JCL
INCLUDES that are included
in the JCL.

COPYMEMBER

USES

COPYMEMBER

Identifies copymembers
directly and indirectly
included by copymembers
(nested copies). Same applies
to JCL INCLUDES.

CSD

HAS

CICS-TRANSACTION

Identifies CICS transactions
defined in CSD files.

CSD

HAS

DD

Identifies DDs defined in
CSD files.

CSECT

LOADMODULE

Identifies control sections in a
load module.

CSECT

IS

PROGRAM
PROCEDURE
FUNCTION

Identifies control sections in a
program.

Assigns CSECTS to a
Program.

CURSOR

IN

DATABASE

Identifies SQL object
pointers that can be used to
run through a set of records
that are returned by a query.

CURSOR

IN

PROGRAM
PROCEDURE
FUNCTION

Identifies SQL cursors
referenced within a program.
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Definitions of Valid Entities in Alliance Query Usage

DATABASE HAS CURSOR Identifies SQL cursors that
are defined to a database.
DATABASE HAS TABLESPACE Indicates the available
tablespaces in a DB2
database.
DATABASE IN PROGRAM Indicates the program where
PROCEDURE DB2 databases are
referenced.
FUNCTION
DATABASE IN STOGROUP Indicates the storage
GROUPS where a DB2
database resides.
DATAITEM DEFINED-IN COPYMEMBER Identifies data items defined
by each copymember defined
to the application.
DATAITEM DEFINED-IN PROGRAM Identifies data items defined
PROCEDURE by each program in an
application.
FUNCTION
DATAITEM HOMONYM DATAITEM Lists homonyms of data items
in an application.
DATAITEM IN RECORD Lists records containing data
DSECT items.
STRUCTURE
DATAITEM LOCALSYNONYM DATAITEM Lists local synonyms of data
items within a program.
DATAITEM SYNONYM DATAITEM Lists global synonyms of data
items in an application.
DBD HAS DD Identifies the DD names to
which the database
definitions are allocated.
DBD HAS SEGMENT Identifies the segments
(records) in an IMS database
that are defined by the
database definition.
DBD IN MEMBER Identifies members
containing an IMS
DBDGEN.
DBD IN PCB Identifies database

definitions included in a PCB
(Program Communication
Block).
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DCB (See FD)

Definitions of Valid Entities in Alliance Query Usage

DD HAS DSN Identifies DSNs referenced
by DD statement.

DD IN CSD Identifies DD statements in
CSD files.

DD IN DBD Identifies DD statements in a
database description.

DD IN FCT Identifies DD statements in a
CICS FCT.

DD IN FCTCSD Identifies the location where
DDs are defined by a CICS
CSD entry.

DD IN STEP Identifies DD statements in
each step of a JCL job stream.

DD SELECTED-BY FD Identifies DD names
referenced by an FD

FILEVAR statement within a COBOL
DCB program.
DD USEDBY PROGRAM Lists DD names used in a
PROCEDURE program via CICS
statements.
FUNCTION

DSECT

(See RECORD)

DSN HAS MEMBER Lists the members within a
partitioned dataset.

DSN IN DD Specifies dataset names, as
specified in the DD statement
in the JCL.

ENTRY CALLED-BY PROGRAM Identifies entry names called

PROCEDURE by a program.
FUNCTION
ENTRY IN PROGRAM Identifies a program's entry
PROCEDURE point names.
FUNCTION

FCT HAS DD Identifies DDs defined in
FCTS.

FCT IN MEMBER Lists members that contain an

FCT.
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Definitions of Valid Entities in Alliance Query Usage

FCTCSD HAS DD Identifies where CICS DDs
were defined in CSD files.
FD IN PROGRAM Identifies the file description
FILEVAR PROCEDURE statements in a COBOL
source program.
DCB FUNCTION
FD SELECTS DD Lists the DD names
referenced by an FD
FILEVAR statement in a COBOL
DCB program.
FD USES RECORD Lists record names
FILEVAR DSECT referenced by FD statements.
DCB STRUCTURE
FILEVAR
(See FD)
FUNCTION
(See PROGRAM)
IDMS IN PROGRAM Lists IDMS entities
PROCEDURE referenced in a program.
FUNCTION
IDMSMAP HAS IDMSRECORD Shows the relationship
between IDMS screen maps
and records.
IDMSMAP IN PROGRAM Identifies programs that
PROCEDURE reference IDMS maps.
FUNCTION
IDMSRECORD IN AREA Lists IDMS records
contained in logical areas.
IDMSRECORD IN IDMSMAP Shows the relationship
between IDMS screen
records and maps.
IDMSRECORD IN LOGICALRECORD Lists IDMS subschema
records contained in IDMS
logical records.
IDMSRECORD IN PROGRAM Identifies programs that
PROCEDURE reference IDMS records.
FUNCTION
IMSDYNALLOCMACRO 1IN MEMBER Lists PDS members that

contain IMS dynamic
allocation macros.
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Definitions of Valid Entities in Alliance Query Usage

IMS-FORMAT EXECUTED-BY IMS-FORMAT Lists the formats(s) executed
by a format.

IMS-FORMAT EXECUTED-BY PROGRAM Identifies programs that

PROCEDURE invoke IMS formats.
FUNCTION

IMS-FORMAT EXECUTES IMS-TRANSACTION Lists the formats that execute
an IMS transaction.

IMS-FORMAT EXECUTES IMS-FORMAT Lists formats that execute
IMS formats.

IMS-FORMAT IN MEMBER Lists PDS members that
contain IMS format
definitions.

IMS-TRANSACTION EXECUTED-BY IMS-FORMAT Lists the IMS transactions
executed by IMS formats.

IMS-TRANSACTION EXECUTED-BY PROGRAM Identifies programs that

PROCEDURE invoke IMS transactions.
FUNCTION

IMS-TRANSACTION EXECUTES LOADMODULE Lists the load modules
executed by IMS
transactions.

JOB HAS STEP Lists all JCL job names in the
application along with their
associated step names.

JOB IN MEMBER Lists JCL job names and their
containing member names.

JOB USES CATALOG Lists the JCL job names in the
application and the names of
the catalogs they use, if any.

JOB USES LIBRARY Lists the JCL job names in the
application and the JOBLIBS
used.

LIBRARY HAS MEMBER Lists the partitioned dataset
names in the application and
their member names.

LIBRARY USEDBY JOB Lists the libraries used as
JOBLIBS and the jobs
referencing them.

LIBRARY USEDBY STEP Lists the libraries used as

STEPLIBs and the steps
referencing them.
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Definitions of Valid Entities in Alliance Query Usage

LOADMODULE EXECUTED-BY IMS-TRANSACTION Lists the load module names
in the application that are
executed by IMS
transactions.

LOADMODULE EXECUTED-BY STEP Lists the load module names
in the application and the JCL
step names that execute them.

LOADMODULE HAS CSECT Lists the load modules in an
application and their CSECT
names.

LOADMODULE IN MEMBER Lists the load modules in an
application and their member
names in the partition
datasets where they are
located.

LOGICALRECORD HAS IDMSRECORD Lists IDMS logical records in
an application and the IDMS
records they contain.

LOGICALRECORD IN PROGRAM Lists IDMS logical records

PROCEDURE referenced in a program.
FUNCTION

MAP HAS MAPFIELD Lists CICS maps in an
application and their
mapfield names.

MAP IN MAPSET Lists CICS maps and the
mapsets that contain them.

MAP REFERENCES RECORD Establishes the relationship

DSECT of CICS maps to COBOL
records.
STRUCTURE
MAP USEDBY PROGRAM Lists CICS maps in an
PROCEDURE application, and the programs
where they are used.
FUNCTION

MAPFIELD IN MAP Lists CICS mapfields in an
application and the map
names that contains them.

MAPSET HAS MAP Lists mapsets in an
application and the maps
contained by the mapsets.

MAPSET IN MEMBER Lists CICS mapsets in an

application and their member
names in a partitioned
dataset.
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MAPSET

Definitions of Valid Entities in Alliance Query Usage

USEDBY

PROGRAM
PROCEDURE
FUNCTION

Lists CICS mapsets in an
application and the programs
that reference them.

MEMBER

HAS

COPYMEMBER

Lists the member names of
partitioned datasets that
contain copymembers. Same
applies to JCL INCLUDES.

MEMBER

HAS

DBD

Lists the member names of
partitioned datasets that
contain DBDS.

MEMBER

HAS

FCT

Lists the member names of
partitioned datasets that
contain FCTS.

MEMBER

HAS

FORMAT

Identifies member names of
partitioned datasets that
contain MFS definitions for
the formats.

MEMBER

HAS

IMSDYNALLOCMACRO

Lists the member names of
partitioned datasets that
contain dynamic allocation
macros.

MEMBER

HAS

JOB

Lists the member names of
partitioned datasets that
contain JCL job streams.

MEMBER

HAS

LOADMODULE

Lists the member names of
partitioned datasets that
contain load modules.

MEMBER

HAS

MAPSET

Lists the member names of
partitioned datasets that
contain mapsets.

MEMBER

HAS

PCT

Lists the member names of
partitioned datasets that
contain PCTS.

MEMBER

HAS

PPT

Lists the member names of
partitioned datasets that
contain PPTS.

MEMBER

HAS

PROC

Lists cataloged procedure
names and their member
names in a partitioned
dataset.

MEMBER

HAS

PROGRAM
PROCEDURE
FUNCTION

Lists the program names in an
application and their member
name in a partitioned dataset.
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Definitions of Valid Entities in Alliance Query Usage

MEMBER HAS PSB Lists the member names of
partitioned datasets that
contain PSBS.

MEMBER IN DSN Lists partition dataset names
and their member names.

MEMBER IN LIBRARY Lists the partitioned dataset
names in the application and
their member names.

MEMBER USES COPYMEMBER Lists the member names of
partitioned datasets that
contain included
copymembers. Same applies
to JCL INCLUDES.

PCB HAS SENSEG Lists PCBs that have
sensitive segments as defined
by SENSEG statements.

PCB IN PSB Lists IMS program
communication blocks and
the PSB where they are
located.

PCB REFERENCES DBD Lists IMS PCBs and the
DBDS they reference.

PCT HAS CICS-TRANSACTION Lists CICS transactions
defined in PCTS.

PCT IN MEMBER Lists PCTS and their member
names in partitioned datasets.

PPT IN MEMBER Lists PPTS and their member
names in partitioned datasets.

PROC EXECUTED-BY STEP Lists cataloged procedures
and the step names that
execute them.

PROC HAS STEP Lists step names in catalog
procedures.

PROC IN MEMBER Lists PROC names and their
member names in partitioned
datasets.

PROCEDURE

(See PROGRAM)

PROGRAM CALLS ENTRY Lists programs in the

PROCEDURE application that issue calls to
load module entry points.

FUNCTION
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Definitions of Valid Entities in Alliance Query Usage

PROGRAM EXECUTED-BY CICS-TRANSACTION Lists programs in the
application that are executed

PROCEDURE by CICS transactions.

FUNCTION

PROGRAM EXECUTES CICS-TRANSACTION Lists programs in the

PROCEDURE application that execute CICS
transactions.

FUNCTION

PROGRAM EXECUTES IMS-FORMAT Lists programs in the

PROCEDURE application that execute IMS
formats.

FUNCTION

PROGRAM EXECUTES IMS-TRANSACTION Lists programs in the

PROCEDURE application that execute IMS
transactions.

FUNCTION

PROGRAM HAS AREA Lists IDMS areas referenced

PROCEDURE by programs within an
application.

FUNCTION

PROGRAM HAS COLUMN Lists DB2 columns

PROCEDURE referenced by programs
within an application.

FUNCTION

PROGRAM HAS CURSOR Lists DB2 cursors referenced

PROCEDURE by programs within an
application.

FUNCTION

PROGRAM HAS DATABASE Lists DB2 databases

PROCEDURE referenced by programs
within an application.

FUNCTION

PROGRAM HAS DATAITEM Lists programs in the

PROCEDURE application and data items
defined in that program.

FUNCTION

PROGRAM HAS ENTRY Lists programs in the

PROCEDURE application and any ENTRY
point names.

FUNCTION

PROGRAM HAS FD Lists programs in the

PROCEDURE FILEVAR application that have FD
statements.

FUNCTION DCB

PROGRAM HAS IDMS Lists programs in the
application that reference

PROCEDURE IDMS entities.

FUNCTION
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Definitions of Valid Entities in Alliance Query Usage

PROGRAM HAS IDMSMAP Lists IDMS maps referenced
PROCEDURE by programs within an
FUNCTION application.
PROGRAM HAS IDMSRECORD Lists IDMS records
PROCEDURE referenced by programs
FUNCTION within an application.
PROGRAM HAS LOGICALRECORD Lists IDMS logical records
PROCEDURE referenced by programs
FUNCTION within an application.
PROGRAM HAS RECORD Lists programs in the
PROCEDURE DSECT application and record names
FUNCTION STRUCTURE referenced in FD statements.
PROGRAM HAS SCHEMA Lists IDMS schemas
PROCEDURE referenced by programs
FUNCTION within an application.
PROGRAM HAS SQL Lists programs in the
application that reference
iE}?}Eﬁ?&f:E SQL entities.
PROGRAM HAS STOGROUP Lists DB2 storage groups
PROCEDURE referenced by programs
FUNCTION within an application.
PROGRAM HAS SUBSCHEMA Lists IDMS subschemas
PROCEDURE referenced by programs
FUNCTION within an application.
PROGRAM HAS TABLE Lists DB2 tables referenced
PROCEDURE by }iyogyams within an
FUNCTION application.
PROGRAM HAS TABLESPACE Lists DB2 tablespaces
PROCEDURE referenced by programs
FUNCTION within an application.
PROGRAM HAS VIEW Lists DB2 views referenced
PROCEDURE by programs within an
FUNCTION application.
PROGRAM IN MEMBER Lists the program names in
PROCEDURE the application and their
member names in a
FUNCTION partitioned dataset.
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Definitions of Valid Entities in Alliance Query Usage

PROGRAM INCLUDES COPYMEMBER Lists programs in the

PROCEDURE application that have copy or
include statements.

FUNCTION

PROGRAM IS CSECT Establishes linkage between

PROCEDURE CSECTSs and programs.

FUNCTION

PROGRAM LINKED-BY PROGRAM Lists programs executed by

PROCEDURE PROCEDURE CICS LINKs or XCTL
statements.

FUNCTION FUNCTION

PROGRAM LINKS PROGRAM Lists programs that execute
other programs via CICS

PROCEDURE PROCEDURE LINKS or XCTLs.

FUNCTION FUNCTION

PROGRAM USES DD Lists programs in the
application and the DD

PROCEDURE names referenced via CICS

FUNCTION statements.

PROGRAM USES MAP Lists programs in the

PROCEDURE application that use CICS
maps.

FUNCTION

PROGRAM USES MAPSET Lists programs in the

PROCEDURE application that reference
CICS mapsets.

FUNCTION

PROGRAM USES PSB Lists programs in the
application that use IMS

PROCEDURE PSBS.

FUNCTION

PROGRAM USES SEGMENT Lists programs in that
application that use segments

PROCEDURE in an IMS database.

FUNCTION

PSB HAS PCB Lists PSBs in the application
and PCBs contained by the
PSBS.

PSB IN MEMBER Lists PSBs in the application
and the member names they
are stored under in partitioned
datasets.

PSB USEDBY PROGRAM Lists PSBs in the application

PROCEDURE and the programs that use
them.
FUNCTION
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Definitions of Valid Entities in Alliance Query Usage

RECORD HAS DATAITEM Lists the record names in an

DSECT application and their field
names.

STRUCTURE

RECORD IN PROGRAM Lists the record names in a

DSECT PROCEDURE program.

STRUCTURE FUNCTION

RECORD REFERENCED-BY MAP Lists the record names

DSECT defined to an application and
the map names that reference

STRUCTURE them.

RECORD USEDBY FD Lists the record names
defined to an application and

DSECT FILEVAR the FDs that use them.

STRUCTURE DCB

SCHEMA HAS SUBSCHEMA Lists the IDMS schemas
defined to an application and
their associated subschemas.

SCHEMA IN PROGRAM Lists programs that reference

PROCEDURE entities defined in IDMS
schemas.
FUNCTION

SEGFIELD IN SEGMENT Lists the IMS segment fields
defined to an application and
the segments where they are
defined.

SEGMENT HAS SEGFIELD Lists the IMS segments
defined to an application and
the fields defined within
them.

SEGMENT IN DBD Lists IMS segments and the
parental DBD associated with
them.

SEGMENT IN SEGMENT Lists the segments in an IMS
database and their parent
segments.

SEGMENT USEDBY PROGRAM Lists IMS segments used by

PROCEDURE programs within an
application.
FUNCTION
SEGMENT USES SEGMENT List the segments in an IMS

database and their child
segments.
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SENFIELD IN SENSEG Lists sensitive fields (defined
by an IMS SENFIELD
statement) in a sensitive
segment (defined by an IMS
SENSEG statement).

SENSEG HAS SENFIELD Lists IMS sensitive segments
and any fields within the
segment defined with a

SENFIELD statement.
SENSEG IN PCB Lists sensitive segments and
the PCB names where they
appear.
SENSEG IN SENSEG Lists the SENSEGs in a PCB

and their parental SENSEGs.

SENSEG USES SENSEG Lists the SENSEGs in a PCB
and their children SENSEGs.

SQL IN PROGRAM Lists SQL entities and any
PROCEDURE referencing programs.
FUNCTION

STEP EXECUTES LOADMODULE Lists JCL step names and the
load module names that they
execute.

STEP EXECUTES PROC Lists JCL job steps that
execute PROCS.

STEP HAS DD Lists steps and DDS
referenced by them.

STEP IN JOB Lists step names and the job
names they are associated
with.

STEP IN PROC Lists step names and the
PROCS where they reside.

STEP USES CATALOG Lists JCL step names and the
catalogs that are referenced in
the step.

STEP USES LIBRARY Lists JCL step names and the
libraries that are referenced as
STEPLIBs.

STOGROUP HAS DATABASE Lists the storage groups and
the DB2 databases they
contain.
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Definitions of Valid Entities in Alliance Query Usage

STOGROUP IN PROGRAM Lists storage group names
PROCEDURE and the programs where they
are defined.
FUNCTION

STRUCTURE

(See RECORD)

SUBSCHEMA HAS AREA Lists IDMS subschema
names and the logical areas in
an IDMS database defined
within the subschemas.

SUBSCHEMA HAS LOGICALRECORD Lists IDMS subschema
names and the logical record
names that they are
associated with.

SUBSCHEMA IN PROGRAM Lists programs that reference

PROCEDURE entities defined in IDMS
subschemas.
FUNCTION

SUBSCHEMA IN SCHEMA Lists IDMS subschema
names in the schemas with
which they are associated.

TABLE HAS COLUMN Lists DB2 relational database
table definitions and the
columns defined within them.

TABLE IN PROGRAM Lists programs that reference

PROCEDURE relational database tables.
FUNCTION

TABLE IN TABLESPACE Lists DB2 tables and the
tablespaces that contains
them.

TABLESPACE HAS TABLE Lists DB2 tablespaces and the
tables defined within.

TABLESPACE HAS VIEW Lists DB2 tablespaces and the
views defined within.

TABLESPACE IN DATABASE Lists DB2 tablespaces and the
databases where they are
defined.

TABLESPACE IN PROGRAM Lists programs that reference

PROCEDURE entities defined within DB2
tablespaces.
FUNCTION
VIEW HAS COLUMN Lists any defined DB2 views

and the columns they control.
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VIEW IN PROGRAM Lists any defined DB2 views
PROCEDURE and the programs that use
them.
FUNCTION
VIEW IN TABLESPACE Lists DB2 views and the
tablespaces where they are
defined.
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Impact Analysis Entity Relationships

The Alliance Impact Facility traverses these recognized relationships searching for

additional impact answers for each of these starting entity kinds:

Starting Entity Kind Entity Relationships

AREA AREA IN PROGRAM
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
AREA HAS IDMSRECORD
IDMSRECORD IN PROGRAM
IDMSRECORD IN IDMSMAP
IDMSMAP IN PROGRAM

CATALOG CATALOG USEDBY JOB
CATALOG USEDBY STEP
STEP IN JOB
STEP IN PROC
PROC EXECUTED-BY STEP

CICS TRANSACTION CICSTRANSACTION EXECUTES PROGRAM
CICSTRANSACTION EXECUTED-BY PROGRAM
CICSTRANSACTION IN CSD
CICSTRANSACTION IN PCT
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Starting Entity Kind Entity Relationships

COLUMN COLUMN IN PROGRAM
COLUMN IN VIEW
VIEW IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
COLUMN IN TABLE
TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
IDMSRECORD IN IDMSMAP
IDMSRECORD IN LOGICAL

RECORD

LOGICAL IN PROGRAM
RECORD
IDMSRECORD IN PROGRAM
DATAITEM IN RECORD
RECORD REFERENCED-BY  MAP
MAP IN MAPSET
MAP HAS MAPFIELD
RECORD USEDBY FD
FD SELECTS DD
DD HAS DSN
DSN HAS MEMBER
DD IN DBD
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Starting Entity Kind Entity Relationships

DD IN FCT

DD IN CSD

SEGMENT HAS SEGFIELD

SEGMENT IN SEGMENT

SEGMENT USES SEGMENT

SEGMENT USEDBY PROGRAM

SEGMENT IN DBD

SENSEG USES SENSEG

SENSEG IN SENSEG

SENSEG HAS SENFIELD

SENSEG IN PCB

PCB REFERENCES DBD

PCB IN PSB

PSB USEDBY PROGRAM
COPYMEMBER COPYMEMBER IN PROGRAM

COPYMEMBER USEDBY COPYMEMBER

COPYMEMBER USES COPYMEMBER

COPYMEMBER HAS DATAITEM

DATAITEM IN RECORD

RECORD REFERENCED-BY  MAP

MAP IN MAPSET

MAP HAS MAPFIELD

RECORD USEDBY FD

FD SELECTS DD

DD IN DBD
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Starting Entity Kind Entity Relationships

DD IN FCT

DD IN CSD

DD HAS DSN

DSN HAS MEMBER
CSECT CSECT IN LOADMODULE

LOADMODULE IN MEMBER

MEMBER IN LIBRARY

LOADMODULE EXECUTED-BY IMSTRANSACTION

LOADMODULE EXECUTED-BY STEP

STEP IN JOB

STEP IN PROC

PROC EXECUTED-BY STEP

CSECT IS PROGRAM

PROGRAM LINKED-BY PROGRAM

PROGRAM HAS ENTRY

ENTRY CALLED-BY PROGRAM

PROGRAM EXECUTED-BY CICSTRANSACTION
CURSOR CURSOR IN DATABASE

DATABASE IN STOGROUP

CURSOR IN PROGRAM
DATABASE DATABASE IN PROGRAM

DATABASE IN STOGROUP

DATABASE HAS CURSOR

CURSOR IN PROGRAM

DATABASE HAS TABLESPACE
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Starting Entity Kind Entity Relationships

TABLESPACE IN PROGRAM

TABLESPACE HAS VIEW

VIEW IN PROGRAM

VIEW HAS COLUMN

TABLESPACE HAS TABLE

TABLE IN PROGRAM

TABLE HAS COLUMN

COLUMN IN PROGRAM
DATAITEM DATAITEM DEFINED-IN PROGRAM

DATAITEM DEFINED-IN COPYMEMBER

COPYMEMBER USES COPYMEMBER

COPYMEMBER IN PROGRAM

DATAITEM IN RECORD

RECORD REFERENCED-BY  MAP

MAP IN MAPSET

MAP HAS MAPFIELD

RECORD USEDBY FD

FD SELECTS DD

DD HAS DSN

DSN HAS MEMBER

DD IN DBD

DD IN FCT

DD IN CSD

DD IN STEP

STEP IN JOB
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Starting Entity Kind Entity Relationships

STEP IN PROC
SEGMENT USEDBY PROGRAM
SEGMENT IN DBD
DBD HAS DD
SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT HAS SEGFIELD
SENSEG IN PCB
SENSEG HAS SENFIELD
SENSEG IN SENSEG
SENSEG USES SENSEG
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
IDMSRECORD IN IDMSMAP
IDSMRECORD IN LOGICAL
RECORD
LOGICAL IN PROGRAM
RECORD
IDMSRECORD IN PROGRAM
COLUMN IN TABLE
TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
COLUMN IN VIEW
VIEW IN TABLESPACE
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Starting Entity Kind Entity Relationships

DBD DBD HAS DD
DD HAS DSN
DSN HAS MEMBER
DD IN STEP
STEP IN JOB
STEP IN PROC
PROC EXECUTED-BY STEP
DBD HAS SEGMENT
SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT USEDBY PROGRAM
DBD IN PCB
PCB HAS SENSEG
SENSEG USES SENSEG
SENSEG IN SENSEG
SENSEG HAS SENFIELD
PCB IN PSB
PSB USEDBY PROGRAM
DBD IN MEMBER
MEMBER IN LIBRARY
DD DD SELECTED-BY FD
FD IN PROGRAM
FD USES RECORD
RECORD HAS DATAITEM
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DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
DD USEDBY PROGRAM
DD IN DBD
DD IN FCT
DD IN CSD
DD HAS DSN
DSN HAS MEMBER
DD IN STEP
STEP IN JOB
STEP IN PROC
PROC EXECUTED-BY STEP

DSN DSN HAS MEMBER
DSN IN DD
DD USEDBY PROGRAM
DD IN DBD
DBD HAS SEGMENT
SEGMENT USEDBY PROGRAM
DD IN FCT
DD IN CSD
DD SELECTED-BY FD
FD IN PROGRAM
FD USES RECORD
RECORD HAS DATAITEM
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Starting Entity Kind Entity Relationships

DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
DD IN STEP
STEP IN JOB
STEP IN PROC
PROC EXECUTED-BY STEP

ENTRY ENTRY IN PROGRAM
PROGRAM EXECUTED-BY CICSTRANSACTION
PROGRAM HAS ENTRY
ENTRY CALLED-BY PROGRAM
PROGRAM USES DD
PROGRAM HAS FD
FD SELECTS DD
DD IN STEP
DD IN CSD
DD IN FCT
DD HAS DSN
DSN HAS MEMBER
PROGRAM HAS AREA
PROGRAM HAS LOGICAL

RECORD

PROGRAM HAS IDMSMAP
PROGRAM HAS IDMSRECORD
PROGRAM HAS SCHEMA
PROGRAM HAS SUBSCHEMA
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PROGRAM

RECORD

RECORD

PROGRAM

PROGRAM

PROGRAM

PROGRAM

PROGRAM

PROGRAM

PROGRAM

PROGRAM

MEMBER

PROGRAM

COPYMEMBER

PROGRAM

CSECT

LOADMODULE

STEP

STEP

PROC

LOADMODULE

PROGRAM

PROGRAM

MAP

PROGRAM

HAS

HAS

REFERENCED-BY

HAS

HAS

HAS

HAS

HAS

HAS

HAS

IN

IN

INCLUDES

USES

IS

IN

EXECUTED-BY

IN

IN

EXECUTED-BY

EXECUTED-BY

LINKED-BY

USES

IN

USES

RECORD

DATAITEM

MAP

COLUMN

CURSOR

DATABASE

STOGROUP

TABLE

TABLESPACE

VIEW

MEMBER

LIBRARY

COPYMEMBER

COPYMEMBER

CSECT

LOADMODULE

STEP

JOB

PROC

STEP

IMSTRANSAC
TION

PROGRAM

MAP

MAPSET

MAPSET
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Starting Entity Kind Entity Relationships

PROGRAM USES PSB
PROGRAM USES SEGMENT
SEGMENT IN DBD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT HAS SEGFIELD
SENSEG IN SENSEG
SENSEG USES SENSEG
SENSEG HAS SENFIELD
SENSEG IN PCB

FCT FCT IN MEMBER
MEMBER IN LIBRARY
FCT HAS DD
DD USEDBY PROGRAM
DD SELECTED-BY FD
FD IN PROGRAM
FD USES RECORD
RECORD HAS DATAITEM
DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
DD USEDBY PROGRAM
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
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IDMSRECORD IN IDMSMAP

IDMSRECORD IN LOGICAL
RECORD

LOGICAL IN PROGRAM

RECORD

IDMSRECORD IN PROGRAM

COLUMN IN PROGRAM

TABLE IN PROGRAM

COLUMN IN TABLE

TABLE IN TABLESPACE

TABLESPACE IN DATABASE

DATABASE IN STOGROUP

COLUMN IN VIEW

VIEW IN TABLESPACE

DATAITEM DEFINED-IN PROGRAM

DATAITEM DEFINED-IN COPYMEMBER

COPYMEMBER USES COPYMEMBER

COPYMEMBER IN PROGRAM

DATAITEM IN RECORD

RECORD REFERENCED-BY  MAP

MAP IN MAPSET

MAP HAS MAPFIELD

RECORD USEDBY FD

FD SELECTS DD

DD HAS DSN

DSN HAS MEMBER

DD IN DBD
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Starting Entity Kind Entity Relationships

DD IN FCT

DD IN CSD

SEGMENT HAS SEGFIELD

SEGMENT IN SEGMENT

SEGMENT USES SEGMENT

SEGMENT USEDBY PROGRAM

SEGMENT IN DBD

SENSEG USES SENSEG

SENSEG IN SENSEG

SENSEG HAS SENFIELD

SENSEG IN PCB

PCB REFERENCES DBD

PCB IN PSB

PSB USEDBY PROGRAM
FCTCSD FCTCSC HAS DD

FCT HAS DD

CSD HAS DD

DD USEDBY PROGRAM

DD SELECTED-BY FD

FD IN PROGRAM

FD USES RECORD

RECORD HAS DATAITEM

DATAITEM DEFINED-IN COPYMEMBER

COPYMEMBER USES COPYMEMBER

COPYMEMBER IN PROGRAM
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IDMSRECORD IN AREA

AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
IDMSRECORD IN IDMSMAP
IDMSRECORD IN LOGICALRECORD
LOGICAL IN PROGRAM
RECORD

IDMSRECORD IN PROGRAM
TABLE IN PROGRAM
COLUMN IN TABLE

TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
COLUMN IN VIEW

VIEW IN TABLESPACE
DATAITEM DEFINED-IN PROGRAM
DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
DATAITEM IN RECORD
RECORD REFERENCED-BY  MAP

MAP IN MAPSET

MAP HAS MAPFIELD
RECORD USEDBY FD

FD SELECTS DD

DD HAS DSN
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Starting Entity Kind Entity Relationships

DSN HAS MEMBER

DD IN DBD

DD IN FCT

DD IN CSD

SEGMENT HAS SEGFIELD

SEGMENT IN SEGMENT

SEGMENT USES SEGMENT

SEGMENT USEDBY PROGRAM

SEGMENT IN DBD

SENSEG USES SENSEG

SENSEG IN SENSEG

SENSEG HAS SENFIELD

SENSEG IN PCB

PCB REFERENCES DBD

PCB IN PSB

PSB USEDBY PROGRAM
FD FD SELECTS DD

DD IN DBD

DD IN FCT

DD IN CSD

DD IN STEP

STEP IN JOB

STEP IN PROC

DD HAS DSN

DSN HAS MEMBER
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Starting Entity Kind Entity Relationships

FD IN PROGRAM
FD USES RECORD
RECORD REFERENCED-BY  MAP
MAP IN MAPSET
MAP HAS MAPFIELD
RECORD HAS DATAITEM
DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
FORMAT FORMAT EXECUTED-BY FORMAT
FORMAT EXECUTED-BY PROGRAM
PROGRAM EXECUTED-BY CICSTRANSACTION
PROGRAM HAS ENTRY
ENTRY CALLED-BY PROGRAM
PROGRAM IS CSECT
CSECT IN LOADMODULE
LOADMODULE EXECUTED-BY IMSTRANSACTION
IMSTRANSACTION EXECUTED-BY PROGRAM
IMSTRANSACTION EXECUTED-BY FORMAT
PROGRAM LINKED-BY PROGRAM
IDMS IDMSMAP HAS IDMSRECORD
MAP REFERENCES RECORD
RECORD HAS DATAITEM
IDMS IN PROGRAM
IDMSMAP IN PROGRAM
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Starting Entity Kind Entity Relationships

IDMSRECORD IN PROGRAM

LOGICAL IN PROGRAM

RECORD

AREA IN PROGRAM

SCHEMA IN PROGRAM

SUBSCHEMA IN PROGRAM

IDMSRECORD IN LOGICAL
RECORD

IDMSRECORD IN AREA

AREA IN SUBSCHEMA

SUBSCHEMA IN SCHEMA

DATAITEM DEFINED-IN PROGRAM

DATAITEM IN RECORD

RECORD REFERENCED-BY  MAP

MAP IN MAPSET

MAP HAS MAPFIELD

RECORD USEDBY FD

FD SELECTS DD

DD HAS DSN

DSN HAS MEMBER

DD IN DBD

DD IN FCT

DD IN CSD

DATAITEM DEFINED-IN COPYMEMBER

COPYMEMBER USES COPYMEMBER

COPYMEMBER IN PROGRAM

SEGMENT USEDBY PROGRAM

149



ASG-Alliance User’s Guide

Starting Entity Kind Entity Relationships

150

SEGMENT IN DBD
SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT HAS SEGFIELD
SENSEG IN PCB
SENSEG HAS SENFIELD
SENSEG IN SENSEG
SENSEG USES SENSEG
COLUMN IN TABLE
TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
COLUMN IN VIEW
VIEW IN TABLESPACE
IDMS MAP IDMSMAP IN PROGRAM
IDMSMAP HAS IDMSRECORD
IDMSRECORD IN LOGICAL
RECORD
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
COLUMN IN PROGRAM
TABLE IN PROGRAM
COLUMN IN TABLE
TABLE IN TABLESPACE
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Starting Entity Kind Entity Relationships

TABLESPACE IN DATABASE
DATABASE IN STOGROUP
COLUMN IN VIEW

VIEW IN TABLESPACE
DATAITEM DEFINED-IN PROGRAM
DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
DATAITEM IN RECORD
RECORD REFERENCED-BY  MAP

MAP IN MAPSET

MAP HAS MAPFIELD
RECORD USEDBY FD

FD SELECTS DD

DD HAS DSN

DSN HAS MEMBER

DD IN DBD

DD IN FCT

DD IN CSD
SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT USEDBY PROGRAM
SEGMENT IN DBD

SENSEG USES SENSEG
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Starting Entity Kind Entity Relationships

SENSEG IN SENSEG
SENSEG HAS SENFIELD
SENSEG IN PCB
PCB REFERENCES DBD
PCB IN PSB
PSB USEDBY PROGRAM
IDMS RECORD IDMSRECORD IN PROGRAM
IDMSRECORD IN IDMSMAP
IDMSMAP IN PROGRAM
IDMSRECORD IN LOGICAL
RECORD
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
COLUMN IN PROGRAM
TABLE IN PROGRAM
COLUMN IN TABLE
TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
COLUMN IN VIEW
VIEW IN TABLESPACE
DATAITEM DEFINED-IN PROGRAM
DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
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Starting Entity Kind Entity Relationships

DATAITEM IN RECORD

RECORD REFERENCED-BY  MAP

MAP IN MAPSET

MAP HAS MAPFIELD

RECORD USEDBY FD

FD SELECTS DD

DD HAS DSN

DSN HAS MEMBER

DD IN DBD

DD IN FCT

DD IN CSD

SEGMENT HAS SEGFIELD

SEGMENT IN SEGMENT

SEGMENT USES SEGMENT

SEGMENT USEDBY PROGRAM

SEGMENT IN DBD

SENSEG USES SENSEG

SENSEG IN SENSEG

SENSEG HAS SENFIELD

SENSEG IN PCB

PCB REFERENCES DBD

PCB IN PSB

PSB USEDBY PROGRAM
IMS DYNALLOCMACRO IMS DYNALLOCMACRO IN MEMBER

MEMBER IN LIBRARY
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IMS TRANSACTION IMSTRANSACTION EXECUTED-BY PROGRAM
PROGRAM EXECUTED-BY CICSTRANSACTION
PROGRAM HAS ENTRY
ENTRY CALLED-BY PROGRAM
PROGRAM IS CSECT
CSECT IN LOADMODULE
LOADMODULE EXECUTED-BY STEP
STEP IN JOB
STEP IN PROC
PROC EXECUTED-BY STEP
LOADMODULE EXECUTED-BY IMSTRANSACTION
PROGRAM LINKED-BY PROGRAM
IMSTRANSACTION EXECUTED-BY FORMAT
FORMAT EXECUTED-BY FORMAT
FORMAT EXECUTED-BY PROGRAM
IMSTRANSACTION EXECUTES LOADMODULE
LOADMODULE HAS CSECT
CSECT IS PROGRAM

JCL PROC PROC EXECUTED-BY STEP
STEP IN JOB
JOB USES LIBRARY
JOB USES CATALOG
PROC HAS STEP
STEP USES CATALOG
STEP USES LIBRARY
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Starting Entity Kind Entity Relationships

STEP HAS DD

DD IN DBD

DD IN FCT

DD IN CSD

DD HAS DSN

DSN HAS MEMBER

STEP EXECUTES LOADMODULE

LOADMODULE HAS CSECT

CSECT IS PROGRAM

PROC IN MEMBER

MEMBER IN LIBRARY
JOB JOB HAS STEP

STEP USES LIBRARY

STEP USES CATALOG

STEP HAS DD

DD IN DBD

DD IN FCT

DD IN CSD

DD HAS DSN

DSN HAS MEMBER

STEP EXECUTES LOADMODULE

LOADMODULE HAS CSECT

CSECT IS PROGRAM

STEP EXECUTES PROC

JOB USES LIBRARY
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JOB USES CATALOG

JOB IN MEMBER

MEMBER IN LIBRARY
LIBRARY LIBRARY USEDBY STEP

STEP IN JOB

STEP IN PROC

PROC EXECUTED-BY STEP

LIBRARY USEDBY JOB

LIBRARY HAS MEMBER

MEMBER HAS LOADMODULE

MEMBER HAS PROGRAM

MEMBER HAS JOB

MEMBER HAS PROC

MEMBER HAS PSB

MEMBER HAS DBD

MEMBER HAS PCT

MEMBER HAS PPT

MEMBER HAS FCT

MEMBER HAS MAPSET

MEMBER HAS IMSDYNALLOCMACRO

MEMBER HAS FORMAT

MEMBER HAS COPYMEMBER
LOADMODULE LOADMODULE HAS CSECT

CSECT IS PROGRAM

PROGRAM EXECUTED-BY CICSTRANSACTION
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Starting Entity Kind Entity Relationships

PROGRAM LINKED-BY PROGRAM
PROGRAM HAS ENTRY
ENTRY CALLED-BY PROGRAM
LOADMODULE EXECUTED-BY IMSTRANSACTION
LOADMODULE EXECUTED-BY STEP
STEP IN JOB
STEP IN PROC
PROC EXECUTED-BY STEP
LOADMODULE IN MEMBER
MEMBER IN LIBRARY
LOGICAL RECORD LOGICALRECORD IN PROGRAM
LOGICALRECORD HAS IDMSRECORD
IDMSRECORD IN PROGRAM
IDMSRECORD IN IDMSMAP
IDMSMAP IN PROGRAM
IDMSRECORD IN LOGICALRECORD
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
COLUMN IN PROGRAM
TABLE IN PROGRAM
COLUMN IN TABLE
TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
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COLUMN IN VIEW

VIEW IN TABLESPACE
DATAITEM DEFINED-IN PROGRAM
DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
DATAITEM IN RECORD
RECORD REFERENCED-BY  MAP

MAP IN MAPSET

MAP HAS MAPFIELD
RECORD USEDBY FD

FD SELECTS DD

DD HAS DSN

DSN HAS MEMBER

DD IN DBD

DD IN FCT

DD IN CSD
SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT USEDBY PROGRAM
SEGMENT IN DBD

SENSEG USES SENSEG
SENSEG IN SENSEG
SENSEG HAS SENFIELD
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Starting Entity Kind Entity Relationships

SENSEG IN PCB
PCB REFERENCES DBD
PCB IN PSB
PSB USEDBY PROGRAM
MAP (CICS) MAP HAS MAPFIELD
MAP IN MAPSET
MAPSET USEDBY PROGRAM
MAP REFERENCES RECORD
RECORD HAS DATAITEM
DATAITEM DEFINED-IN PROGRAM
MAP USEDBY PROGRAM
IDMSMAP HAS IDMSRECORD
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
IDMSRECORD IN LOGICALRECORD
IDMSMAP IN PROGRAM
MAPFIELD (CICS) MAPFIELD IN MAP
MAP IN MAPSET
MAPSET USEDBY PROGRAM
MAP REFERENCES RECORD
RECORD HAS DATAITEM
DATAITEM DEFINED-IN PROGRAM
MAP USEDBY PROGRAM
IDMSMAP HAS IDMSRECORD
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IDMSRECORD IN AREA

AREA IN SUBSCHEMA

SUBSCHEMA IN SCHEMA

IDMSRECORD IN LOGICAL RECORD

IDMSMAP IN PROGRAM
MAPSET MAPSET USEDBY PROGRAM

MAPSET HAS MAP

MAP HAS MAPFIELD

MAP IN MAPSET

MAP REFERENCES RECORD

RECORD HAS DATAITEM

DATAITEM DEFINED-IN PROGRAM

MAP USEDBY PROGRAM
MEMBER MEMBER HAS DBD

MEMBER HAS FCT

MEMBER HAS FORMAT

MEMBER HAS JOB

MEMBER HAS LOADMODULE

MEMBER HAS MAPSET

MEMBER HAS IMSDYNALLOCMACRO

MEMBER HAS PCT

MEMBER HAS PROGRAM

MEMBER HAS PPT

MEMBER HAS PROC

MEMBER HAS PSB
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Starting Entity Kind Entity Relationships

MEMBER HAS COPYMEMBER
COPYMEMBER IN PROGRAM
COPYMEMBER USEDBY COPYMEMBER
COPYMEMBER HAS DATAITEM
DATAITEM IN RECORD
MEMBER IN LIBRARY
MEMBER IN DSN

PCB PCB REFERENCES DBD
PCB IN PSB
PSB USEDBY PROGRAM
PCB HAS SENSEG
SENSEG USES SENSEG
SENSEG IN SENSEG
SENSEG USES SENSEG
SENSEG HAS SENFIELD
SEGMENT HAS SENFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT USEDBY PROGRAM
SEGMENT IN DBD

PCT PCT IN MEMBER
MEMBER IN LIBRARY
PCT HAS CICSTRANSACTION
CICSTRANSACTION EXECUTES PROGRAM
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PPT PPT IN MEMBER
MEMBER IN LIBRARY

PROGRAM PROGRAM EXECUTED-BY CICSTRANSACTION
PROGRAM HAS ENTRY
ENTRY CALLED-BY PROGRAM
PROGRAM USES DD
PROGRAM HAS FD
FD SELECTS DD
DD IN STEP
DD IN CSD
DD IN FCT
DD HAS DSN
DSN HAS MEMBER
PROGRAM HAS AREA
PROGRAM HAS LOGICALRECORD
PROGRAM HAS ISMSMAP
PROGRAM HAS IDMSRECORD
PROGRAM HAS SCHEMA
PROGRAM HAS SUBSCHEMA
PROGRAM HAS RECORD
RECORD HAS DATAITEM
RECORD REFERENCED-BY  MAP
PROGRAM HAS COLUMN
PROGRAM HAS CURSOR
PROGRAM HAS DATABASE



PROGRAM

PROGRAM

PROGRAM

PROGRAM

MEMBER

PROGRAM

COPYMEMBER

PROGRAM

CSECT

LOADMODULE

STEP

STEP

PROC

LOADMODULE

PROGRAM

PROGRAM

MAP

PROGRAM

PROGRAM

PROGRAM

SEGMENT

SEGMENT

SEGMENT

SEGMENT

SENSEG

HAS

HAS

HAS

HAS

IN

INCLUDES

USES

IS

IN

EXECUTED-BY

IN

IN

EXECUTED-BY

EXECUTED-BY

LINKED-BY

USES

IN

USES

USES

USES

IN

IN

USES

HAS

STOGROUP

TABLE

TABLESPACE

VIEW

LIBRARY

COPYMEMBER

COPYMEMBER

CSECT

LOADMODULE

STEP

JOB

PROC

STEP
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IMSTRANSACTION

PROGRAM

MAP

MAPSET

MAPSET

PSB

SEGMENT

DBD

SEGMENT

SEGMENT

SEGFIELD

SENSEG
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SENSEG USES SENSEG
SENSEG HAS SEGFIELD
SENSEG IN PCB

PSB PSB USEDBY PROGRAM
PSB HAS PCB
PCB REFERENCES DBD
PCB HAS SENSEG
SENSEG IN SENSEG
SENSEG USES SENSEG
SENSEG HAS SEGFIELD
SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT USEDBY PROGRAM
SEGMENT IN DBD
PSB IN MEMBER
MEMBER IN LIBRARY

RECORD RECORD HAS DATAITEM
DATAITEM DEFINED-IN PROGRAM
DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
RECORD REFERENCED-BY  MAP
MAP IN MAPSET
MAP HAS MAPFIELD
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RECORD USEDBY FD

FD SELECTS DD

DD IN DBD

DD IN FCT

DD IN CSD

DD HAS DSN

DSN HAS MEMBER
SEGMENT USEDBY PROGRAM
SEGMENT IN DBD
SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT HAS SEGFIELD
SENSEG IN PCB
SENSEG HAS SENFIELD
SENSEG IN SENSEG
SENSEG USES SENSEG
IDMSRECORD IN PROGRAM
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
IDMSRECORD IN IDMSMAP
IDMSRECORD IN LOGICALRECORD
LOGICALRECORD IN PROGRAM
COLUMN IN PROGRAM
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TABLE IN PROGRAM
COLUMN IN TABLE
TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
COLUMN IN VIEW
VIEW IN TABLESPACE
SCHEMA SCHEMA IN PROGRAM
SCHEMA HAS SUBSCHEMA
SUBSCHEMA IN PROGRAM
SUBSCHEMA HAS LOGICALRECORD
LOGICALRECORD IN PROGRAM
LOGICALRECORD HAS IDMSRECORD
SUBSCHEMA HAS AREA
AREA IN PROGRAM
AREA HAS IDMSRECORD
IDMSRECORD IN PROGRAM
IDMSRECORD IN IDMSMPA
IDMSMAP IN PROGRAM
SEGMENT SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT USEDBY PROGRAM
SEGMENT IN DBD
DBD HAS DD
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SENSEG

SENSEG

SENSEG

SENSEG

PCB

PCB

PSB

IDMSRECORD

AREA

SUBSCHEMA

IDMSRECORD

IDMSRECORD

LOGICALRECORD

IDMSRECORD

COLUMN

TABLE

COLUMN

TABLE

TABLESPACE

DATABASE

COLUMN

VIEW

DATAITEM

DATAITEM

COPYMEMBER
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USES

IN

HAS

IN

REFERENCES

IN

USEDBY

IN

IN

IN

IN

IN

IN

IN

IN

IN

DEFINED-IN

DEFINED-IN

USES

Starting Entity Kind Entity Relationships

SENSEG

SENSEG

SENFIELD

PCB

DBD

PSB

PROGRAM

AREA

SUBSCHEMA

SCHEMA

IDMSMAP

LOGICALRECORD

PROGRAM

PROGRAM

PROGRAM

PROGRAM

TABLE

TABLESPACE

DATABASE

STOGROUP

VIEW

TABLESPACE

PROGRAM

COPYMEMBER

COPYMEMBER
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COPYMEMBER IN PROGRAM

DATAITEM IN RECORD

RECORD REFERENCED-BY  MAP

MAP IN MAPSET

MAP HAS MAPFIELD

RECORD USEDBY FD

FD SELECTS DD

DD HAS DSN

DSN HAS MEMBER

DD IN DBD

DD IN FCT
SEGFIELD DD IN CSD

SEGFIELD IN SEGMENT

SENSEG USES SENSEG

SENSEG IN SENSEG

SENSEG IN PCB

PCB REFERENCES DBD

PCB IN PSB

PSB USEDBY PROGRAM

SEGMENT IN SEGMENT

SEGMENT USEDBY PROGRAM

SEGMENT IN DBD

IDMSRECORD IN AREA

AREA IN SUBSCHEMA

SUBSCHEMA IN SCHEMA
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IDMSRECORD

IDMSRECORD

LOGICALRECORD

IDMSRECORD

COLUMN

TABLE

COLUMN

TABLE

TABLESPACE

DATABASE

COLUMN

VIEW

DATAITEM

DATAITEM

COPYMEMBER

COPYMEMBER

DATAITEM

RECORD

MAP

MAP

RECORD

FD

DD

DSN

DD

IN

IN

IN

IN

IN

IN

IN

IN

IN

DEFINED-IN

DEFINED-IN

USES

IN

IN

REFERENCED-BY

IN

HAS

USEDBY

SELECTS

HAS

HAS

IN
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IDMSMAP

LOGICALRECORD

PROGRAM

PROGRAM

PROGRAM

PROGRAM

TABLE

TABLESPACE

DATABASE

STOGROUP

VIEW

TABLESPACE

PROGRAM

COPYMEMBER

COPYMEMBER

PROGRAM

RECORD

MAP

MAPSET

MAPFIELD

FD

DD

DSN

MEMBER

DBD
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DD IN FCT
DD IN CSD
SENFIELD SENFIELD IN SENSEG
SENFIELD USES SENSEG
SENSEG IN SENSEG
SENSEG IN PCB
PCB REFERENCES DBD
PCB IN PSB
PSB USEDBY PROGRAM
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT USEDBY PROGRAM
SEGMENT IN DBD
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
IDMSRECORD IN IDMSMAP
IDMSRECORD IN LOGICALRECORD
LOGICALRECORD IN PROGRAM
IDMSRECORD IN PROGRAM
COLUMN IN PROGRAM
TABLE IN PROGRAM
COLUMN IN TABLE
TABLE IN TABLESPACE
TABLESPACE IN DATABASE
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DATABASE IN STOGROUP
COLUMN IN VIEW
VIEW IN TABLESPACE
DATAITEM DEFINED-IN PROGRAM
DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
DATAITEM IN RECORD
RECORD REFERENCED-BY  MAP
MAP IN MAPSET
MAP HAS MAPFIELD
RECORD USEDBY FD
FD SELECTS DD
DD HAS DSN
DSN HAS MEMBER
DD IN DBD
DD IN FCT
DD IN CSD

SENSEG SENSEG USES SENSEG
SENSEG IN SENSEG
SENSEG HAS SENFIELD
SENSEG IN PCB
PCB REFERENCES DBD
PCB IN PSB

PSB USEDBY PROGRAM
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SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT USEDBY PROGRAM
SEGMENT IN DBD
IDMSRECORD IN AREA

AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
IDMSRECORD IN IDMSMAP
IDMSRECORD IN LOGICALRECORD
LOGICALRECORD IN PROGRAM
IDMSRECORD IN PROGRAM
COLUMN IN PROGRAM
TABLE IN PROGRAM
COLUMN IN TABLE

TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
COLUMN IN VIEW

VIEW IN TABLESPACE
DATAITEM DEFINED-IN PROGRAM
DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
DATAITEM IN RECORD
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RECORD REFERENCED-BY ~ MAP
MAP IN MAPSET
MAP HAS MAPFIELD
RECORD USEDBY FD
FD SELECTS DD
DD HAS DSN
DSN HAS MEMBER
DD IN DBD
DD IN FCT
DD IN CSD

SQL COLUMN IN TABLE
TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
COLUMN IN VIEW
VIEW IN TABLESPACE
SQL IN PROGRAM
COLUMN IN PROGRAM
TABLE IN PROGRAM
VIEW IN PROGRAM
TABLESPACE IN PROGRAM
DATABASE IN PROGRAM
DATAITEM DEFINED-IN PROGRAM
DATAITEM IN RECORD
RECORD REFERENCED-BY ~ MAP
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MAP

MAP

RECORD

FD

DD

DSN

DD

DD

DD

DATAITEM

COPYMEMBER

COPYMEMBER

SEGMENT

SEGMENT

SEGMENT

SEGMENT

SEGMENT

SEGMENT

SENSEG

SENSEG

SENSEG

SENSEG

IDMSRECORD

AREA

SUBSCHEMA

IN

HAS

USEDBY

SELECTS

HAS

HAS

IN

IN

IN

DEFINED-IN

USES

IN

USEDBY

IN

HAS

IN

USES

HAS

HAS

IN

USES

MAPSET

MAPFIELD

FD

DD

DSN

MEMBER

DBD

FCT

CSD

COPYMEMBER

COPYMEMBER

PROGRAM

PROGRAM

DBD

SEGFIELD

SEGMENT

SEGMENT

SEGFIELD

PCB

SENFIELD

SENSEG

SENSEG

AREA

SUBSCHEMA

SCHEMA



Appendix B - Impact Analysis Entity Relationships

Starting Entity Kind Entity Relationships

IDMSRECORD IN IDMSMAP

IDMSRECORD IN LOGICALRECORD

LOGICALRECORD IN PROGRAM

IDMSRECORD IN PROGRAM
STEP STEP IN JOB

STEP IN PROC

STEP EXECUTES PROC

STEP USES LIBRARY

STEP USES CATALOG

STEP HAS DD

DD IN DBD

DD IN FCT

DD IN CSD

DD HAS DSN

DSN HAS MEMBER

STEP EXECUTES LOADMODULE

LOADMODULE HAS CSECT

CSECT IS PROGRAM
STOGROUP STOGROUP IN PROGRAM

STOGROUP HAS DATABASE

DATABASE IN PROGRAM

DATABASE HAS CURSOR

CURSOR IN PROGRAM

DATABASE HAS TABLESPACE

TABLESPACE IN PROGRAM
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Starting Entity Kind Entity Relationships

TABLESPACE HAS VIEW
VIEW IN PROGRAM
VIEW HAS COLUMN
TABLESPACE HAS TABLE
TABLE IN PROGRAM
TABLE HAS COLUMN
COLUMN IN PROGRAM
SUBSCHEMA SUBSCHEMA IN PROGRAM
SUBSCHEMA IN SCHEMA
SUBSCHEMA HAS LOGICALRECORD
LOGICALRECORD IN PROGRAM
LOGICALRECORD HAS IDMSRECORD
SUBSCHEMA HAS AREA
AREA IN PROGRAM
AREA HAS IDMSRECORD
IDMSRECORD IN PROGRAM
IDMSRECORD IN IDMSMAP
IDMSMAP IN PROGRAM
TABLE TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
TABLE IN PROGRAM
TABLE HAS COLUMN
COLUMN IN PROGRAM
IDMSRECORD IN AREA
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Starting Entity Kind Entity Relationships

AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
IDMSRECORD IN IDMSMAP
IDMSRECORD IN LOGICALRECORD
LOGICALRECORD IN PROGRAM
IDMSRECORD IN PROGRAM
DATAITEM IN RECORD
RECORD REFERENCED-BY  MAP

MAP IN MAPSET
MAP HAS MAPFIELD
RECORD USEDBY FD

FD SELECTS DD

DD HAS DSN

DSN HAS MEMBER
DD IN DBD

DD IN FCTY

DD IN CSD
SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT USEDBY PROGRAM
SEGMENT IN DBD
SENSEG USES SENSEG
SENSEG IN SENSEG
SENSEG HAS SENFIELD
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Starting Entity Kind Entity Relationships

SENSEG IN PCB
PCB REFERENCES DBD
PCB IN PSB
PSB USEDBY PROGRAM
TABLESPACE TABLESPACE IN DATABASE
DATABASE IN STOGROUP
TABLESPACE IN PROGRAM
TABLESPACE HAS VIEW
VIEW IN PROGRAM
VIEW HAS COLUMN
TABLESPACE HAS TABLE
TABLE IN PROGRAM
TABLE HAS COLUMN
COLUMN IN PROGRAM
EW VIEW IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
VIEW IN PROGRAM
VIEW HAS COLUMN
COLUMN IN PROGRAM
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
IDMSRECORD IN IDMSMAP
IDMSRECORD IN LOGICALRECORD
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Starting Entity Kind Entity Relationships

LOGICALRECORD IN PROGRAM
IDMSRECORD IN PROGRAM
DATAITEM IN RECORD
RECORD REFERENCED-BY  MAP

MAP IN MAPSET
MAP HAS MAPFIELD
RECORD USEDBY FD

FD SELECTS DD

DD HAS DSN

DSN HAS MEMBER
DD IN DBD

DD IN FCT

DD IN CSD
SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT USEDBY PROGRAM
SEGMENT IN DBD
SENSEG USES SENSEG
SENSEG IN SENSEG
SENSEG HAS SENFIELD
SENSEG IN PCB

PCB REFERENCES DBD

PCB IN PSB

PSB USEDBY PROGRAM

179



ASG-Alliance User’s Guide

180



Appendix C
Managing the AKR

The ESW family of components provides AKR management tools through online
utilities. For more information on online utilities, see the ASG-Application Definition and
Analysis User’s Guide.

Allocating the AKR

An AKR is a BDAM or VSAM file. The AKR is the repository for all of the information
used by the ESW family of components.

You can create a new AKR, or expand an existing one. Each AKR can contain multiple
applications and you can allocate multiple AKRs for a single change, as necessary. You
may want to allocate one AKR for each major business unit in your company (for
example, manufacturing, accounting, sales). The size of the AKR depends on the number
and size of the application definitions it contains.

Allocating the AKR with ISPF

You can allocate an AKR with or without using ISPF. For step-by-step instructions on

allocating the AKR without using ISPF, see "Allocating and Expanding AKRs without
ISPF" on page 184.
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To use ISPF to allocate an AKR

1 Choose File » AKR utility from Alliance Primary screen and press Enter. The
ESW - AKR Utility pop-up (see Figure 68) displays.

Figure 68 « ESW - AKR Utility Pop-up

E:ZM — AKR Utility
ConHand ===

Elank - Di=splay Hedber list O - Delete Hednber
] = Hllocate~<eHdpand AKR R - Renane Hedbetr

Application Knowledge Repository [AKR]:

Data =et name . . 'UIAUERLGEMERAL.AKR’

HeWbar o o & & & o __ [if "R" or "0 selected)
Mew maWe o . . o __________ [if "R" selected)
Volure =erial . . ______ [if not cataloged]
Password . . . . [if password protected]

2 In the Dataset name field, type the name of the AKR to be allocated. If the high-level
qualifier is different than your TSO prefix or user ID, enter the name in single quotes.
The last node of the name should be AKR.

3  Type A on the command line to specify the allocate function and press Enter.

4  Ifthe AKR will not be cataloged, in the Volume serial field, type the serial number
of the volume where the AKR will reside.

5  To password-protect the AKR, type the password in the Password field.

6  Press Enter to open the File - AKR Allocate/Expand pop-up.
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The pop-up that displays depends on whether you use BDAM or VSAM AKRs and

whether SMS is turned on for your site. Figure 69 assumes a BDAM-VSAM
sequential AKR.

Figure 69  File - AKR Allocate/Expand Pop-up with a VSAM AKR

File - AKR AllocatesExpand

Command ===3%
% - Submit JCL E - Edit JCL C - Specify Cataleog
Expand existing AKR . . . MO {¥es or Mo
AKR data set name . . . . 'USER.TEST.AKR'
Yolume . . . . . . . .
Unit . . . . . . . .. (Generic unit name)
Space units . . . . . . RECORDS {Records, Tracks or Cylinders)
Primary space . . . . . 4QE0 ({Primary amount in above units)
Secondary space . . . . @ {Secondary amount in above units)

Job statement information:
£ ANAME
b MSGCLASS=A

fi* INSERT '/#ROUTE PRIWT NODE.USER’

£i*

JOB (ACCOUMT 3, NAHE,

HERE IF WEEDED.

Specify this information:

Expand existing AKR field

Specifies whether you want to expand an
existing AKR. Type No in this field.

Volume field Specifies the volume serial number for the
AKR. This field is required if Storage class is
not specified.

Unit field Specifies the generic unit name.

Space units field

Specifies the type of units to allocate. The units
must be records, tracks, or cylinders.

Primary space field

Specifies the amount of space required. For
information on the expected size of the AKR
and analyze work files, see the ASG-Application
Definition and Analysis User’s Guide.

Secondary space field

Specifies the amount of secondary space
required.

Job statement information field

Contains the job card and routing information.
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10

11

12

13

14

To specify a private catalog to contain the name of the AKR, type C on the Command
line and press Enter. The AKR Catalog Information pop-up displays.

Type the catalog dataset name and password.

To submit the AKR for allocation, type S in the command line and press Enter.
Or

To edit the JCL, type E in the command line and press Enter.

Modify the JCL, then type SUBMIT.

Type End on the command line.

Or

Press PF3 to return to the File - AKR Allocate/Expand pop-up.

Verify the allocation job by examining the job output. The allocation is successful
when the condition code 0 appears in the output.

After the AKR is successfully allocated, create the application. For step-by-step
instructions on creating and defining the application, see the ASG-Application Definition
and Analysis User’s Guide.

Allocating and Expanding AKRs without ISPF

The batch AKR utility can allocate and expand VSAM AKRs without using ISPF. ESW
provides you with the VIASAKRA JCL to allocate an AKR, and the VIASAKRX JCL to
expand an AKR. Figure 70 shows the VIASAKRA JCL. Figure 71 on page 186 shows
the VIASAKRX JCL.
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Figure 70 = VIASAKRA JCL for a VSAM AKR

)CM khkhkhkhkhkhkhkhkhkhkhkkhkkhhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhhhhhkkhkhkkkk*x%

00010000

)CM * ASG, INC. ASG-CENTER MM-YYYY * 00020003
)CM * * 00030000
)CM * SKELETON JCL FOR SUBMITTING A BATCH JOB TO ALLOCATE AND * 00040000
)CM * INITIALIZE A ASG APPLICATION KNOWLEDGE REPOSITORY (AKR) . * 00050003
Y O K % ok ok ok ok ok ko ok ook ok ok ok ko Kk K Kk o Kk o K K o Kk K Kk Kk K Kk Kk o K Kk Kk o K Kk K Kk
00060000

) CM 00070000
) CM 00080000
Y OM %ok ok %ok ok ok ok ok ok ko ok Kk ok K Kk ok Kk K KK Kk Kk 00090000
)CM * JOB STATEMENT INFORMATION * 00100000
Y CM %k ok %ok ok ok ok ok ok ko ok Kk ok K Kk ok Kk K KK Kk Kk 00110000
) CM 00120000
&VSV11JB1 00130000
&VSV11JB2 00140000
&VSV11JB3 00150000
&VSV11JB4 00160000
) CM 00170000



EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE S

* IN-STREAM JCL PROCEDURE *

) CM
) CM
Y OM ok ok ok ok ok ok ok ok ko o ok kK Kk ko kK Kk K Kk
) CM
) IM

VIASAKAP OPT

// PEND

//*

) CM

)CM khkhkhkhkhkkhkhkkhkhkhkhkhkkhkhkkhkhkhkhkhkhkhkkhkhkhhkhkhdxkhx*k
)CM * EXECUTE JCL STATEMENTS *

)CM EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE S

) CM
//VIASAKRA EXEC VIASAKAP
//*
) SEL &VSV32VAC = YES
//DEFAKR.SYSIN DD *
DEFINE CLUSTER -
(NAME (&VSVIDB) -
) SEL &VSV32SPU = CYLINDERS
CYLINDERS (&VSV32SPA) -
) ENDSEL
) SEL &VSV32SPU = RECORDS
RECORDS (&VSV32SPA) -
) ENDSEL
) SEL &VSV32SPU = TRACKS
TRACKS (&VSV32SPA) -
) ENDSEL
) SEL &VSV32DCL 2= &%
DATACLAS (&VSV32DCL) -
) ENDSEL
) SEL &VSV32MCL 2= &%
MGMTCLAS (&VSV32MCL) -
) ENDSEL
) SEL &VSV32VOL 2= &%
VOLUME (&VSV32VOL) -
) ENDSEL
) SEL &VSV32SCL 2= &%
STORCLAS (&VSV32SCL) -

) ENDSEL
CONTROLINTERVALSIZE (4096) -
NUMBERED -
RECORDSIZE (4089 4089) -
RECOVERY -

) SEL &VSV32UNQ 2= NO
UNIQUE -

) ENDSEL

SHAREOPTIONS (3 3)) -
) SEL &VSV32CAT %= &Z && &VSV32PSW = &Z
CATALOG (&VSV32CAT) -

Appendix C - Managing the AKR

00180000
00190000
00200000
00210000
00220000
00230000
00240000
00250000
00260000
00270000
00280000
00290000
00300000
00310000
00320000
00330000
00340000
00350000
00360000
00370000
00380000
00390000
00400000
00410000
00420000
00430000
00440000
00450000
00460000
00470000
00480000
00490000
00500000
00510000
00520000
00530000
00540000
00550000
00560000
00570000
00580000
00590000
00600000
00610000
00620000
00630000
00640000
00650000
00660000
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To allocate an AKR without ISPF

1

2

Figure 71 shows an example of an AKR VIASAKRX JCL.

Replace XX in the NAME (XX), NAME (XX.DATA), and the DSNAME (XX)

parameters with the name of the AKR to be allocated.

Replace XX (xX) with the allocation units values and quantities for your site.

Figure 71 « VIASAKRX JCL for a VSAM AKR

)CM LR R R R R S e e S S S S S S S S S S S S S S S S

00010000
)CM * ASG, INC. ASG-CENTER

*

) CM

)CM * SKELETON JCIL FOR SUBMITTING A BATCH JOB TO EXPAND A
)CM *  ASG APPLICATION KNOWLEDGE REPOSITORY (AKR).
) CM

*
*
*

*

00020003
00030000
00040000
00050003

LR R R R R R S S e e S S I S S S S S S S S S S S S S

CM R R R R Ik I b b b b R I b b b b h R R b I S S i 2 3

00060000

) CM

) CM

)CM hhkhkhkhkhkkhkhkkhkhkhkhkhkkhkhkkhkhkhkhkhkkhkhkhkhhkkhhkkhxkxxk
)CM * JOB STATEMENT INFORMATION *
)

)

CM

&VSV11JB1
&VSV11JB2
&VSV11JB3
&VSV11JB4

EEEEEEEEEEEEEEEEEEEEEEEEEEEE SRS S S

) CM
) CM
)CM * IN-STREAM JCL PROCEDURE *
) CM
) CM
) IM

R R R R Ik I I I b b e R I b b bk R b b I b b S i 2 3

VIASAKXP OPT

// PEND

//*

) CM

)CM khkhkhkhkhkkhkhkkhkhkhkhkhkkhkhkkhkhkhhkhkhkhkkhkhkhhkhhhhxkhx*k
)CM * EXECUTE JCL STATEMENTS *

)CM R R R R Ik I I I I b b b b I b b b b h R b b I b b b i 2 3

) CM
//VIASAKRX EXEC VIASAKXP
//*
) SEL &VSV32VAC = YES
//DEFAKR.SYSIN DD *
DEFINE CLUSTER -
(NAME (&VSVIDB. .EX) -
) SEL &VSV32SPU = CYLINDERS
CYLINDERS (&VSV32SPA) -
) ENDSEL
) SEL &VSV32SPU = RECORDS
RECORDS (&VSV32SPA) -
) ENDSEL
) SEL &VSV32SPU = TRACKS
TRACKS (&VSV32SPA) -
) ENDSEL
) SEL &VSV32DCL 2= &%
DATACLAS (&VSV32DCL) -
) ENDSEL

00070000
00080000
00090000
00100000
00110000
00120000
00130000
00140000
00150000
00160000
00170000
00180000
00190000
00200000
00210000
00220000
00230000
00240000
00250000
00260000
00270000
00280000
00290000
00300000
00310000
00320000
00330000
00340000
00350000
00360000
00370000
00380000
00390000
00400000
00410000
00420000
00430000
00440000
00450000
00460000
00470000
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) SEL &VSV32MCL 2= &Z
MGMTCLAS (&VSV32MCL) -
) ENDSEL
) SEL &VSV32VOL 2= &Z
VOLUME (&VSV32VOL) -
) ENDSEL
) SEL &VSV32SCL 2®= &Z
STORCLAS (&VSV32SCL) -

) ENDSEL
CONTROLINTERVALSIZE (4096) -
NUMBERED -
RECORDSIZE (4089 4089) -
RECOVERY -

) SEL &VSV32UNQ 2= NO
UNIQUE -

) ENDSEL

SHAREOPTIONS (3 3)) -
) SEL &VSV32CAT 2= §&Z && &VSV32PSW = &%
CATALOG (&VSV32CAT) -
) ENDSEL
) SEL &VSV32CAT 2= §&Z && &VSV32PSW 2= &2
CATALOG (&VSV32CAT/&VSV32PSW) -

) ENDSEL
DATA -
(NAME (&VSVIDB. .EX.DATA))
) ENDSEL
/1%

//INITAKR.STEPLIB DD DSN=VIASHxx.PROD.XALOAD,DISP=SHR ** IN-HOUSE**

//INITAKR.VIASYSIN DD *

INIT DSNAME (&VSVIDB. .EX)

//*

) SEL &VSV32CAT 2= &Z

//INITAKR.STEPCAT DD DSN=&VSV32CAT,

// DISP=SHR

) ENDSEL

//*

) SEL &VSV32EXD 2= MIX

//REPRO.SYSIN DD *

REPRO INDATASET (&VSVIDB) -
OUTDATASET (&VSVIDB. .EX) -
REPLACE

//*

) SEL &VSV32CAT 2= &Z

//REPRO.STEPCAT DD DSN=&VSV32CAT,

// DISP=SHR

) ENDSEL

//*

//RESIZE.STEPLIB DD DSN=VIASHxx.PROD.XALOAD,DISP=SHR ** IN-HOUSE **

//RESIZE.VIASYSIN DD *

RESIZE DSNAME (&VSVIDB. .EX)

//*

) SEL &VSV32CAT 2= &%

//RESIZE.STEPCAT DD DSN=&VSV32CAT,

// DISP=SHR

) ENDSEL

) ENDSEL

//*

) SEL &VSV32EXD = MIX

//COPY.VIASYSIN DD *

COPY * NOREPLACE
) ENDSEL
//RENAME.SYSIN DD *

00480000
00490000
00500000
00510000
00520000
00530000
00540000
00550000
00560000
00570000
00580000
00590000
00600000
00610000
00620000
00630000
00640000
00650000
00660000
00670000
00680000
00690000
00700000
00710000
00720000
00730000
00740000
00750002
00770000
00780000
00790000
00800000
00810000
00820000
00830000
00840000
00850000
00860000
00870000
00880000
00890000
00900000
00910000
00920000
00930000
00940000
00950000
00960002
00980000
00990000
01000000
01010000
01020000
01030000
01040000
01050000
01060000
01070000
01080000
01090000
01100000
01110000
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01120000

DELETE &VSVIDB PURGE 01130000
01140000

ALTER &VSVIDB..EX - 01150000
NEWNAME (&VSVIDB) 01160000

) SEL &VSV32VAC = YES 01170000
ALTER &VSVIDB..EX.DATA - 01180000
NEWNAME (&VSVIDB. .DATA) 01190000

) ENDSEL 01200000
//* 01210000
) SEL &VSV32CAT 2= &7 01220000
//RENAME . STEPCAT DD DSN=&VSV32CAT, 01230000
// DISP=SHR 01240000
) ENDSEL 01250000
//* 01260000
//DELETE.SYSIN DD * 01270000
DELETE &VSVIDB..EX PURGE 01280000
//* 01290000
) SEL &VSV32CAT 2= &7 01300000
//DELETE.STEPCAT DD DSN=&VSV32CAT, 01310000
// DISP=SHR 01320000
) ENDSEL 01330000
//* 01340000
) CM 01350000
)CM *** END OF VIASAKRX *** 01360000

To expand an AKR without using ISPF

1 RephceXX&ntheNAME(XX}EX),NAME(XX.EX.DATA),DSNAME(XX.EX),
INDATASET (XX), and the OUTDATASET (XX.EX) parameters with the name of
the AKR to be expanded.

2 Replace XX(xX) with the allocation units values and quantities for your site.

To rename an AKR without using ISPF

1 Replace the XX in the DELETE statement with the AKR to be renamed.

2 Type the new AKR name in the NEWNAME (XX) parameter.
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Using the Import and Export Facility

Importing an Application Definition

The Import facility imports application definitions into Alliance.

To prepare the application definition for importing, follow this step:

»

Edit an existing file or create a new file using keywords from the import language
described in the ASG-Application Definition and Analysis User’s Guide.

These keywords enable Alliance to identify the components and attributes for each
library and member included in the file and to convert the application definition to the
structure required by the Application Analytical Engine.

To import an application definition

1

Using the import language described in the ASG-Application Definition and Analysis
User’s Guide, edit or create a file containing the keywords to identify the application
information, defaults, and the components and attributes of the application
definition.

Save the file.

Start Alliance using the procedure defined for your site.

Select File » Import/Export from the Alliance Primary screen and press Enter.

Select Import Definition and press Enter.

In the Dataset name field of the File - Import Definition pop-up, type the name of the
dataset containing the import file you created in step 1.

If the high-level qualifier is different than your TSO prefix or user ID, enter the name
in single quotes ('). For example, ' USER. TEST. APPLDEF".
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7  Inthe Member name field, type the name of the member containing the import
information and press Enter.

The message APPLICATION <application name> IMPORTED
SUCCESSFULLY displays.

Note:
If the import does not complete successfully, verify the dataset and member names
for the import file. If the names are correct, review the structure and syntax of the
import file to locate any errors or invalid data input.

Exporting the Application Information

You can export both the application definition and the information produced from an
analyze job. Store the exported definition in a sequential file or a PDS member. Load
exported application analysis information into DB2 tables or input it to other database
managers. For information on loading into DB2, see "Defining and Loading DB2
Databases" on page 234. For information on exporting application information to the
Texas Instruments Transition Enablement Facility product, see "Exporting to Transition
Enablement Facility (TEF)" on page 301.

For AutoChange users, Alliance provides an automated export facility that stores both the
application definition and information produced from an analyze job in PDS members for
use by AutoChange. For information on using this facility see "Using Export for

AutoChange" on page 200.

Exporting Application Definition Data

190

The exported application definition consists of a series of keyword control statements
with a syntax that is consistent with the requirements of the Import facility. These are the
items the keyword control statements identify:

. The AKR
. The application name and description

. The application components and their associated attributes

For a description of the keyword control statement syntax, see "Importing an Application

Definition" on page 189.
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Use the exported application definition to perform these tasks:
. Create a backup of the application definition for easy recovery.
. Copy an application definition from one AKR to another.

. Copy an application definition to use as a template when you are creating a similar
definition.

To export the application definition

1 Identify or create a sequential file or a PDS to contain the exported definition. The
file must have a record length of 80.

2 Select File » Import/Export from the Alliance Primary screen and press Enter. The
File - Export Definition pop-up (see Figure 72) displays.

Figure 72 » File - Export Definition Pop-up

File - Export Definition
Cammand ===3*

Tupe AKR and Export information, then press enter.
Application Knowledge Repository (AKR):

Data set name . . . ‘VIAUID .TEST AKR’
Application name . .

Export:

Data set name
Hember . . . . . . .

3 On the File - Export Definition pop-up, specify this information:
. The AKR dataset name containing the application to export
. The application name
. The export definition dataset name

. If the export definition dataset is a PDS, specify the export definition member
name

4  Press Enter to execute the export request.

Note:
When the export of the application definition is complete, the message <application
name> EXPORTED displays in the short message area of the File - Export Definition
pop-up.
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Copying Application Definition Data

Edit the exported definition to use the import facility to copy the exported application
definition to an AKR (the original AKR or another AKR).

To copy the exported application definition

1

2

On the File - Export Definition pop-up, enter the dataset name.
Enter the application name and press Enter.

Note:
Application names must be unique within an AKR.

To complete this process, follow the instructions located in "Importing an
Application Definition" on page 189.

Creating an Application Definition Template

192

Edit the exported definition to use the Import facility to create an application definition
template.

To create a template from the exported application

1

2

On the File - Export Definition pop-up, enter the dataset name.
Enter the application name.
To update the application definition, use one of these methods:

Edit the exported application definition file. Modify the keyword control
statements, and their associated attribute keyword control statements, to create the
new application definition.

Or

Import the application definition into the target AKR (see "Importing an
Application Definition" on page 189). Then use the online application definition
function to modify the imported definition as appropriate.
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Exporting Application Analysis Results

Exported application analysis information consists of comma delimited output files
created for each application entity and relationship. Use the exported application
information files to load DB2 tables, or transfer it to your workstation for input to
database applications. For more information about AKR export output, see "Using the
Output from an AKR Export" on page 207.

Use the exported application analysis information as part of the input to develop these
types of business information:

. Planning models

. Impact of change analyses
. Where-used queries

. Work plans

. Manpower requirement estimates

Export application information using the online facility or using batch JCL supplied with
the product.

Using the Online Facility to Export Analysis Data

To export application information using the online facility
1 Start the product using the procedure defined for your site.

2 Select File » Import/Export from the Alliance Primary screen and press Enter. The
File - Import/Export pop-up displays.

3 Select Export Data and press Enter. The Data Export pop-up (see Figure 73)
displays.

Figure 73 « Data Export Pop-up

Data Export
CoHHand ===

fpecify options and jobcard infornation. Then press PF key for action.

WARNING! Zelecting "Edit JCL" or “Subrit JCL" will delete any eHisting
export files created under this userid.

Export Twpe __ 1. Flat Files DE2 Zubswsten:
2. DE2 Load
3. COOLIiGen Export

Job statedent infordation.

#~NAAE JOE [ACCOUNT ], MAHE,

£ HEGCLAEE=A

Ao INZERT '~ROUTE PRINT WODE.UZER' HERE IF MEEDED.
Ao

PF4=CO0LIGen EXport Options PFS=Edit JCL  PFE=SuUbHit JCL
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4  Type the DB2 subsystem name to immediately load the files into a DB2 database in
the DB2 Subsystem field.

5  In the Export Type field, perform one or more of these actions:

If you want Specify Export Type

Sequential files containing the Flat File. For example, you might want to
exported application data create a sequential file and bypass the DB2
database load.

Note:

If you specify Flat File, the sequential files
containing the exported application data are
catalogued when you submit the export job.

Use the data as input to a batch DB2 load or
other software, or transfer it to your
workstation for input to a database manager.

Application data exported into DB2 Load.The appropriate DB2 entities must
sequential files and then loaded  be defined before the DB2 export.

into a DB2 database as part of the

same job Note:

If you specify that a DB2 load is performed
as part of the export job, the default JCL
deletes the files containing the exported data
after a successful load. To retain these files,
edit the JCL before submitting the job, and
change the disposition JCL parameters.

Application data exported to the =~ COOL:Gen Export. For more information
TI Transition Enablement Facility about this option, see "Exporting to Transition
Enablement Facility (TEF)" on page 301.

6  Type the job card information required for your site in the Job Statement information
field.
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7  To submit the export job, choose one of these options:

To edit the generated JCL file before submitting the export job, press PF5 to edit
JCL. Type SUBMIT to submit the export job.

Or

To execute the export request without editing the generated JCL, press PF6 to

submit JCL.

Using Batch JCL to Export Analysis Data

You can also use batch JCL to export application data. The JCL has symbolic parameters
you can edit to meet your export requirements. Edit and submit these jobs when you
prefer not to start the online application.

The batch JCL members you need to accomplish these tasks are located in this PDS:

ASG.CENTER.CNTL

If you need help locating the JCL, contact your systems administrator.

This is the JCL included with the Export facility:

Dataset Name Description

VIABXTRIJ

Exports application data from a ESW AKR into sequential files.
See Figure 74 on page 196.

VIABXDFJ

Defines a DB2 database. See Figure 75 on page 196.

VIABXDF1

Inputs CREATE control statements for VIABXDFIJ. See Figure 76
on page 197.

VIABXDF2

Inputs DSN control statements for VIABXDFJ. See Figure 77 on
page 197.

VIABXLD

Loads application data from sequential files into a DB2 database.
See Figure 78 on page 198.

VIABXLD1

Inputs LOAD control statements for VIABXLDJ. See Figure 79
on page 199.
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Figure 74 « Sample VIABXTRJ

//*ASG JOB (

/1%
/1%
/1%
/1%
/1%
/1%
/1%
/1%
/1%
/1%
/1%
/1%

//VIABXTR PROC SYSOUT='*',

!/
!/
/7
/1%

INSERT '/

Kok KKKk Kk KK

UNLOAD

*
*
*
*
* NOTE:
*
*
*

Kk kKKK KK

VI
CE

), '"ASG EXPORT EXTR'
*ROUTE PRINT NODE.USER' HERE IF NEEDED.

R R R R R

ASG, INC. ASG-ALLIANCE MM-YYYY

APPLICATION DATA FROM A ASG AKR INTO FLAT FILES

*
*
*
ELRECL, & RLRECI, ARE ALREADY MINIMIZED TO REFLECT *
THE INFORMATION OUTPUT BY THE EXPORT FACILITY. *

*

*

R R R R R R

PRINTED OUTPUT MESSAGE CLASS
ASOFT="ASG', HIGH LEVEL NODE OF ASG DATA SETS
NTER='VIACENXX', MIDDLE NODE OF ASG DATA SETS

AKR="XXX.YYY.ZZZ' ASG AKR

//EXTRACT EXEC PGM=VIABEXPT,REGION=4096K,

2
/1%

//STEPLIB DD
//VIAAKR DD
//VIAUT3 DD
//VIALOG DD
//VIARARPT DD
//VIAPRINT DD
//SYSPRINT DD

/1%
//
/1%

PEND

//STEP1 EXEC

/1%

PARM= ('APPL=APPLNAME ')

DSN=&VIASOFT. .&CENTER. . LOADLIB, DISP=SHR
DSN=&AKR, DISP=SHR

UNIT=SYSDA, SPACE=(CYL, (10,10)
SYSOUT=&SYSOUT

SYSOUT=&SYSOUT

SYSOUT=&SYSOUT

SYSOUT=&SYSOUT

VIABXTR

00010001
00020000
00030000
00040000
00050001
00060000
00070001
00080000
00090000
00100000
00110000
00120000
00130000
00140000
00150001
00160001
00170001
00180000
00190000
00200000
00210000
00220000
00230000
00240000
00250000
00260000
00270000
00280000
00290000
00300000
00310000
00320000
00330000

Figure 75 « Sample VIABXDFJ

//ASG JOB (

//*
//*
//*
//*
//*
//*
//*
//*
//*

INSERT

), 'ASG EXPORT DEF'
'/*ROUTE PRINT NODE.USER' HERE IF NEEDED.

ROk ki kb bk b kb kb b b b kb kb b b ik kI I I bk I I Ik I I I Ik I I 2k kb I I I I I I I I I I

* ASG,

*

INC. ASG-ALLIANCE MM-YYYY

* DEFINE DB2 DATABASE FOR EXPORT FEATURE

*

*

*

*

*

KA A A A A A A A A A A A A A A A A A A A A A Ak ko k ko ko ko ko ko hkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkkkkkkkkkkkk

//JOBLIB DD DSN=DB2.DSNLOAD, DISP=SHR

//*

//DEFINE

//SYSTSPRT DD
//SYSTSIN DD
//SYSPRINT DD
//SYSUDUMP DD
//SYSIN DD
//SYSTSIN DD

//*

EXEC PGM=IKJEFTO01l, DYNAMNBR=20

SYSOUT=*

*

SYSOUT=*

SYSOUT=*
DSN=ASG.VIACENXX.CNTL (VIABXDF1) , DISP=SHR
DSN=ASG.VIACENXX.CNTL (VIABXDF2) , DISP=SHR

00010001
00020000
00030000
00040000
00050001
00060000
00070000
00080000
00090000
00100000
00110000
00120000
00130000
00140000
00150000
00160000
00170000
00180001
00190001
00200000
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Figure 76 » Sample VIABXDF1

CREATE TABLE ASG.PROGRAM
(PROGRAM_KEY CHAR(8) NOT NULL,
PROGRAM_NAME CHAR(8) NOT NULL,
PRIMARY KEY (PROGRAM KEY))

IN DATABASE USERDB;

CREATE UNIQUE INDEX ASG.PROGRAM KEY INX
ON ASG.PROGRAM
(PROGRAM KEY ASC)
USING STOGROUP USERSTGP
PRIQTY 10
ERASE NO
BUFFERPOOL BPO
CLOSE YES;

CREATE INDEX ASG.PROGRAM_ NAME INX
ON ASG.PROGRAM
(PROGRAM NAME ASC)
USING STOGROUP USERSTGP
PRIQTY 10
ERASE NO
BUFFERPOOL BPO
CLOSE YES;

COMMIT;

Figure 77 « Sample VIABXDF2

DSN SYSTEM(USERSYS)
RUN PROGRAM(DSNTIAD) LIB(USER DB2.LOADLIB') PLAN(USERPLAN)
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Figure 78 « Sample VIABXLDJ

//ASG JOB ( ),'ASG EXPORT LOAD'

//* INSERT '/*ROUTE PRINT NODE.USER' HERE IF NEEDED.

//*

//* AR RS S S S S SRS SR SRS SRS R SRS R R R R R SRS RS SR SRS RS RS EEEE SRS EEEESE S S ST
//*  * ASG, INC. ASG-ALLIANCE *
//* * *
//* * LOAD APPLICATION DATA FROM FLAT FILES TO DB2 *
//* * *
//* khhkhkhkkhkhkhkhkhkhkhhkhkhkhhkhkhkhkhhkhhkhkrhkhkhkhkhkhkhhkhkhkhkhkhkhkkhkhkhkhkhhkhkkhkhkhkhkhkhkhkhkhkkkxk*x*k
//*

//VIABXLD EXEC DSNUPROC, PARM= ('SUBSYSTEM')

//*

//SORTLIB DD DSN=SYS1.SORTLIB,DISP=SHR

//SORTOUT DD UNIT=SYSDA,SPACE=(CYL, (10,10),,,ROUND)

//SORTWKO1 DD UNIT=SYSDA,SPACE=(CYL, (10,10),,,ROUND)

//SORTWK02 DD UNIT=SYSDA, SPACE=(CYL, (10,10),,,ROUND)

//SORTWKO3 DD UNIT=SYSDA,SPACE=(CYL, (10,10),,,ROUND)

//SORTWK04 DD UNIT=SYSDA,SPACE=(CYL, (10,10),,,ROUND)

//DSNTRACE DD SYSOUT=*

//SYSMAP DD UNIT=SYSDA,SPACE=(CYL, (1,1)

//SYSUT1 DD UNIT=SYSDA,SPACE=(CYL, (50,50),,,ROUND)

//*

//SYSIN DD DSN=ASG.VIACENXX.CNTL (VIABXLD1),DISP=SHR

//*

//DDENT000 DD DSN=USER.VIABEXPT.EXPORT.EPGM, DISP=(SHR, KEEP, KEEP)
//DDENT001 DD DSN=USER.VIABEXPT.EXPORT.EENTRY,DISP=(SHR,KEEP, KEEP)
//DDENT002 DD DSN=USER.VIABEXPT.EXPORT.ECOPYMEM, DISP=(SHR,KEEP,KEEP)
//DDENT003 DD DSN=USER.VIABEXPT.EXPORT.EFD,DISP=(SHR,KEEP,KEEP)
//DDENT004 DD DSN=USER.VIABEXPT.EXPORT.ERECORD,DISP=(SHR,KEEP, KEEP)
//DDENT005 DD DSN=USER.VIABEXPT.EXPORT.EDATAITM, DISP=(SHR,KEEP,KEEP)
//DDENT006 DD DSN=USER.VIABEXPT.EXPORT.EIDMS,DISP=(SHR,KEEP,KEEP)
//DDENT007 DD DSN=USER.VIABEXPT.EXPORT.ESQL,DISP=(SHR,KEEP,KEEP)
//DDENT008 DD DSN=USER.VIABEXPT.EXPORT.ECSECT,DISP=(SHR,KEEP, KEEP)
//DDENT009 DD DSN=USER.VIABEXPT.EXPORT.ELOADMOD, DISP=(SHR, KEEP, KEEP)
//DDENT010 DD DSN=USER.VIABEXPT.EXPORT.EJOB,DISP=(SHR,KEEP,KEEP)

00010001
00020000
00030000
00040000
00050001
00060000
00070000
00080000
00090000
00100000
00110000
00120000
00130000
00140000
00150000
00160000
00170000
00180000
00190000
00200000
00210000
00220000
00230001
00240000
00250000
00260000
00270000
00280000
00290000
00300000
00310000
00320000
00330000
00340000
00350000
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Figure 79 « Sample of VIABXLD1

LOAD DATA REPLACE
INDDN (DDENT000) INTO TABLE VIASOFT.PROGRAM
(PROGRAM_KEY POSITION(01:08) CHAR(8) ,
PROGRAM_NAME POSITION(10:17) CHAR (8))

LOAD DATA REPLACE
INDDN (DDENT001) INTO TABLE VIASOFT.ENTRY
(ENTRY_KEY POSITION(01:08) CHAR(8),
ENTRY NAME POSITION(10:19) CHAR (10))

LOAD DATA REPLACE
INDDN (DDENTO002) INTO TABLE VIASOFT.COPYMEMBER
(COPYMEMBER KEY POSITION(01:08) CHAR(8),
COPYMEMBER NAME POSITION (10:19) CHAR(10))

LOAD DATA REPLACE
INDDN (DDENT003) INTO TABLE VIASOFT.FED
(FD_KEY POSITION(01:08) CHAR(8) ,
FD NAME POSITION(10:39) CHAR (30))

LOAD DATA REPLACE
INDDN (DDENTO004) INTO TABLE VIASOFT.RECORD
(REC_KEY POSITION(01:08) CHAR(8),
REC_NAME POSITION (10:39) CHAR (30))

LOAD DATA REPLACE
INDDN (DDENTO005) INTO TABLE VIASOFT.DATAITEM

(DATA_KEY POSITION(01:08) CHAR(8),
DATA NAME POSITION (10:39) CHAR (30),
DATA LEVEL POSITION (41:42) CHAR(2),
DATA PARENT POSITION (44:51) CHAR(8),
DATA CHILD POSITION (53:60) CHAR(8),

DATA NEXT STBLING POSITION (62:69) CHAR(8),
DATA PREV_SIBLING POSITION(71:78) CHAR(8),
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Using Export for AutoChange

Use this procedure to export an application definition and the corresponding data
resulting from an analyze job.

Note:

To successfully complete this export procedure, the application must be semantically
linked and free of errors.

1 From the Alliance Primary screen (see Figure 80) open the application you want to
export.

Figure 80 « Alliance Primary Screen

File Edit Wiew Facility Options Help

ASG-ALliance

Command ===3>
KEERRRRRRRRRRRRRRRAR RRERRRRRRRRRRRRRRRRR R AR AR AR AR AR AR AR
RRERRRRRRRRRRRRARLRELE  RRRRRRRR R R R R R R R R R AR AR Rk Rk kR
Kk kkE KhkkE  KRERER Kk kkE
Kk kkE KhkkE  KRERER Kk kkE
RRERRRRRRRRRRRRRRLREE KRR RRRRRRRRRRRRAR Kk kkE EETET 2T
RRERRRRRRRRRRRRRRRRAR RRERRRRRRRRRRRREE  KRERA EEZETETE
Kk kkE Kk kkE KhkkRE RRRER EEE
Kk kkE Kk kkE KhkkRE RRRER EEE
Kk kkE RRRRRRRRRRRRRRRRRRRRRRRER KRR RRRRRRRRR KRR kR
Kk kkE ERERRRRRRRRRRRRRRRRARARA KRERRRRRRRRRRRRAR

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Yisit the ASG Support Web Site at www.asg.com

2 Select Facility » Impact and press Enter. The Impact Facility screen displays (see
Figure 81).

Figure 81 « Impact Facility Screen for Selected Application

File Edit ¥iew Search Generate Worklist Options Help
Impact Facility
Command ===% Scroll ===* L3R

MName:

ek ok b ok ok ookl sk ok ook ckok sk ok otobb kool TOP OF  DETE sk skt ek o ook sk shob o e oh e koo sk ok ok ok ok o
ek ok ko ok kR sk ook bk ok ok ok sk skokokob btk BOTTOM OF DATE  eskskokok ok o ook sk ok sk ok seob oo ok sk ok of ok ook oh

200



Appendix D - Using the Import and Export Facility

On the Impact Facility screen, select File » New Impact List and press Enter. The
New Impact pop-up displays (see Figure 82).

Figure 82 « New Impact Pop-up

Hew Imnpact
Command ===
ASGISTEI IMPACT “"TESTEMTRZ" SUCCESSFULLT OPEMED.
Specify the name and description. Then press PF key for action.

Hame . . . . . TESTEMTRZ
Description . . TEST FILE

PF4=Edit Impact PFS=Summary Impact PFE=Detailed Impact

Enter the Name (the Name field is 8 characters in length) and Description and press
Enter.

Press PF4 to go the Impact Entity List (see Figure 83).

Figure 83  Impact Entity List

Inpact Entity List
CoHHand === fcroll ===} CIR

Press PF kew for actions. Delete requires selection 1 of 2695
of entryls].

Current Zort kKewl NAHE

Entity Kind Nare
_ PROGRAH<PROCEDURE-FUNCTION «BACE-DATE
_ PROGRAH<PROCEDURE-FUNCTION - COBSC-ERROR-CODE:
_ PROGRAH<PROCEDURE-FUNCTION «DATEE-TY
_ PROGRAH<PROCEDURE-FUNCTION SME-DATES-YY
_ PROGRAH<PROCEDURE-FUNCTION SWE-E-TY
_ ENTRY ' COBSE"
_ ENTRY tCoesct
_ ENTRY ‘CDileR’
_ ENTRY ‘CD1GE"
_ ENTRY 'CDLSE’

PFd=Add entity PFS=Delete entity PFE=Change fort
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6  To add an entity, press PF4. The Impact Entities Selection Criteria pop-up displays
(see Figure 84).

Figure 84  Impact Entities Selection Criteria Pop-up

IHpact Entities Zelection Criteria
ComMHand === ________________ 2crall ===} CIR
TeHt: *

1 of 51
Entity Kind [Default = All)

ARER

CATALDG
CICE-TRANSACTION
COLUAN
COPYHAEREER-INCLUDE
CED

CSECT

CUREOR

DATABASE
DATAITEH

DED

oo

DEN

PF5=%elect all PFe=Unselect all

7 Confirm that the Text field contains an asterisk (*), then select the Dataitem entity
and press Enter. The Add Impact List Entity screen displays (see Figure 85).

Figure 85 « Add Impact List Entity Screen

fadd Impact List Entity

Command ===} _ Scroll ===: CSR
Select desired entries then press the Add key. 1 of 157
Previously selected entries are marked with an asterisk.
Text: #*
Text Entity Kind
< EMD-IHPUT CATAITEM
< EMD-0F-COLS CATAITEM
< FIRST-TIME CATAITEM
< FIRST-TIME-SW CATAITEM
< IMPUT-EMD-0OF -FILE CATAITEM
< MISC-FIELDS CATAITEM
< OTL-CHG-CC-4 CATAITEM
< OTL-CHG-DL-1 CATAITEM
< OTL-CHG-DD-2 CATAITEM
< OTL-CHG-DL-32 CATAITEM

FFS=5elect all FPFE=Unhselect a1l  FPF1lO=Add

8 Press PF5 to Select all selections, then press PF10 to Add the selection.

9  Press PF3 to return to the New Impact screen.
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10 To generate the Summary Impact, press PF5. The Summary Impact - Select Impact
Generation Entities screen displays (see Figure 86).

11

12

Figure 86 « Summary Impact - Select Impact Generation Entities Screen

Summary Impact - Select Impact Generation Entities

Command ===

Scroll ===: CSR

Select the items from which the impact list will

be generated.

EMD- IMPUT
EMD- IMPUT
EMD- IMPUT
EMD- IMPUT
EMD- IMPUT
EMD- IMPUT
EMD-0F -COLS
EMD-0F -COLS
FIRST-TIME
FIRST-TIME
FIRST-TIME
FIRST-TIME

FF2=0ptions PFd4=Generate

1 of 514

Entity Kind Qualification >

DATATITEM IMPUT-EMD-0F -F1
DATATITEM IMPUT-EMD-0F -F1
DATATITEM IMPUT-EMD-0F -F1
DATATITEM IMPUT-EMD-0F -F1
DATATITEM IMPUT-EMD-0F -F1
DATATITEM IMPUT-EMD-0OF-F1I
DATATITEM QRT-INF-FIRST-B
DATATITEM QRT-INF-FIRST-B
DATATITEM FIRST-TIME-SW O
DATATITEM FIRST-TIME-SW O
DATATITEM FIRST-TIME-SW O
DATAITEM FIRST-TIME-SW O

PFS=Select all PFE=Hide entity kind

To select all entities, press PF5.

Or

Select individual entities to include in the summary.

Press PF2 for Options. The Impact Generate Options screen displays. Confirm you
have chosen all options as shown in this example (see Figure 87).

Figure 87 « Impact Generate Options Screen

Command ===

Impact Generate Options

Base Impact Targets:

Select desired Impact Generate Options.
#  Include Baze Selection in results
s Include Copy Detail in results

Targets Lewel Synonyms  To Fram Alternates
# Base Selection s - - -
# Parents of Base Selection - - - -
# Children of Baze Selection s s s s
Expanded Impact Targets: Application Assighments
Targets Lewel Synonyms  To Fram Alternates
<  Base Impact Targets - - # #
< Parents of Base Impact Targets - - - -
# Children of Base Impact Targets ~ - - -

FF4=Restore ASG Default Options

Application Assighments

PFS=Detailed Options

203



ASG-Alliance User’s Guide

13  Press PF3 to return to the Summary Impact - Select Impact Generation Entities

screen.

14  To generate the entity list, press PF4. When the entity list is complete, the Impact

Facility screen displays.

15 To create a worklist to store the saved results of this summary, select Worklist » New

worklist and press Enter. The New Worklist pop-up displays (see Figure 88).

Figure 88 « New Worklist Pop-up

Mew Worklist
Command ===}

Hame . « « o . WELSTTST
Description . . TEST WORKLIST
[Lata =set

Specify the worklist name and description. Then press Enter.

[(Optional)

16  Enter a name and description for the new worklist. Press Enter. If you do not enter a
worklist name, Alliance assigns a default name to the worklist.

17  Select Worklist » Write worklist and press Enter. The Impact Facility screen displays
the statement VIEW CONTENTS HAS BEEN SAVED TO WORKLIST "XXXXX"

where XXXXX is the name given to your worklist.

18 Seclect Worklist » Close worklist and press Enter.

19 Seclect Generate » ASG-AutoChange Export File and press Enter. The

Generate Impact Export for ASG-AutoChange screen displays (see Figure 89).

Figure 89 » Generate Impact Export for ASG-AutoChange Screen

EBatch Options Help

Gererate Impact Export For ASG-AutoChange
Command ===} _

fBpplication Definition:

Lata Set Mame "WIAULD . EXPORT.DEF '
Member Mame . . WIAQAHEW

Export Data:

Lata Set Mame "WMIAULD . EXPORT.DATA'

Member Mame . . YIAQAHEW

Worklist Mame "WMIAULD ALHEEGEGEE, Y ITAWKLEST
AKR DEH . . . . "MIAQA.QAESWSE. ATCHMAST. AKR®
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20 Enter this information:

21

. Application Definition:
—  Use an existing PDS for the dataset name and enter a new member name.
. Export Data:

— Usean existing PDS for the dataset name and enter the member name that
is the name of the application.

—  The worklist name is the name of the worklist created in step 15. The
AKR DSN is the name of the AKR where the application definition is
stored.

Note:

All dataset names must be fully qualified and datasets should have a record length
of 80 and record format of fixed block.

From the Batch Menu choose one of these actions:

To export the impact, submit the job. The Batch job is scheduled. A message
displays stating the job was submitted.

Or
To edit the JCL, edit the job. The JCL edit facility displays (see Figure 90).

Figure 90 « JCL Edit Facility

File Edit Confirm Henu Utilities CoWpilers Test Help

EDIT UIAUD .T1457V1d.VIATCL Colunns 008l aaavz

ConHand === Ecroll ===F PAGE
Top of Data

==HEG3 -Marning— The UNDO condand is not available until you change

==Hzi5> wour edit profile using the coWnand RECOUERY ON.

aagaal S-UIATFC JOE [ACCOUNT ) ,NAKE,

HEAEa2 <~ HEGCLASE=A

LT INZERT '-~+ROUTE PRINT HWODE.UZER' HERE IF WNEEDED.

HERaad <ok

HEAEAS <~

EO0EE <~FASGE  JOE [ ],'ASG EXPORT EXTR’

HEAEAT <o INZERT '-~+ROUTE PRINT HWODE.UZER' HERE IF WNEEDED.

HEAERS <~

HEAaae <~

HEgEln <ok sk ARG, INC. AEG-ALLIANCE HH -y

LILIEITTH I R, S

BEgal2 <o~ sk UNLOAD APPLICATION DATA FROM A ASG AKR INTO FLAT FILE:

LILTTITTN R e, S

aoa0id <~k  # NOTED ELRECL & RLRECL ARE ALREADY HINIHIZED TO REFLECT
HOERLS <ok THE INFORHATION OUTPUT EY THE EXPORT FACILITY.
HOERLE <ok

EFEEEEEE

205



ASG-Alliance User’s Guide

206



Appendix E
Export Language Reference

Using the Output from an AKR Export

Entity Files

The AKR export job creates a sequential file for each of the entities and relationships in
the application. Transfer the files created by the AKR export job to your workstation and
load them into your workstation database. You can also load these files into DB2 tables

1

or other databases. For more information about exporting data to DB2, see "Defining and
Loading DB2 Databases" on page 234.

The format for application data files created for entities is described in the section under
Entity Files. The format for application data files created for relationships is described
under "Relationship Files" on page 216.

Note:

The Assembler language does not create specific ASM entity kinds. All entity kinds look
the same as their COBOL counterparts (for example, a DCB appears as an FD). For more
information about Assembler language support, see the chapter regarding assembler
language support in the ASG-Application Definition and Analysis User’s Guide.

These are the application entity data types and export files:

Entity Type Filename

AREA <userid>EXPORT.<application name>AREA
Col 1: AREA Key
Col 2: AREA Name
CATALOG <userid>EXPORT<application name>.CATALOG
Col 1: CATALOG Key
Col 2: CATALOG Name
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Entity Type Filename

CICS-TRANSACTION <userid>EXPORT.<application name>.CICSTRAN

Col 1: CICS-TRANSACTION Key
Col 2: CICS-TRANSACTION Name
COLUMN <userid>EXPORT.<application name>.COLUMN
Col 1: COLUMN Key
Col 2: COLUMN Name
COPYMEMBER <userid>EXPORT.<application name>.COPYMEMB
Col 1: COPYMEMBER Key
Col 2: COPYMEMBER Name
CSD <userid>EXPORT.<application name>.CSD
Col 1: CSD Key
Col 2: CSD Name
CSECT <userid>EXPORT.<application name>.CSECT
Col 1: CSECT Key
Col 2: CSECT Name
CURSOR <userid>EXPORT.<application name>.CURSOR
CURSOR Key
CURSOR Name
DATABASE <userid>EXPORT<application name>DATABASE
Col 1: DATABASE Key
Col 2: DATABASE Name
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Entity Type Filename

DATAITEM <userid>EXPORT.<application name>DATAITEM
Col 1: DATAITEM Key
Col 2: DATAITEM Name
Col 3: ATTRIBUTE Level
Col 4: ATTRIBUTE Parent Key
Col 5: ATTRIBUTE Child Key
Col 6: ATTRIBUTE Next Key
Col 7: ATTRIBUTE Prev Key
Col 8: ATTRIBUTE Picture Clause
Col 9: ATTRIBUTE Usage
Col 10: ATTRIBUTE Occurs
Col 11: ATTRIBUTE Redefines Key
Col 12: ATTRIBUTE Rename Key
Col 13: ATTRIBUTE Rename Through Key
Col 14: ATTRIBUTE Size
Col 15: ATTRIBUTE Offset
Col 16: ATTRIBUTE Position
Col 17: ATTRIBUTE Value Clause
Col 18: ATTRIBUTE Uses
Col 19: ATTRIBUTE Modifications
Col 20: ATTRIBUTE References
Col 21: ATTRIBUTE Conditional
Col 22: ATTRIBUTE Arithmetic
Col 23: ATTRIBUTE Create

209



ASG-Alliance User’s Guide

Col 24: ATTRIBUTE Read
Col 25: ATTRIBUTE Update
Col 26: ATTRIBUTE Delete
DBD <userid>EXPORT.<application name>DBD
Col 1: DBD Key
Col 2: DBD Name
DD <userid>EXPORT<application name>DD
Col 1: DD Key
Col 2: DD Name
DSN <userid>EXPORT.<application name>DSN
Col 1: DSN Key
Col 2: DSN Name
Col 3: DSN Entity ATTRIBUTE
ENTRY <userid>.EXPORT.<application name>ENTRY
Col 1: ENTRY Key
Col 2: ENTRY Name
FCTCSD <userid>EXPORT<application name>FCTCSD
Col 1: FCTCSD Key
Col 2: FCTCSD Name
FD <userid>EXPORT.<application name>FDFILEVA
Col 1: FD Key
Col 2: FD Name
Col 3: T/F: Indicates whether a CREATE was used
Col 4: T/F: Indicates whether a READ was used
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Entity Type Filename

Col 5: T/F: Indicates whether a UPDATE was used
Col 6: T/F: Indicates whether a DELETE was used
FORMAT <userid>EXPORT.<application name>IMSFORMA
Col 1: FORMAT Key
Col 2: FORMAT Name
FCT <userid>EXPORT<application name>FCT
Col 1: FCT Key
Col 2: FCT Name
IDMS <userid>EXPORT.<application name>IDMS
Col 1: IDMS Key
Col 2: IDMS Name
IDMSMAP <userid>EXPORT.<application name>IDMSMAP
Col I: IDMSMAP Key
Col 2: IDMSMAP Name
IDMSRECORD <userid>EXPORT<application name>IDMSRECO
Col I: IDMSRECORD Key
Col 2: IDMSRECORD Name
Col 3: T/F: Indicates whether a CREATE was used
Col 4: T/F: Indicates whether a READ was used
Col 5: T/F: Indicates whether a UPDATE was used
Col 6: T/F: Indicates whether a DELETE was used
IMS DYN ALLOC <userid>EXPORT<application name>IMSDYNAL
MACRO
Col 1: IDMS DYN ALLOC MACRO Key

Col 2: IDMS DYN ALLOC MACRO Name
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IMS-TRANSACTION <userid>EXPORT.<application name>.IMSTRANS
Col I: IMS-TRANSACTION Key
Col 2: IMS-TRANSACTION Name
JOB <userid>EXPORT.<application name>JOB
Col 1: JOB Key
Col 2: JOB Name
LIBRARY <userid>EXPORT.<application name>LIBRARY
Col 1: LIBRARY Key
Col 2: LIBRARY Name
LOADMODULE <userid>EXPORT<application name>LOADMODU
Col 1: LOADMOD Key
Col 2: LOADMOD Name
LOGICALRECORD <userid>.EXPORT.<application name>LOGICALR
Col 1: LOGICALRECORD Key
Col 2: LOGICALRECORD Name
MAP <userid>.EXPORT.<application name>MAP
Col 1: MAP Key
Col 2: MAP Name
MAPFIELD <userid>.EXPORT.<application name>MAPFIELD
Col 1: MAPFIELD Key
Col 2: MAPFIELD Name
MAPSET <userid>EXPORT<application name>MAPSET
Col 1: MAPSET Key
Col 2: MAPSET Name
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MEMBER <userid>EXPORT.<application name>.MEMBER
Col 1: MEMBER Key
Col 2: MEMBER Name
PCB <userid>EXPORT.<application name>PCB
Col 1: PCB Key
Col 2: PCB Name
PCT <userid>EXPORT<application name>PCT
Col 1: PCT Key
Col 2: PCT Name
PPT <userid>.EXPORT.<application name>.PPT
Col 1: PPT Key
Col 2: PPT Name
PROC <userid>EXPORT.<application name>PROC
Col 1: PROC Key
Col 2: PROC Name
PROGRAM <userid>.EXPORT.<application name>PROGRAMP
Col 1: PROGRAM Key
Col 2: PROGRAM Name
PSB <userid>EXPORT.<application name>.PSB
Col 1: PSB Key
Col 2: PSB Name
RECORD <userid>EXPORT.<application name>RECORDS
Col 1: RECORD Key
Col 2: RECORD Name
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SCHEMA <userid>EXPORT.<application name>SCHEMA
Col 1: SCHEMA Key
Col 2: SCHEMA Name
SEGFIELD <userid>EXPORT.<application name>.SEGFIELD
Col 1: SEGFIELD Key
Col 2: SEGFIELD Name
SEGMENT <userid>EXPORT.<application name>.SEGMENT
Col 1: SEGMENT Key
Col 2: SEGMENT name
Col 3: T/F: Indicates whether a CREATE was used
Col 4: T/F: Indicates whether a READ was used
Col 5: T/F: Indicates whether a UPDATE was used
Col 6: T/F: Indicates whether a DELETE was used
SENFIELD <userid>EXPORT.<application name>.SENFIELD
Col 1: SENFIELD Key
Col 2: SENFIELD Name
SENSEG <userid>EXPORT<application name>.SENSEG
Col 1: SENSEG Key
Col 2: SENSEG Name
SQL <userid>EXPORT<application name>.SQL
Col 1: SQL Entity Key
Col 2: SQL Entity Name
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STEP <userid>EXPORT.<application name>.STEP
Col 1: STEP Key
Col 2: STEP Name
STOGROUP <userid>EXPORT.<application name>.STOGROUP
Col 1: STOGROUP Key
Col 2: STOGROUP name
SUBSCHEMA <userid>EXPORT.<application name>SUBSCHEM
Col 1: SUBSCHEMA Key
Col 2: SUBSCHEMA Name
TABLE <userid>EXPORT.<application name>TABLE
Col 1: TABLE Key
Col 2: TABLE Name
Col 3: T/F: Indicates whether a CREATE was used
Col 4: T/F: Indicates whether a READ was used
Col 5: T/F: Indicates whether a UPDATE was used
Col 6: T/F: Indicates whether a DELETE was used
TABLESPACE <userid>EXPORT<application name>TABLESPA
Col I: TABLESPACE Key
Col 2: TABLESPACE Name
VIEW <userid>EXPORT<application name>VIEW
Col 1: VIEW Key
Col 2: VIEW Name

215



ASG-Alliance User’s Guide

Relationship Files

216

These are the relationship files:

Relationship Type

Filename

AREA HAS RECORDS

<userid>EXPORT.<application
Col 1: AREA Key
Col 2: IDMSRECORD Key

name>.ARAHRECF

AREA IN PROGRAM

<userid>EXPORT.<application
Col 1: AREA Key
Col 2: PROGRAM Key

name>.ARAINPGM

AREA IN SUBSCHEMA

<userid>EXPORT.<application
Col 1: AREA Key
Col 2: SUBSCHEMA Key

name>.AINSUBSF

CALLS IS ENTRY

<userid>EXPORT.<application
Col 1: CALL Key
Col 2: ENTRY Key

name>.CALISENT

CATALOG USEDBY JOB

<userid>EXPORT.<application
Col 1: CATALOG Key
Col 2: JOB Key

name>.CATUBJOB

CATALOG USEDBY STEP

<userid>EXPORT.<application
Col 1: CATALOG Key
Col 2: STEP Key

name>.CATUBSTF

CICSDD USEDBY PROGRAM

<userid>EXPORT.<application
Col 1: CICSDD Key
Col 2: PROGRAM Key

name>.CDDUBPGM

CICS-TRANSACTION
EXECUTED-BY PROGRAM

<userid>EXPORT.<application
Col 1: CICS-TRANSACTION Key
Col 2: PROGRAM Key

name>.TRAEBPGM

CICS-TRANSACTION EXECUTES
PROGRAM

<userid>EXPORT.<application
Col 1: CICS-TRANSACTION Key
Col 2: PROGRAM Key

name>.CTREXPGM

CICS-TRANSACTION IN CSD

<userid>EXPORT.<application
Col 1: CICS-TRANSACTION Key
Col 2: CSD Key

name>.CTRINCSD
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Relationship Type Filename

CICS-TRANSACTION IN PCT <userid>EXPORT.<application name>.CTRINPCT
Col 1: CICS-TRANSACTION Key
Col 2: PCT Key

COLUMN IN PROGRAM <userid>EXPORT.<application name>.COLINPGM

Col 1: COLUMN Key
Col 2: PROGRAM Key

COLUMN IN TABLE <userid>EXPORT.<application name>.COLINTAB
Col 1: COLUMN Key
Col 2: TABLE Key

COLUMN IN VIEW <userid>EXPORT<application name>.COLIVIEW

Col 1: COLUMN Key
Col 2: VIEW Key

COPYMEMBER HAS DATAITEM <userid>.EXPORT.<application
Col 1: COPYMEMBER Key
Col 2: DATAITEM Key

name>INCHDDEF

COPYMEMBER IN <userid>EXPORT.<application
COPYMEMBER Col 1: COPYMEMBER Key
Col 2: COPYMEMBER Key

name>.CPYINICP

COPYMEMBER IN MEMBER <userid>.EXPORT.<application
Col 1: COPYMEMBER Key
Col 2: MEMBER Key

name>.COPYIMBR

COPYMEMBER IN PROGRAM <userid>.EXPORT.<application
Col 1: COPYMEMBER Key
Col 2: PROGRAM Key

name>.CPMINPGM

COPYMEMBER INCLUDES <userid>EXPORT.<application
COPYMEMBER Col 1: COPYMEMBER Key
Col 2: COPYMEMBER Key

name>.CPYICPYF

COPYMEMBER USEDBY <userid>EXPORT.<application
COPYMEMBER Col 1: COPYMEMBER Key
Col 2: COPYMEMBER Key

name>.CPYUSBCP

COPYMEMBER USEDBY <userid>EXPORT.<application
MEMBER Col 1: COPYMEMBER
Col 2: MEMBER

name>MBINCSRC
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Relationship Type Filename
COPYMEMBER USES <userid>EXPORT.<application
COPYMEMBER

Col 1: COPYMEMBER Key
Col 2: COPYMEMBER Key

name>.CPYUSCPY

CSD HAS CICS-TRANSACTION <userid>EXPORT.<application
Col 1: CSD Key
Col 2: CICS-TRANSACTION Key

name>.CSDHCTRF

CSD HAS DD <userid>EXPORT.<application
Col 1: CSD Key
Col 2: DD Key

name>.CSDHDDF

CSECT IN LOADMODULE <userid>.EXPORT.<application
Col 1: CSECT Key
Col 2: LOADMODULE Key

name>.CSECINLM

CSECT IS PROGRAM <userid>.EXPORT.<application
Col 1: CSECT Key
Col 2: PROGRAM Key

name>.CSECTPGM

CURSOR IN DATABASE <userid>.EXPORT.<application
Col 1: CURSOR Key
Col 2: DATABASE Key

name>.CURINDBF

CURSOR IN PROGRAM <userid>.EXPORT.<application
Col 1: CURSOR Key
Col 2: PROGRAM Key

name>.CSRINPGM

DATABASE HAS CURSOR <userid>EXPORT.<application
Col 1: DATABASE Key
Col 2: CURSOR Key

name>DBHCSRF

DATABASE HAS TABLESPACE  <userid>EXPORT.<application
Col 1: DATABASE Key
Col 2: TABLESPACE Key

name>DBHTBLSP

DATABASE IN PROGRAM <userid>.EXPORT.<application
Col 1: DATABASE Key
Col 2: PROGRAM Key

name>.DBINPGMF

DATABASE IN STOGROUP <userid>EXPORT.<application
Col 1: DATABASE Key
Col 2: STOGROUP Key

name>.DBINSGRP
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Relationship Type Filename
DATAITEM DEFINED-IN <userid>EXPORT.<application name>DTDEFINC
INCLUDE Col 1: DATAITEM Key
Col 2: INCLUDE Key
DATAITEM DEFINED-IN <userid>EXPORT.<application name>.DTDEFPGM
PROGRAM Col 1: DATAITEM Key
Col 2: PROGRAM Key
DATAITEM IN RECORD <userid>.EXPORT.<application name>.DATINREC
Col 1: DATAITEM Key
Col 2: RECORD Key
DATAITEM REFERENCED-BY <userid>EXPORT.<application name>.DIRMAPF
FIELD Col 1: DATAITEM Key
Col 2: MAPSET Key
DATAITEM REFERENCED-BY <userid>.EXPORT.<application name>DIRBMAPF
MAPFIELD Col 1: DATAITEM Key
Col 2: MAPFIELD Key
DATAITEM REFERENCES <userid>EXPORT.<application name>DIRMAPF
MAPFIELD Col 1: DATAITEM Key
Col 2: MAPFIELD Key
DBD HAS DD <userid>EXPORT.<application name>DBDHSDDF
Col 1: DBD Key
Col 2: DD Key
DBD HAS SEGMENT <userid>.EXPORT.<application name>DBDHSEGF
Col 1: DBD Key
Col 2: SEGMENT Key
DBD IN MEMBER <userid>.EXPORT.<application name>.DBDINMBR
Col 1: DBD Key
Col 2: MEMBER Key
DBD IN PCB <userid>EXPORT.<application name>DBDINPCB
Col 1: DBD Key
Col 2: PCB Key
DD HAS DSN <userid>EXPORT.<application name>DDHDSNF

Col 1: DD Key
Col 2: DSN Key
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DD IN CSD <userid>EXPORT.<application name>DDINCSDF
Col 1: DD Key

Col 2: CSD Key

DD IN DBD <userid>EXPORT.<application name>.DDINDBDF
Col 1: DD Key
Col 2: DBD Key

DD IN FCT <userid>EXPORT.<application name>DDINFCTF
Col 1: DD Key
Col 2: FCT Key

DD IN CICS <userid>EXPORT.<application name>DDINCICS
Col 1: DD Key
Col 2: CICS Key

DD IN STEP <userid>EXPORT.<application name>.DDINSTEP
Col 1: DD Key
Col 2: STEP Key

DD SELECTED-BY FD <userid>.EXPORT.<application name>DDSELBFDF
Col 1: DD Key
Col 2: FD Key

DSN HAS MEMBER <userid>.EXPORT.<application name>DSNHMBRF

Col 1: DSN Key
Col 2: MEMBER Key

DSN IN DD <userid>.EXPORT.<application name>.DSNINDDF
Col 1: DSN Key
Col 2: DD Key

ENTRY CALLED-BY PROGRAM <userid>EXPORT.<application name>ENTCBPGM
Col 1: ENTRY Key
Col 2: PROGRAM Key

ENTRY IN PROGRAM <userid>EXPORT.<application name>ENTINPGM
Col 1: ENTRY Key
Col 2: PROGRAM Key

ENTRY IS CALLS <userid>EXPORT.<application name>ENTISCAL
Col 1: ENTRY Key
Col 2: CALL Key
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Filename

FCT HAS DD

<userid>EXPORT.<application
Col 1: FCT Key
Col 2: DD Key

name>.FCTHDDF

FCT IN MEMBER

<userid>EXPORT.<application
Col 1: FCT Key
Col 2: MEMBER Key

name>.FCTINMBR

FCTCSD HAS DD

<userid>EXPORT.<application
Col 1: FCTCSD Key
Col 2: DD Key

name>.CICSHDDF

FD IN PROGRAM

<userid>.EXPORT.<application
Col 1: FD Key
Col 2: PROGRAM Key

name>FDINPGMF

FD SELECTS DD

<userid>EXPORT.<application
Col 1: FD Key
Col 2: DD Key

name>FDSELDDF

FD USES RECORD

<userid>EXPORT.<application
Col 1: FD Key
Col 2: RECORD Key

name>FDUSRECF

FORMAT EXECUTED-BY
FORMAT

<userid>EXPORT.<application
Col 1: FORMAT Key
Col 2: FORMAT Key

name>FMTEBFMT

FORMAT EXECUTED-BY
PROGRAM

<userid>EXPORT.<application
Col 1: FORMAT Key
Col 2: PROGRAM Key

name>FMTEBPGM

FORMAT EXECUTES FORMAT <userid>.EXPORT.<application name>FMTEXFMT
Col 1: FORMAT Key
Col 2: FORMAT Key

FORMAT EXECUTES <userid>.EXPORT.<application name>FMEXITRN

IMS-TRANSACTION

Col 1: FORMAT Key
Col 2: IMS-TRANSACTION Key

FORMAT IN MEMBER

<userid>EXPORT.<application
Col 1: FORMAT Key
Col 2: MEMBER Key

name>FMINMBRF
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Relationship Type Filename
IDMS IN PROGRAM <userid>EXPORT.<application name>IDMSIPGM
Col 1: IDMS Key
Col 2: PROGRAM Key
IDMSMAP HAS IDMSRECORD <userid>EXPORT.<application name>MAPHRECF
Col 1: IDMSMAP Key
Col 2: IDMSRECORD Key
IDMSMAP IN PROGRAM <userid>EXPORT.<application name>MAPINPGM
Col 1: IDMSMAP Key
Col 2: PROGRAM Key
IDMSRECORD IN AREA <userid>EXPORT.<application name>RECINAF
Col 1: IDMSRECORD Key
Col 2: AREA Key
IDMSRECORD IN IDMSMAP <userid>EXPORT.<application name>.RECINMAP
Col 1: IDMSRECORD Key
Col 2: IDMSMAP Key
IDMSRECORD IN <userid>EXPORT.<application name>RECILREC
LOGICALRECORD Col 1: IDMSRECORD Key
Col 2: LOGICALRECORD Key
IMSDYNALLOCMACRO IN <userid>EXPORT<application name>MDAINMBR
MEMBER

Col 1: IMSDYNALLOCMACRO Key
Col 2: MEMBER Key

IMS-TRANSACTION
EXECUTED-BY FORMAT

<userid>EXPORT.<application
Col 1: IMS-TRANSACTION Key
Col 2: FORMAT Key

name>ITRNEBFM

IMS-TRANSACTION
EXECUTED-BY PROGRAM

<userid>EXPORT.<application
Col 1: IMS-TRANSACTION Key
Col 2: PROGRAM Key

name>ITRNEBPG

IMS-TRANSACTION EXECUTES

LOADMODULE

<userid>EXPORT.<application
Col 1: IMS-TRANSACTION Key
Col 2: LOADMODULE Key

name>ITRNEXLM

JOB HAS STEP

<userid>EXPORT.<application
Col 1: JOB Key
Col 2: STEP Key

name>.JOBHSTPF




Relationship Type

Appendix E - Export Language Reference

Filename

JOB IN MEMBER

<userid>EXPORT.<application
Col 1: JOB Key
Col 2: MEMBER Key

name>.JOBINMBR

JOB USES CATALOG

<userid>EXPORT.<application
Col 1: JOB Key
Col 2: CATALOG Key

name>.JOBUSCAT

JOB USES LIBRARY

<userid>EXPORT.<application
Col 1: JOB Key
Col 2: LIBRARY Key

name>.JOBUSLIB

LIBRARY HAS MEMBER

<userid>EXPORT.<application
Col 1: LIBRARY Key
Col 2: MEMBER Key

name>LIBHMBRF

LIBRARY USEDBY JOB

<userid>EXPORT.<application
Col 1: LIBRARY Key
Col 2: JOB Key

name>.LIBUBJOB

LIBRARY USEDBY STEP

<userid>EXPORT.<application
Col 1: LIBRARY Key
Col 2: STEP Key

name>LIBUBSTF

LOADMODULE EXECUTED-BY
STEP

<userid>EXPORT.<application
Col 1: LOADMODULE Key
Col 2: STEP Key

name>LMEXSTPF

LOADMODULE EXECUTED-BY
IMS-TRANSACTION

<userid>EXPORT.<application
Col 1: LOADMODULE Key
Col 2: IMS-TRANSACTION Key

name>LMEBITRN

LOADMODULE HAS CSECT <userid>EXPORT.<application name>LMHCSECT
Col 1: LOADMODULE Key
Col 2: CSECT Key
LOADMODULE IN MEMBER <userid>EXPORT.<application name>LMINMBRF
Col 1: LOADMODULE Key
Col 2: MEMBER Key
LOGICALRECORD HAS <userid>EXPORT.<application name>LRHRECF
IDMSRECORD

Col 1: LOGICALRECORD Key
Col 2: IDMSRECORD Key
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Relationship Type Filename

LOGICAL RECORD INPROGRAM <userid>EXPORT.<application
Col 1: LREC Key
Col 2: PROGRAM Key

name>.LRINPGMF

MAP IN MAPSET <userid>EXPORT.<application
Col 1: MAP Key
Col 2: MAPSET Key

name>MAPINMST

MAP REFERENCES RECORD <userid>EXPORT.<application
Col 1: MAP Key
Col 2: RECORD Key

name>MRCRFREC

MAP USEDBY PROGRAM <userid>.EXPORT.<application
Col 1: MAP Key
Col 2: PROGRAM Key

name>MPAUBPGM

MAPFIELD IN MAP <userid>EXPORT.<application
Col 1: MAPFIELD Key
Col 2: MAP Key

name>MFDINMAP

MAPFIELD REFERENCED BY <userid>.EXPORT.<application name>MAPFRFDI
DATAITEM Col 1: MAPSET Key
Col 2: DATAITEM Key
MAPSET HAS MAP <userid>.EXPORT.<application name>MSETHMAP
Col 1: MAPSET Key
Col 2: MAP Key
MAPSET IN MEMBER <userid>EXPORT.<application name>MSTINMBR

Col 1: MAPSET Key
Col 2: MEMBER Key

MAPSET USEDBY PROGRAM <userid>.EXPORT.<application
Col 1: MAPSET Key
Col 2: PROGRAM Key

name>MSETUPGM

MDA HAS DD <userid>EXPORT.<application
Col 1: MDA Key
Col 2: DD Key

name>MDAHSDDF

MEMBER HAS COPYMEMBER <userid>.EXPORT.<application
Col 1: MEMBER Key
Col 2: COPYMEMBER Key

name>MBRISCIN
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Filename

MEMBER HAS DBD

<userid>EXPORT.<application
Col 1: MEMBER Key
Col 2: DBD Key

name>MBRHDBDF

MEMBER HAS FCT

<userid>EXPORT.<application
Col 1: MEMBER Key
Col 2: FCT Key

name>MBRHFCTF

MEMBER HAS FORMAT

<userid>EXPORT.<application
Col 1: MEMBER Key
Col 2: FORMAT Key

name>MBRHFMF

MEMBER HAS
IMSDYNALLOCMACRO

<userid>EXPORT.<application
Col 1: MEMBER Key
Col 2: IMSDYNALLOCMACRO Key

name>MBRHMDA

MEMBER HAS JOB

<userid>EXPORT.<application
Col 1: MEMBER Key
Col 2: JOB Key

name>MBRHIJOBF

MEMBER HAS LOADMODULE

<userid>EXPORT.<application
Col 1: MEMBER Key
Col 2: LOADMODULE Key

name>MBRHLMF

MEMBER HAS MAPSET

<userid>EXPORT.<application
Col 1: MEMBER Key
Col 2: MAPSET Key

name>MBRHMSET

MEMBER HAS PCT

<userid>EXPORT.<application
Col 1: MEMBER Key
Col 2: PCT Key

name>MBRHPCTF

MEMBER HAS PPT

<userid>EXPORT.<application
Col 1: MEMBER Key
Col 2: PPT Key

name>MBRHPPTF

MEMBER HAS PROC

<userid>EXPORT.<application
Col 1: MEMBER Key
Col 2: PROC Key

name>MBRHPROC

MEMBER HAS PROGRAM

<userid>EXPORT.<application
Col 1: MEMBER Key
Col 2: PROGRAM Key

name>MBRHPGMF
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MEMBER HAS PSB <userid>EXPORT.<application name>MBRHPSBF
Col 1: MEMBER Key
Col 2: PSB Key

MEMBER IN DSN <userid>EXPORT.<application name>MBRINDSN
Col 1: MEMBER Key
Col 2: DSN Key

MEMBER IN LIBRARY <userid>EXPORT.<application name>MBRINLIB
Col 1: MEMBER Key
Col 2: LIBRARY Key

MEMBER USES COPYMEMBER  <userid>EXPORT.<application name>SRCINCMB
Col 1: MEMBER Key
Col 2: COPYMEMBER Key

PCB HAS SENSEG <userid>EXPORT.<application name>PCBHSSGF
Col 1: PCB Key
Col 2: SENSEG Key

PCB IN PSB <userid>EXPORT.<application name>PCBINPSB
Col 1: PCB Key
Col 2: PSB Key

PCB REFERENCES DBD <userid>.EXPORT.<application name>PCBHDBDF
Col 1: PCB Key
Col 2: DBD Key

PCT HAS CICS-TRANSACTION <userid>.EXPORT.<application name>.PCTHCTRF
Col 1: PCT Key
Col 2: CICS-TRANSACTION Key

PCT IN MEMBER <userid>.EXPORT.<application name>.PCTINMBR
Col 1: PCT Key
Col 2: MEMBER Key

PPT IN MEMBER <userid>.EXPORT.<application name>.PPTINMBR
Col 1: PPT Key
Col 2: MEMBER Key

PROC HAS STEP <userid>.EXPORT.<application name>PRCHSTPF
Col 1: PROC Key
Col 2: STEP Key
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PROC EXECUTED-BY STEP <userid>EXPORT.<application
Col 1: PROC Key
Col 2: STEP Key

name>PROCEBST

PROC IN MEMBER <userid>EXPORT.<application
Col 1: PROC Key
Col 2: MEMBER Key

name>.PRCINMBR

PROGRAM CALLS ENTRY <userid>EXPORT.<application name>PGMCENTF
Col 1: PROGRAM Key
Col 2: ENTRY Key
PROGRAM EXECUTED-BY <userid>EXPORT.<application name>PGMEBCTR
CICS-TRANSACTION Col 1: PROGRAM Key
Col 2: CICS-TRANSACTION Key
PROGRAM EXECUTES <userid>EXPORT.<application name>PGMEXTRN

CICS-TRANSACTION Col 1: PROGRAM Key

Col 2: CICS-TRANSACTION Key

PROGRAM EXECUTES FORMAT <userid>EXPORT.<application
Col 1: PROGRAM Key
Col 2: FORMAT Key

name>PGMEXFMT

PROGRAM EXECUTES <userid>EXPORT.<application name>PGMEXITR
IMS-TRANSACTION Col 1: PROGRAM Key
Col 2: IMS-TRANSACTION Key
PROGRAM HAS AREA <userid>EXPORT.<application name>.PGMHAREA
Col 1: PROGRAM Key
Col 2: AREA Key
PROGRAM HAS COLUMN <userid>EXPORT.<application name>PGHHCOLF
Col 1: PROGRAM Key
Col 2: COLUMN Key
PROGRAM HAS CURSOR <userid>EXPORT.<application name>PGMHCSRF
Col 1: PROGRAM Key
Col 2: CURSOR Key
PROGRAM HAS DATABASE <userid>.EXPORT.<application name>PGMHDBF

Col 1: PROGRAM Key
Col 2: DATABASE Key
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PROGRAM HAS DATAITEM <userid>EXPORT.<application name>PGMHDDEF
Col 1: PROGRAM Key
Col 2: DATAITEM Key

PROGRAM HAS ENTRY <userid>EXPORT.<application name>PGMHENTF
Col 1: PROGRAM Key
Col 2: ENTRY Key

PROGRAM HAS FD <userid>EXPORT.<application name>PGMHFDF
Col 1: PROGRAM Key
Col 2: FD Key

PROGRAM HAS IDMS <userid>EXPORT.<application name>PGMHIDMS
Col 1: PROGRAM Key
Col 2: IDMS Key

PROGRAM HAS IDMSMAP <userid>.EXPORT.<application name>PGMHMAP

Col 1: PROGRAM Key
Col 2: IDMSMAP Key

PROGRAM HAS IDMSRECORD

<userid>EXPORT.<application
Col 1: PROGRAM Key
Col 2: IDMSRECORD Key

name>PGMHRECS

PROGRAM HAS <userid>EXPORT.<application name>PGMHLREC
LOGICALRECORD Col 1: PROGRAM Key

Col 2: LOGICALRECORD Key
PROGRAM HAS RECORD <userid>EXPORT.<application name>PGMRHREC

Col 1: PROGRAM Key
Col 2: RECORD Key

PROGRAM HAS SCHEMA

<userid>EXPORT.<application
Col 1: PROGRAM Key
Col 2: SCHEMA Key

name>PGMHSCHF

PROGRAM HAS SQL

<userid>EXPORT.<application
Col 1: PROGRAM Key
Col 2: SQL Entity Key

name>PGMHSQLF

PROGRAM HAS STOGROUP

<userid>EXPORT.<application
Col 1: PROGRAM Key
Col 2: STOGROUP Key

name>PGMHSTGF
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PROGRAM HAS SUBSCHEMA <userid>EXPORT.<application
Col 1: PROGRAM Key
Col 2: SUBSCHEMA Key

name>PGMHSSCH

PROGRAM HAS TABLE <userid>EXPORT.<application
Col 1: PROGRAM Key
Col 2: TABLE Key

name>.PGMHTBLF

PROGRAM HAS TABLESPACE <userid>.EXPORT.<application
Col 1: PROGRAM Key
Col 2: TABLESPACE Key

name>PGMHTBLS

PROGRAM HAS VIEW <userid>EXPORT.<application
Col 1: PROGRAM Key
Col 2: VIEW Key

name>PGMHVIEW

PROGRAM IN MEMBER <userid>.EXPORT.<application
Col 1: PROGRAM Key
Col 2: MEMBER Key

name>PGMINMBR

PROGRAM INCLUDES <userid>EXPORT.<application
COPYMEMBER Col 1: PROGRAM Key
Col 2: COPYMEMBER Key

name>PGMILMBR

PROGRAM IS CSECT <userid>EXPORT.<application name>PGMISCSC
Col 1: PROGRAM Key
Col 2: CSECT Key

PROGRAM LINKEDBY <userid>.EXPORT.<application name>PGMLBPGM

PROGRAM Col 1: PROGRAM Key

Col 2: PROGRAM Key

PROGRAM LINKS PROGRAM <userid>.EXPORT.<application
Col 1: PROGRAM Key
Col 2: LINKED PROGRAM Key

name>PGMLKPGM

PROGRAM USES DD <userid>EXPORT.<application name>PGMUSCDD
Col 1: PROGRAM Key
Col 2: DD Key

PROGRAM USES MAP <userid>EXPORT.<application name>PGMUSMAP

Col 1: PROGRAM Key
Col 2: MAP Key
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PROGRAM USES MAPSET <userid>EXPORT.<application
Col 1: PROGRAM Key
Col 2: MAPSET Key

name>PGMUSMST

PROGRAM USES PSB <userid>EXPORT.<application
Col 1: PROGRAM Key
Col 2: PSB Key

name>.PGMUSPSB

PROGRAM USES SEGMENT <userid>EXPORT.<application
Col 1: PROGRAM Key
Col 2: SEGMENT Key

name>PGMUSEGF

PROGRAM USES <userid>EXPORT.<application
SPECIALREGISTER Col 1: PROGRAM Key

Col 2: SPECIALREGISTER Key

name>PGMUSREG

PSB HAS PCB <userid>EXPORT.<application
Col 1: PSB Key
Col 2: PCB Key

name>PSBHPCBF

PSB IN MEMBER <userid>EXPORT.<application
Col 1: PSB Key
Col 2: MEMBER Key

name>PSBINMBR

PSB USEDBY PROGRAM <userid>.EXPORT.<application
Col 1: PSB Key
Col 2: PROGRAM Key

name>PSBUBPGM

RECORD HAS DATAITEM <userid>.EXPORT.<application
Col 1: RECORD Key
Col 2: DATAITEM Key

name>RECHDATA

RECORD IN PROGRAM <userid>.EXPORT.<application
Col 1: RECORD Key
Col 2: PROGRAM Key

name> RECINPGM

RECORD REFERENCED BY MAP <userid>EXPORT.<application
Col 1: RECORD Key
Col 2: MAP Key

name>RECRBMRC

RECORD USEDBY FD <userid>.EXPORT.<application
Col 1: RECORD Key
Col 2: FD Key

name>RECUBFDF
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SCHEMA HAS SUBSCHEMA <userid>EXPORT.<application
Col 1: SCHEMA Key
Col 2: SUBSCHEMA Key

name>.SCMHSSCM

SCHEMA IN PROGRAM <userid>EXPORT.<application
Col 1: SCHEMA Key
Col 2: PROGRAM Key

name>.SCHINPGM

SEGFIELD IN SEGMENT <userid>EXPORT.<application name>FLDINSEG
Col 1: SEGFIELD Key
Col 2: SEGMENT Key

SEGMENT HAS SEGFIELD <userid>.EXPORT.<application name>.SEGHFLDF

Col 1: SEGMENT Key
Col 2: SEGFIELD Key

SEGMENT IN DBD <userid>.EXPORT.<application
Col 1: SEGMENT Key
Col 2: DBD Key

name>.SEGINDBD

SEGMENT IN SEGMENT <userid>.EXPORT.<application
Col 1: SEGMENT Key
Col 2: SEGMENT Key

name>.SEGINSEG

SEGMENT USEDBY PROGRAM  <userid>.EXPORT.<application
Col 1: SEGMENT Key
Col 2: PROGRAM Key

name>.SEGUBPGM

SEGMENT USES SEGMENT <userid>.EXPORT.<application
Col 1: SEGMENT Key
Col 2: SEGMENT Key

name>.SEGHSEGF

SENFIELD IN SENSEG <userid>.EXPORT.<application
Col 1: SENFIELD Key
Col 2: SENSEG Key

name>.SENFISEN

SENSEG HAS SENFIELD <userid>.EXPORT.<application
Col 1: SENSEG Key
Col 2: SENFIELD Key

name>.SSGHSFDF

SENSEG IN PCB <userid>EXPORT.<application
Col 1: SENSEG Key
Col 2: PCB Key

name>.SSEGIPCB
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SENSEG IN SENSEG <userid>EXPORT.<application
Col 1: SENSEG Key
Col 2: SENSEG Key

name>.SENINSEN

SENSEG USES SENSEG <userid>EXPORT.<application
Col 1: SENSEG Key
Col 2: SENSEG Key

name>.SSGHSSGF

SQL IN PROGRAM <userid>EXPORT.<application
Col 1: SQL Entity Key
Col 2: PROGRAM Key

name>.SQLINPGM

STEP EXECUTES LOADMODULE <userid>.EXPORT.<application
Col 1: STEP Key
Col 2: LOADMODULE Key

name>.STEPELMF

STEP EXECUTES PROC <userid>EXPORT.<application
Col 1: STEP Key
Col 2: PROC Key

name>.STPEXPRC

STEP HAS DD <userid>EXPORT.<application name>.STPHDDF
Col 1: STEP Key
Col 2: DD Key

STEP IN JOB <userid>EXPORT.<application name>.STEPIJOB

Col 1: STEP Key
Col 2: JOB Key

STEP IN PROC <userid>EXPORT.<application
Col 1: STEP Key
Col 2: PROC Key

name>.STINPROC

STEP USES CATALOG <userid>EXPORT.<application
Col 1: STEP Key
Col 2: CATALOG Key

name>.STPUSCAT

STEP USES LIBRARY <userid>.EXPORT.<application
Col 1: STEP Key
Col 2: LIBRARY Key

name>.STPUSLIB

STOGROUP HAS DATABASE <userid>EXPORT.<application
Col 1: STOGROUP Key
Col 2: DATABASE Key

name>.STGHDBF
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Relationship Type Filename

STOGROUP IN PROGRAM <userid>EXPORT.<application
Col 1: STOGROUP Key
Col 2: PROGRAM Key

name>.STGINPGM

SUBSCHEMA HAS AREA <userid> EXPORT.<application name>SSCMHARA

Col 1: SUBSCHEMA Key
Col 2: AREA Key

SUBSCHEMA HAS <userid>EXPORT.<application
LOGICALRECORD Col 1: SUBSCHEMA Key
Col 2: LOGICALRECORD Key

name>.SSCMHLRF

SUBSCHEMA IN PROGRAM <userid>.EXPORT.<application
Col 1: SUBSCHEMA Key
Col 2: PROGRAM Key

name>.SSCMINPG

SUBSCHEMA IN SCHEMA <userid>.EXPORT.<application
Col 1: SUBSCHEMA Key
Col 2: SCHEMA Key

name>.SUBSISCM

TABLE HAS COLUMN <userid>EXPORT.<application
Col 1: TABLE Key
Col 2: COLUMN Key

name>TBHCOLF

TABLE IN PROGRAM <userid>.EXPORT.<application
Col 1: TABLE Key
Col 2: PROGRAM Key

name>TBLINPGM

TABLE IN TABLESPACE <userid>.EXPORT.<application
Col 1: TABLE Key
Col 2: TABLESPACE Key

name>TABINTSF

TABLESPACE HAS TABLE <userid>.EXPORT.<application
Col 1: TABLESPACE Key
Col 2: TABLE Key

name>TBLSPHTB

TABLESPACE HAS VIEW <userid>EXPORT.<application
Col 1: TABLESPACE Key
Col 2: VIEW Key

name>TBLSPHVW

TABLESPACE IN DATABASE <userid>.EXPORT.<application
Col 1: TABLESPACE Key
Col 2: DATABASE Key

name>.TSINDBF

233



ASG-Alliance User’s Guide

Relationship Type Filename

TABLESPACE IN PROGRAM <userid>EXPORT.<application name>.TBSINPGM
Col 1: TABLESPACE Key
Col 2: PROGRAM Key

VIEW HAS COLUMN <userid>EXPORT.<application name>VWHCOLF
Col 1: VIEW Key
Col 2: COLUMN Key

VIEW IN PROGRAM <userid>EXPORT.<application name>VWINPGMF
Col 1: VIEW Key
Col 2: PROGRAM Key

VIEW IN TABLESPACE <userid>EXPORT.<application name>VIEWINTS
Col 1: VIEW Key
Col 2: TABLESPACE Key

Defining and Loading DB2 Databases

The Export facility provides for loading output sequential files, created from the unload
job, to a DB2 database.

To define and load a DB2 database
1 Use the JCL VIABXDFI to define the database.

2 To load the sequential files from the unload step (in the AKR export job), use the
JCL VIABXLD/J.

234



DB2 Database Description

Entity Tables

Appendix E - Export Language Reference

Table Name Contents

ASG.AREA Col 1: Area Key Char(8)
Col 2: Area Name Char(8)
Primary Key: Area Key

ASG.CATALOG Col 1: Catalog_Key Char(8)
Col 2: Catalog Name Char(44)
Primary Key: Catalog_Key

ASG.CICSTXN (CICS Trans) Col I: CICSTXN_Key Char(8)
Col 2: CICSTXN_ Name Char(8)
Primary Key: CICSTXN_Key

ASG.COLUMN Col 1: Column_Key Char(8)
Col 2: Column_Name Char(30)
Primary Key: Column_Key

ASG.COPYMEMBER Col 1: Copymember_ Key Char(8)
Col 2: Copymember Name Char(10)
Primary Key: Copymember_Key

ASG.CSD Col 1: CSD_Key Char(8)
Col 2: CSD_Name Char(44)
Primary Key: CSD_Key

ASG.CSECT Col 1: CSECT_Key Char(8)
Col 2: CSECT Name Char(8)
Primary Key: CSECT Key
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Table Name Contents

ASG.CURSOR Col 1: Cursor_Key Char(8)
Col 2: Cursor Name Char(30)
Primary Key: Cursor_Key

ASG.DATABASE Col 1: Database Key Char(8)
Col 2: Database Name Char(44)
Primary Key: Database Key

ASG.DATAITEM Col 1: Data Key Char(8)

Not Null
Col 2: Data Name Char(50)
Not Null

Col 3: Data Level Char(2)
Col 4: Data Parent Char(8)
Col 5: Data_Child Char(8)
Col 6: Data Next Sibling Char(8)
Col 7: Data Prev_Sibling Char(8)
Col 8: Data_Picture Char(20)
Col 9: Data Usage Char(10)
Col 10: Data_Occurs Char(8)
Col 11: Data_Redefine Char(8)
Col 12: Data_Rename From Char(8)
Col 13: Data Rename Thru Char(8)
Col 14: Data_Size Char(8)
Col 15: Data_Offset Char(8)
Col 16: Data_Position Char(8)
Col 17: Data Value Char(40)
Col 18: Data_Use Char(8)
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Table Name Contents

Col 19: Data_Mod Char(8)
Col 20: Data_Ref Char(8)
Col 21: Data Cond Char(8)
Col 22: Data_Arith Char(8)
Col 23: Data_Create Char(1)
Col 24: Data Read Char(1)
Col 25: Data_Update Char(1)
Col 26: Data_Delete Char(1)
Primary Key: Data Key

ASG.DBD Col 1: DBD Key Char(8)
Col 2: DBD Name Char(8)
Primary Key: DBD Key

ASG.DD Col 1: DD Key Char(8)
Col 2: DD Name Char(8)
Primary Key: DD Key

ASG.DSN Col 1: DSN Key Char(8)
Col 2: DSN Name Char(44)
Primary Key: DSN_Key

ASG.ENTRY Col 1: Entry Key Char(8)
Col 2: Entry Name Char(10)
Primary Key: Entry key

ASG.FCT Col 1: FCT Key Char(8)
Col 2: FCT_Name Char(8)
Primary Key: FCT Key
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Table Name Contents

ASG.FCTCSD Col 1: FCTCSD_Key Char(8)
Col 2: FCTCSD_ Name Char(44)
Primary Key: FCTCSD_Key

ASG.FD Col 1: FD Key Char(8)
Col 2: FD Name Char(30)
Primary Key: FD Key

ASG.FORMAT Col 1: Format_Key Char(8)
Col 2: Format Name Char(8)
Primary Key: Format Key

ASG.IDMS Col 1: IDMS Key Char(8)
Col 2: IDMS_Name Char(36)
Primary Key: IDMS Key

ASG.IDMSMAP Col 1: IDMSMAP Key Char(8)
Col 2: IDMSMAP_Name Char(8)
Primary Key: IDMSMAP_Key Char(8)

ASG.IDMSRECORD Col 1: IDMSRECORD_Key Char(30)
Col 2: IDMSRECORD Name
Primary Key: IDMSRECORD_Key

ASG.IMSDYNALLOCMACRO Col 1: IMSALCMAC Key Char(8)
Col 2: IMSALCMAC Name Char(8)
Primary Key: IMSALCMAC Key

ASG.IMSTXN (IMS Transaction) Col 1: IMSTXN Key Char(8)
Col 2: IMSTXN Name Char(8)
Primary Key: IMSTXN Key
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ASG.JOB Col 1: Job_Key Char(8)
Col 2: Job_Name Char(8)
Primary Key: Job_Key

ASG.LIBRARY Col 1: Library Key Char(8)
Col 2: Library Name Char(44)
Primary Key: Library Key

ASG.LOADMODULE Col 1: LoadModule Key Char(8)
Col 2: LoadModule Name Char(8)
Primary Key: LoadModule Key

ASG.LOGICAL RECORD Col I: LOGICALRECORD Key  Char(8)
Col 2: LOGICALRECORD Name Char(30)
Primary Key: LOGICALRECORD Key

ASG.MAP Col 1: Map Key Char(8)
Col 2: Map_ Name Char(8)
Primary Key: Map Key

ASG.MAPFIELD Col 1: Mapfield Key Char(8)
Col 2: Mapfield Name Char(30)
Primary Key: Mapfield Key

ASG.MAPSET Col 1: Mapset_Key Char(8)
Col 2: Mapset Name Char(8)
Primary Key: Mapset Key

ASG.MEMBER Col 1: Member Key Char(8)
Col 2: Member Name Char(10)
Primary Key: Member Key
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Table Name Contents

ASG.PCB Col 1: PCB_Key Char(8)
Col 2: PCB_Name Char(8)
Primary Key: PCB_Key

ASG.PCT Col 1: PCT Key Char(8)
Col 2: PCT Name Char(8)
Primary Key: PCT Key

ASG.PPT Col 1: PPT Key Char(8)
Col 2: PPT Name Char(8)
Primary Key: PPT Key

ASG.PROC Col 1: Proc_Key Char(8)
Col 2: Proc_Name Char(8)
Primary Key: Proc Key

ASG.PROGRAM Col 1: Program Key Char (8)
Col 2: Program Name Char(8)
Primary Key: Program_Key

ASG.PSB Col 1: PSB_Key Char(8)
Col 2: PSB_Name Char(8)
Primary Key: PSB Key

ASG.RECORD Col 1: Rec _Key Char(8)
Col 2: Rec Name Char(30)
Primary Key: Rec Key

ASG.SCHEMA Col 1: Schema_Key Char(8)
Col 2: Schema Name Char(8)
Primary Key: Schema Key
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ASG.SEGFIELD Col 1: SEGFIELD Key Char(8)
Col 2: SEGFIELD Name Char(30)
Primary Key: SEGFIELD Key

ASG.SEGMENT Col 1: Segment Key Char(8)
Col 2: Segment Name Char(30)
Primary Key: Segment Key

ASG.SENFIELD Col 1: SENFIELD Key Char(8)
Col 2: SENFIELD Name Char(30)
Primary Key: SENFIELD Key

ASG.SENSEG Col 1: SENSEG_Key Char(8)
Col 2: SENSEG Name Char(30)
Primary Key: SENSEG Key

ASG.SQL Col 1: SQL_Key Char(8)
Col 2: SQL_Name Char(30)
Primary Key: SQL Key

ASG.STEP Col 1: Step Key Char(8)
Col 2: Step_Name Char(8)
Primary Key: Step_Key

ASG.STOGROUP (Storage Group) Col 1: STOGROUP_Key Char(8)
Col 2: STOGROUP_Name Char(8)
Primary Key: STOGROUP_Key

ASG.SUBSCHEMA Col 1: Subschema_Key Char(8)
Col 2: Subschema_Name Char(8)
Primary Key: Subschema Key
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ASG.TABLE Col 1: Table Key Char(8)
Col 2: Table Name Char(30)
Primary Key: Table Key

ASG.TABLESPACE Col 1: TableSpace Key Char(8)
Col 2: TableSpace Name Char(8)
Primary Key: TableSpace Key

ASG.VIEW Col 1: View_Key Char(8)
Col 2: View_ Name Char(30)
Primary Key: View_ Key

Relationship Tables

Table name Contents

ASG.AREA HAS RECORDS Col 1: AREA Key Char(8)
Col 2: RECORDS Key Char(8)
Primary Key: (AREA Key, RECORDS Key)
Foreign Key: AREAKEY (AREA Key)
References: ~ ASG.AREA
Foreign Key: RECRDKEY (RECORDS Key)
References: ~ ASG.RECORD

ASG.AREAS IN PGM Col 1: AREA Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (AREA Key, PGM_Key)
Foreign Key: AREAKEY (AREA Key)
References: ~ ASG.AREA
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Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM

ASG.AREAS IN_ SUBSCHEMA Col 1: AREAS Key Char(8)
Col 2: SUBSCHEMA Key Char(8)
Primary Key: (AREAS Key, SUBSCHEMA Key)
Foreign Key: AREASKEY (AREAS Key)
References: ~ ASG.AREA

Foreign Key: SUBSCKEY
(SUBSCHEMA_Key)

References: ASG.SUBSCHEMA

ASG.CATALOG_USDBY JOB Col 1: CATALOG Key Char(8)
Col 2: JOB_Key Char(8)
Primary Key: (CATALOG Key, JOB Key)
Foreign Key: CATKEY (CATALOG Key)
References: ASG.CATALOG
Foreign Key: JOBKEY (JOB Key)

References: ASG.JOB

ASG.CATALOG USDBY_STP Col 1: CATALOG Key Char(8)
Col 2: STEP Key Char(8)
Primary Key: (CATALOG Key, STEP Key)
Foreign Key: CATKEY (CATALOG Key)
References: ASG.CATALOG
Foreign Key: STEPKEY (STEP_ Key)

References: ASG.STEP
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Table name Contents

ASG.CICS HAS DD Col 1: CICS Key Char(8)
Col 2: DD Key Char(8)
Primary Key: (CICS Key, DD Key)
Foreign Key: CICSKEY (CICS Key)
References: ASG.FCTCSD
Foreign Key: DDKEY (DD Key)
References: ~ ASG.DD
ASG.CICSDD_USDBY_PGM Col 1: CICSDD_Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (CICSDD_Key, PGM_Key)
Foreign Key: CIDDKEY (CICSDD_ Key)
References: ~ ASG.DD
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
ASG.CICSTRANS_EXEC PGM Col 1: CICSTRANS Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (CICSTRANS Key, PGM_Key)
Foreign Key: CITXNKEY (CICSTRANS Key)
References: ~ ASG.CICSTXN
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
ASG.CICSTRANS_IN_CSD Col I: CICSTRANS Key Char(8)
Col 2: CSD_Key Char(8)
Primary Key: (CICSTRANS Key, CSD Key)
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Foreign Key: CTXNKEY (CICSTRANS Key)
References: ASG.CICSTXN
Foreign Key: PSDKEY (CSD Key)

References: ASG.CSD

ASG.CICSTRANS_IN_PCT Col 1: CICSTRANS Key Char(8)
Col 2: PCT Key Char(8)
Primary Key: (CICSTRANS Key, PCT Key)
Foreign Key: CTXNKEY (CICSTRANS Key)
References:  ASG.CICSTXN
Foreign Key: PCTKEY (PCT_Key)

References: ASG.PCT

ASG.COLUMNS_IN_PGM Col 1: COLUMN_Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (COLUMN_Key, PGM_Key)
Foreign Key: COLKEY (COLUMN _Key)
References: ~ ASG.COLUMN
Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM

ASG.COLUMNS IN TABLE Col 1: COLUMNS_Key Char(8)
Col 2: TABLE Key Char(8)
Primary Key: (COLUMNS Key, TABLE Key)
Foreign Key: COLUMKEY (COLUMNS Key)

References: ASG.COLUMN
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Foreign Key: TABLEKEY (TABLE Key)
References: ASG.TABLE
ASG.COLUMNS IN VIEW Col 1: COLUMNS Key Char(8)
Col 2: VIEW Key Char(8)
Primary Key: (COLUMNS Key, VIEW Key)
Foreign Key: COLUMKEY (COLUMNS Key)
References: ~ ASG.COLUMN
Foreign Key: VIEWKEY (VIEW_Key)
References: ~ ASG.VIEW
ASG.COPY_INCLIN MEMBER Col 1: COPY Key Char(8)
Col 2: MEMBER Key Char(8)
Primary Key: (COPY_Key, MEMBER Key)
Foreign Key: COPYKEY COPY_Key)
References: ASG.COPYMEMBER
Foreign Key: MEMBRKEY (MEMBER Key)
References: ~ ASG.MEMBER
ASG.COPY_INCLIN_PGM Col 1: COPY_Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (COPY_Key, PGM_Key)
Foreign Key: COPYKEY (COPY_Key)
References: ASG.COPYMEMBER
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
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ASG.COPYMB_INCLIN_COPYMB  Col 1: COPYMBR Key Char(8)
Col 2: COPYMBR2 Key Char(8)
Primary Key: (COPYMBR Key,
COPYMBR2 Key)
Foreign Key: CPMBKEY (COPYMBR Key)
References: ASG.COPYMEMBER
Foreign Key: CPMB2KEY (COPYMBR2 Key)
References: ASG.COPYMEMBER
ASG.COPYMB_USES COPYMB Col 1: COPYMBR Key Char(8)
Col 2: COPYMBR2 Key Char(8)
Primary Key: (COPYMBR Key,
COPYMBR2 Key)
Foreign Key: CPMBKEY (COPYMBR Key)
References: ASG.COPYMEMBER
Foreign Key: CPMB2KEY (COPYMBR2 Key)
References: ASG.COPYMEMBER
ASG.CSD_HAS_CICSTRANS Col 1: CSD_Key Char(8)
Col 2: CICSTRANS Key Char(8)
Primary Key: (CSD_Key, CICSTRANS Key)
Foreign Key: CSDKEY (CSD_Key)
References: ~ ASG.CSD
Foreign Key: CTXNKEY (CICSTRANS Key)
References: ~ ASG.CICSTXN
ASG.CSD_HAS DD Col 1: CSD_Key Char(8)
Col 2: DD Key Char(8)
Primary Key: (CSD_Key, DD Key)
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Foreign Key: CSDKEY (CSD_Key)

References: ASG.CSD

Foreign Key: DDKEY (DD Key)

References: ASG.DD
ASG.CSECT_IN_LM Col 1: CSECT _Key Char(8)

Col 2: LM Key Char(8)

Primary Key: (CSECT_Key, LM _Key)

Foreign Key: CSECTKEY (CSECT Key)

References: ~ ASG.CSECT

Foreign Key: LMKEY (LM_Key)

References: ~ ASG.LOADMODULE
ASG.CSECT_IS_PGM Col 1: CSECT_Key Char(8)

Col 2: PGM_Key Char(8)

Primary Key: (CSECT_Key, PGM_Key)

Foreign Key: CSECTKEY (CSECT _Key)

References: ~ ASG.CSECT

Foreign Key: PGMKEY (PGM_Key)

References: ~ ASG.PROGRAM
ASG.CURSOR_IN_DATABASE Col 1: CURSOR_Key Char(8)

Col 2: DATABASE Key Char(8)

Primary Key: (CURSOR Key, DATABASE Key)

Foreign Key: CURSRKEY (CURSOR_Key)

References: ~ ASG.CURSOR
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Foreign Key: DBASEKEY (DATABASE Key)
References: ASG.DATABASE
ASG.CURSOR_IN PGM Col 1: CURSOR_Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (CURSOR Key,PGM_Key)
Foreign Key: CURSRKEY(CURSOR Key)
References: ~ ASG.CURSOR
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
ASG.DATA DEFIN INCL Col 1: DATA Key Char(8)
Col 2: INCL Key Char(8)
Primary Key: (DATA Key, INCL Key)
Foreign Key: DATAKEY (INCL Key)
References: ~ ASG.DATAITEM
Foreign Key: INCLKEY (INCL_Key)
References: ASG.COPYMEMBER
ASG.DATA DEFIN PGM Col 1: DATA Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (DATA Key, PGM Key)
Foreign Key: DATAKEY (DATA Key)
References: ~ ASG.DATAITEM
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
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ASG.DATA HAS HOMONYM Col 1: DATA Key Char(8)
Col 2: HOMONYM_Key Char(8)
Primary Key: (DATA Key, HOMONYM Key)
Foreign Key: DATAKEY (DATA Key)
References: ASG.DATAITEM
Foreign Key: HOMKEY (HOMONYM_ Key)
References: ~ ASG.DATAITEM

ASG.DATA HAS SYNONYM Col 1: DATA Key Char(8)
Col 2: SYNONYM Key Char(8)
Primary Key: (DATA_ Key, SYNONYM Key)
Foreign Key: DATAKEY (DATA Key)
References: ~ ASG.DATAITEM
Foreign Key: SYNKEY (SYNONYM _Key)
References: ~ ASG.DATAITEM

ASG.DATA IN RECORD Col 1: DATA Key Char(8)
Col 2: RECORD_Key Char(8)
Primary Key: (DATA_ Key, RECORD Key)
Foreign Key: DATAKEY (DATA Key)
References: ~ ASG.DATAITEM
Foreign Key: RECKEY (RECORD Key)
References: ~ ASG.RECORD

ASG.DATABASE HAS CRSR Col 1: DATABASE Key Char(8)
Col 2: CURSOR_Key Char(8)
Primary Key: (DATABASE Key, CURSOR Key)
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Foreign Key: DBASEKEY (DATABASE Key)
References: ASG.DATABASE
Foreign Key: CURSRKEY (CURSOR_Key)
References: ASG.CURSOR
ASG.DATABASE HAS TBLSP Col 1: DATABASE Key Char(8)
Col 2: TBLSP_Key Char(8)
Primary Key: (DATABASE Key, TBLSP Key)
Foreign Key: DBASEKEY (DATABASE Key)
References: ~ ASG.DATABASE
Foreign Key: TBLSPKEY (TBLSP_Key)
References: ASG.TABLESPACE
ASG.DATABASE IN PGM Col 1: DATABASE Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (DATABASE Key, PGM Key)
Foreign Key: DBKEY (DATABASE Key)
References: ~ ASG.DATABASE
Foreign Key: PGMPKEY (PGM_Key)
References ASG.PROGRAM
ASG.DATABASE IN STOGRP Col I: DATABASE Key Char(8)
Col 2: STOGRP_Key Char(8)
Primary Key: (DATABASE Key,STOGRP_Key)
Foreign Key: DBASEKEY (DATABASE Key)
References: ~ ASG.DATABASE
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Foreign Key: STOGPKEY (STOGRP_ Key)
References ASG.STOGROUP
ASG.DBD_HAS DD Col 1: DBD Key Char(8)
Col 2: DD Key Char(8)
Primary Key: (DBD_Key, DD Key)
Foreign Key: DBDKEY (DBD Key)
References: ~ ASG.DBD
Foreign Key: DDKEY (DD Key)
References: ~ ASG.DD
ASG.DBD HAS SEGMENT Col 1: DBD Key Char(8)
Col 2: SEGMENT Key Char(8)
Primary Key: (DBD_Key, SEGMENT Key)
Foreign Key: DBDKEY (DBD_ Key)
References: ~ ASG.DBD
Foreign Key: SEGMTKEY (SEGMENT Key)
References: ~ ASG.SEGMENT
ASG.DBD IN MBR Col 1: DBD Key Char(8)
Col 2: MBR Key Char(8)
Primary Key: (DBD_Key, MBR Key)
Foreign Key: DBDKEY (DBD Key)
References: ~ ASG.DBD
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
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ASG.DBD _IN PCB Col 1: DBD_Key Char(8)
Col 2: PCB_Key Char(8)
Primary Key: (DBD_Key, PCB Key)
Foreign Key: DBDKEY (DBD_Key)
References: ASG.DBD
Foreign Key: PCBKEY (PCB_Key)
References: ~ ASG.PCB

ASG.DD_HAS DSN Col 1: DD Key Char(8)
Col 2: DSN_Key Char(8)
Primary Key: (DD_Key, DSN_Key)
Foreign Key: DDKEY (DD Key)
References: ~ ASG.DD
Foreign Key: DSNKEY (DSN_Key)
References: ~ ASG.DSN

ASG.DD_IN_CICS Col I: DD Key Char(8)
Col 2: CICS Key Char(8)
Primary Key: (DD_Key, CICS Key)
Foreign Key: DDKEY (DD Key)
References:  ASG.DD
Foreign Key: CICSKEY (CICS Key)
References: ~ ASG.CICSTXN

ASG.DD _IN_CSD Col 1: DD Key Char(8)
Col 2: CSD_Key Char(8)
Primary Key: (DD_Key, CSD_Key)
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Foreign Key: DDKEY (DD Key)
References: ASG.DD
Foreign Key: CSDKEY (CSD_Key)
References: ASG.CSD
ASG.DD IN DBD Col 1: DD Key Char(8)
Col 2: DBD_Key Char(8)
Primary Key: (DD_Key, DBD Key)
Foreign Key: DDKEY (DD_Key)
References: ~ ASG.DD
Foreign Key: DBDKEY (DBD_Key)
References: ~ ASG.DBD
ASG.DD_IN FCT Col 1: DD Key Char(8)
Col 2: FCT Key Char(8)
Primary Key: (DD _Key, FCT Key)
Foreign Key: DDKEY (DD_Key)
References: ~ ASG.DD
Foreign Key: FCTKEY (FCT_Key)
References: ~ ASG.FCT
ASG.DD _IN STEP Col 1: DD Key Char(8)
Col 2: STEP Key Char(8)
Primary Key: (DD_Key, STEP Key)
Foreign Key: DDKEY (DD_Key)
References: ~ ASG.DD
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Foreign Key: STEPKEY (STEP_Key)
References: ASG.STEP
ASG.DD_SELECTEDBY_FD Col 1: DD_Key Char(8)
Col 2: FD Key Char(8)
Primary Key: (DD_Key, FD Key)
Foreign Key: DDKEY (DD Key)
References: ~ ASG.DD
Foreign Key: FDKEY (FD Key)
References: ~ ASG.FD
ASG.DI_ REF MAPFIELD Col 1: DATA Key Char(8)
Col 2: MAPFIELD Key Char(8)
Primary Key: (DATA Key, MAPFIELD Key)
Foreign Key: DIKEY (DATA Key)
References: ~ ASG.DATAITEM
Foreign Key: MPFKEY (MAPFIELD Key)
References: ~ ASG.MAPFIELD
ASG.DSN_HAS MEMBER Col 1: DSN Key Char(8)
Col 2: MBR_Key Char(8)
Primary Key: (DSN_Key, MBR_Key)
Foreign Key: DSNKEY (DSN_Key)
References: ~ ASG.DSN
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
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ASG.DSN_IN DD Col 1: DSN_Key Char(8)
Col 2: DD Key Char(8)
Primary Key: (DSN_Key, DD Key)
Foreign Key: DSNKEY (DSN_Key)
References: ASG.DSN
Foreign Key: DDKEY (DD Key)
References: ~ ASG.DD

ASG.ENTRY_ CALLEDBY PGM Col 1: ENTRY Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (ENTRY_ Key, PGM_Key)
Foreign Key: ENTRYKEY (ENTRY Key)
References: ~ ASG.ENTRY
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM

ASG.ENTRY _IN_ PGM Col 1: ENTRY Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (ENTRY_ Key, PGM_Key)
Foreign Key: ENTRYKEY (ENTRY Key)
References: ~ ASG.ENTRY
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM

ASG.FCT HAS DD Col 1: FCT_Key Char(8)
Col 2: DD Key Char(8)
Primary Key: (FCT Key, DD Key)
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Foreign Key: FCTKEY (FCT_Key)
References: ASG.FCT
Foreign Key: DDKEY (DD Key)

References: ASG.DD

ASG.FCT _IN_MBR Col 1: FCT Key Char(8)
Col 2: MBR_Key Char(8)
Primary Key: (FCT_Key, MBR_Key)
Foreign Key: FCTKEY (FCT_Key)
References: ~ ASG.FCT
Foreign Key: MBRKEY (MBR Key)

References: ASG.MEMBER

ASG.FD IN PGM Col 1: FD Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (FD_Key, PGM_Key)
Foreign Key: FDKEY (FD_Key)
References: ~ ASG.FD
Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM

ASG.FD_SELECTS DD Col 1: FD Key Char(8)
Col 2: DD Key Char(8)
Primary Key: (FD_Key, DD _Key)
Foreign Key: FDKEY (FD Key)

References: ASG.FD
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Foreign Key: DDKEY (DD Key)
References: ASG.DD
ASG.FD_USES RECORD Col 1: FD Key Char(8)
Col 2: REC_Key Char(8)
Primary Key: (FD_Key, REC Key)
Foreign Key: FDKEY (FD Key)
References: ~ ASG.FD
Foreign Key: RECKEY (REC Key)
References: ~ ASG.RECORD
ASG.FIELD IN SEGMENT Col 1: FIELD Key Char(8)
Col 2: SEGMENT Key Char(8)
Primary Key: (FIELD Key, SEGMENT Key)
Foreign Key: FIELDKEY (FIELD Key)
References: ~ ASG.SEGFIELD
Foreign Key: SEGMTKEY (SEGMENT Key)
References: ~ ASG.SEGMENT
ASG.FMT _EXECBY PGM Col 1: FMT Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (FMT Key, PGM Key)
Foreign Key: FMTKEY (FMT Key)
References: ~ ASG.FORMAT
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
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ASG.FORMAT EXBY FORMAT Col 1: FORMAT Key Char(8)
Col 2: FORMAT2 Key Char(8)
Primary Key: (FORMAT Key, FORMAT2 Key)
Foreign Key: FORMTKEY (FORMAT Key)
References: ASG.FORMAT
Foreign Key: FORMAT2KEY (FORMAT2 Key)

References: ASG.FORMAT

ASG.FORMAT EXEC IMSTXN Col 1: FORMAT Key Char(8)
Col 2: IMSTRANS Key Char(8)
Primary Key: (FORMAT Key, IMSTRANS Key)
Foreign Key: FRMTKEY FORMAT Key)
References: ~ ASG.FORMAT
Foreign Key: IMTXNKEY (IMSTRANS Key)

References: ASG.IMSTXN

ASG.FORMAT IN MBR Col 1: FORMAT Key Char(8)
Col 2: MBR Key Char(8)
Primary Key: (FORMAT Key, MBR Key)
Foreign Key: FMTKEY (FORMAT Key)
References: ~ ASG.FORMAT
Foreign Key: MBRKEY (MBR Key)

References: ASG.MEMBER

ASG.IDMS_IN PGM Col 1: IDMS_Key Char(8)
Col 2: PGM_Key Char(8)

Primary Key: (IDMS_Key, PGM_Key)
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Foreign Key: IDMSKEY (IDMS Key)
References: ASG.IDMS
Foreign Key: FDKEY (PGM_Key)
References: ASG.PROGRAM

ASG.IDMSMAP_IN PGM Col 1: IDMSMAP_Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (IDMSMAP Key, PGM Key)
Foreign Key: IMAPKEY (IDMSMAP Key)
References: ~ ASG.IDMSMAP
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM

ASG.IDMSREC IN PGM Col 1: IDMSRECORD Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (IDMSRECORD Key, PGM_Key)
Foreign Key: IRECKEY (IDMSRECORD_ Key)
References: ~ ASG.IDMSRECORD
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM

ASG.IMSTRANS EXEC LOAD Col 1: IMSTRANS Key Char(8)
Col 2: LOAD Key Char(8)
Primary Key: (IMSTRANS Key, LOAD Key)
Foreign Key: IMTXNKEY (IMSTRANS Key)
References: ~ ASG.IMSTXN
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Foreign Key: LOADKEY (LOAD Key)
References: ASG.LOADMODULE
ASG.IMSTXN_EXBY FORMAT Col 1: IMSTRANS Key Char(8)
Col 2: FORMAT Key Char(8)
Primary Key: (IMSTRANS Key, FORMAT Key)
Foreign Key: IMTXNKEY (IMSTRANS Key)
References: ~ ASG.IMSTXN
Foreign Key: FORMTKEY (FORMAT Key)
References: ~ ASG.FORMAT
ASG.IMSTXN EXECBY PGM Col 1: IMSTRANS Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (IMSTRANS Key, PGM_Key)
Foreign Key: IMTXNKEY (IMSTRANS Key)
References: ~ ASG.IMSTXN
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
ASG.INCL HAS DATA Col 1: INCL Key Char(8)
Col 2: DATA Key Char(8)
Primary Key: (INCL Key,DATA Key)
Foreign Key: INCLKEY (INCL_Key)
References: ASG.COPYMEMBER
Foreign Key: DATAKEY (DATA Key)
References: ~ ASG.DATAITEM
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ASG.JOB_HAS STEP Col 1: JOB_Key Char(8)
Col 2: STEP Key Char(8)
Primary Key: (JOB_Key, STEP Key)
Foreign Key: JOBKEY (JOB Key)
References: ASG.JOB
Foreign Key: STEPKEY (STEP_Key)
References: ~ ASG.JOB
ASG.JOB_IN MBR Col 1: JOB_Key Char(8)
Col 2: MBR_Key Char(8)
Primary Key: (JOB_Key, MBR Key)
Foreign Key: JOBKEY (JOB_Key)
References: ~ ASG.JOB
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
ASG.JOB_USES_CATALOG Col 1: JOB_Key Char(8)
Col 2: CATALOG Key Char(8)
Primary Key: (JOB_Key, CATALOG Key)
Foreign Key: JOBKEY (JOB Key)
References:  ASG.JOB
Foreign Key: CATKEY (CATALOG_Key)
References:  ASG.CATALOG
ASG.JOB_USES_LIBRARY Col 1: JOB_Key Char(8)
Col 2: LIBRARY Key Char(8)
Primary Key: (JOB Key, LIBRARY Key)
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Foreign Key: JOBKEY (JOB Key)
References: ASG.JOB
Foreign Key: LIBKEY (LIBRARY Key)
References: ASG.LIBRARY
ASG.LIBRARY HAS MBR Col 1: LIBRARY Key Char(8)
Col 2: MBR_Key Char(8)
Primary Key: (LIBRARY Key, MBR Key)
Foreign Key: LIBKEY (LIBRARY Key)
References: ~ ASG.LIBRARY
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
ASG.LIBRARY USDBY JOB Col 1: LIBRARY Key Char(8)
Col 2: JOB_Key Char(8)
Primary Key: (LIBRARY Key, JOB Key)
Foreign Key: LIBKEY (LIBRARY Key)
References: ~ ASG.LIBRARY
Foreign Key: JOBKEY (JOB_Key)
References:  ASG.JOB
ASG.LIBRARY USDBY STP Col 1: LIBRARY Key Char(8)
Col 2: STEP Key Char(8)
Primary Key: (LIBRARY Key, STEP Key)
Foreign Key: LIBKEY (LIBRARY Key)
References: ~ ASG.LIBRARY
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Foreign Key: STEPKEY (STEP_Key)
References: ASG.STEP
ASG.LM_EXECBY_STEP Col 1: LM Key Char(8)
Col 2: STEP Key Char(8)
Primary Key: (LM_Key, STEP Key)
Foreign Key: LMKEY (LM_Key)
References:  ASG.LOADMODULE
Foreign Key: STEPKEY (STEP_Key)
References: ~ ASG.STEP
ASG.LM_HAS CSECT Col 1: LM_Key Char(8)
Col 2: CSECT Key Char(8)
Primary Key: (LM _Key, CSECT Key)
Foreign Key: LMKEY (LM_Key)
References: ~ ASG.LOADMODULE
Foreign Key: CSECTKEY (CSECT Key)
References: ~ ASG.CSECT
ASG.LM_IN MBR Col 1: LM Key Char(8)
Col 2: MBR Key Char(8)
Primary Key: (LM _Key, MBR Key)
Foreign Key: LMKEY (LM Key)
References: ~ ASG.LOADMODULE
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
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ASG.LOAD EXECBY_IMSTXN Col 1: LOAD Key Char(8)
Col 2: IMSTXN_ Key Char(8)
Primary Key: (LOAD Key, IMSTXN Key)
Foreign Key: LOADKEY (LOAD Key)
References: ASG.LOADMODULE
Foreign Key: IMTXNKEY (IMSTXN Key)
References: ~ ASG.IMSTXN

ASG.LREC_HAS RECORDS Col 1: LREC Key Char(8)
Col 2: RECORDS Key Char(8)
Primary Key: (LREC Key, RECORDS Key)
Foreign Key: LRECKEY (LREC Key)
References: ASG.LOGICALRECORD
Foreign Key: RECRDKEY (RECORDS Key)
References: ~ ASG.RECORD

ASG.LREC _IN_PGM Col 1: LREC Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (LREC_Key, PGM_Key)
Foreign Key: LRECKEY (LREC Key)
References: ASG.LOGICALRECORD
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM

ASG.MAP HAS MAPFIELD Col 1: MAP Key Char(8)
Col 2: MAPFIELD Key Char(8)
Primary Key: (MAP_Key, MAPFIELD Key)
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Foreign Key: MAPKEY (MAP_ Key)
References: ASG.MAP
Foreign Key: MAPFDKEY (MAPFIELD Key)
References: ASG.MAPFIELD
ASG.MAP_HAS RECORDS Col 1: MAP Key Char(8)
Col 2: RECORDS Key Char(8)
Primary Key: (MAP_Key, RECORDS Key)
Foreign Key: MAPKEY (MAP_ Key)
References: ~ ASG.MAP
Foreign Key: RECRDKEY (RECORDS Key)
References: ~ ASG.RECORD
ASG.MAP IN MAPSET Col 1: MAP Key Char(8)
Col 2: MAPSET Key Char(8)
Primary Key: (MAP_Key, MAPSET Key)
Foreign Key: MAPKEY (MAP_ Key)
References: ~ ASG.MAP
Foreign Key: MAPSTKEY (MAPSET Key)
References: ~ ASG.MAPSET
ASG.MAP USDBY PGM Col 1: MAP Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (MAP Key, PGM_Key)
Foreign Key: MAPKEY (MAP Key)
References: ~ ASG.MAP
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Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.MAPFIELD IN MAP Col 1: MAPFIELD Key Char(8)
Col 2: MAP_ Key Char(8)
Primary Key: (MAPFIELD Key, MAP Key)
Foreign Key: MAPFDKEY (MAPFIELD Key)
References: ~ ASG.MAPFIELD
Foreign Key: MAPKEY (MAP_ Key)
References: ~ ASG.MAP
ASG.MAPFIELD REF DI Col 1: MAPFIELD Key Char(8)
Col 2: DATA Key Char(8)
Primary Key: (MAPFIELD Key, DATA Key)
Foreign Key: MPFKEY (MAPFIELD Key)
References: ~ ASG.MAPFIELD
Foreign Key: DIKEY (DATA Key)
References: ~ ASG.DATAITEM
ASG.MAPREC REFR RECORD Col 1: MAPREC Key Char(8)
Col 2: RECORD_ Key Char(8)
Primary Key: (MAPREC_Key, RECORDD Key)
Foreign Key: MAPRCKEY (MAPREC Key)
References: ~ ASG.MAP
Foreign Key: RECRDKEY (RECORD_Key)
References: ~ ASG.RECORD
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ASG.MAPSET HAS MAP Col 1: MAPSET Key Char(8)
Col 2: MAP_ Key Char(8)
Primary Key: (MAPSET Key, MAP Key)
Foreign Key: MAPSTKEY (MAPSET Key)
References: ASG.MAPSET
Foreign Key: MAPKEY (MAP Key)
References: ~ ASG.MAP

ASG.MAPSET IN MBR Col 1: MAPSET Key Char(8)
Col 2: MBR Key Char(8)
Primary Key: (MAPSET Key, MBR Key)
Foreign Key: MAPSTKEY (MAPSET Key)
References: ~ ASG.MAPSET
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER

ASG.MAPSET USDBY PGM Col 1: MAPSET Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (MAPSET Key, PGM_Key)
Foreign Key: MAPSTKEY (MAPSET Key)
References: ~ ASG.MAPSET
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM

ASG.MBR HAS DBD Col 1: MBR Key Char(8)
Col 2: DBD_Key Char(8)
Primary Key: (MBR_Key, DBD Key)
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Foreign Key: MBRKEY (MBR Key)
References: ASG.MEMBER
Foreign Key: DBDKEY (DBD_Key)

References: ASG.DBD

ASG.MBR_HAS FCT Col 1: MBR_Key Char(8)
Col 2: FCT Key Char(8)
Primary Key: (MBR_Key, FCT Key)
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
Foreign Key: FCTKEY (FCT_Key)

References: ASG.FCT

ASG.MBR HAS FORMAT Col 1: MBR Key Char(8)
Col 2: FORMAT Key Char(8)
Primary Key: (MBR_Key, FORMAT Key)
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
Foreign Key: FMTKEY (FORMAT Key)

References: ASG.FORMAT

ASG.MBR_HAS JOB Col 1: MBR Key Char(8)
Col 2: JOB_Key Char(8)
Primary Key: (MBR_Key, JOB Key)
Foreign Key: MBRKEY (MBR Key)

References: ASG.MEMBER
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Foreign Key: JOBKEY (JOB Key)
References: ASG.JOB
ASG.MBR HAS LM Col 1: MBR_Key Char(8)
Col 2: LM Key Char(8)
Primary Key: (MBR_Key, LM Key)
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
Foreign Key: LMKEY (LM_Key)
References: ~ ASG.LOADMODULE
ASG.MBR HAS MAPSET Col 1: MBR Key Char(8)
Col 2: MAPSET Key Char(8)
Primary Key: (MBR_Key, MAPSET Key)
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
Foreign Key: MAPSTKEY (MAPSET Key)
References: ~ ASG.MAPSET
ASG.MBR HAS MDADB Col 1: MBR Key Char(8)
Col 2: MDADB Key Char(8)
Primary Key: (MBR_Key, MDADB Key)
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
Foreign Key: MDADBKEY (MDADB Key)
References: ASG.IMSDYNALLOC-MACRO
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ASG.MBR_HAS PCT Col 1: MBR_Key Char(8)
Col 2: PCT Key Char(8)
Primary Key: (MBR_Key, PCT Key)
Foreign Key: MBRKEY (MBR Key)
References: ASG.MEMBER
Foreign Key: PCTKEY (PCT_Key)
References: ~ ASG.PCT

ASG.MBR HAS PGM Col 1: MBR Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (MBR_Key, PGM_Key)
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM

ASG.MBR HAS PPT Col 1: MBR_Key Char(8)
Col 2: PPT Key Char(8)
Primary Key: (MBR_Key, PPT Key)
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
Foreign Key: PPTKEY (PPT Key)
References: ~ ASG.PPT

ASG.MBR _HAS PROC Col 1: MBR Key Char(8)
Col 2: PROC Key Char(8)
Primary Key: (MBR_Key, PROC Key)
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Foreign Key: MBRKEY (MBR Key)
References: ASG.MEMBER
Foreign Key: PROCKEY (PROC Key)
References: ASG.PROC
ASG.MBR_HAS PSB Col 1: MBR_Key Char(8)
Col 2: PSB_Key Char(8)
Primary Key: (MBR_Key, PSB Key)
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
Foreign Key: PSBKEY (PSB_Key)
References: ~ ASG.PSB
ASG.MBR_IN DSN Col 1: MEMBER Key Char(8)
Col 2: DSN_Key Char(8)
Primary Key: (MBR_Key, LIBRARY Key)
Foreign Key: MEMBERKEY (DSN Key)
References: ~ ASG.MEMBER
Foreign Key: DSNKEY (DSN_Key)
References: ~ ASG.DSN
ASG.MBR_IN LIBRARY Col 1: MBR_ Key Char(8)
Col 2: LIBRARY Key Char(8)
Primary Key: (MBR_Key, LIBRARY Key)
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
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Foreign Key: LIBKEY (LIBRARY Key)
References: ASG.LIBRARY
ASG.MBR_INCLIN SOURCE Col 1: MBR_Key Char(8)
Col 2: SOURCE_Key Char(8)
Primary Key: (MBR_Key, SOURCE Key)
Foreign Key: MBRKEY (MBR Key)
References: ASG.COPYMEMBER
Foreign Key: SRCKEY (SOURCE Key)
References: ~ ASG.MEMBER
ASG.MBR IS COPYINCL Col 1: MBR Key Char(8)
Col 2: COPYINCL Key Char(8)
Primary Key: (MBR_Key, COPYINCL Key)
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
Foreign Key: CPYMBKEY (COPYINCL Key)
References: ASG.COPYMEMBER
ASG.MDA DBIN MBR Col 1: MDA Key Char(8)
Col 2: MBR Key Char(8)
Primary Key: (MDA Key, MBR Key)
Foreign Key: MDAKEY (MDA Key)
References: ASG.IMSDYNALLOC-MACRO
Foreign Key: KEY (MBR Key)
References: ~ ASG.MEMBER

273



ASG-Alliance User’s Guide

Table name Contents

ASG.MDA HAS DD Col 1: MDA _Key Char(8)
Col 2: DD Key Char(8)
Primary Key: (MDA Key, DD Key)
Foreign Key: MDAKEY (MDA Key)
References: ASG.IMSDYNALLOC-MACRO
Foreign Key: RECRDKEY (RECORDS Key)
References: ~ ASG.RECORD

ASG.PCB_HAS DBD Col 1: PCB_Key Char(8)
Col 2: DBD_Key Char(8)
Primary Key: (PCB_Key, DBD Key)
Foreign Key: PCBKEY (PCB_Key)
References:  ASG.PCB
Foreign Key: DBDKEY DBD Key)
References: ~ ASG.DBD

ASG.PCB_HAS SENSEG Col I: PCB_Key Char(8)
Col 2: SENSEG Key Char(8)
Primary Key: (PCB_Key, SENSEG Key)
Foreign Key: PCBKEY (PCB_Key)
References:  ASG.PCB
Foreign Key: SENSGKEY (SENSEG_Key)
References: ~ ASG.SENSEG

ASG.PCB_IN PSB Col 1: PCB_Key Char(8)
Col 2: PSB_Key Char(8)
Primary Key: (PCB_Key, PSB_Key)
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Foreign Key: PCBKEY (PCB_Key)
References: ASG.PCB
Foreign Key: PSBKEY (PSB Key)
References: ASG.PSB

ASG.PCT _HAS CICSTRANS Col 1: PCT Key Char(8)
Col 2: CICSTRANS Key Char(8)
Primary Key: (PCT_Key,CICSTRANS Key)
Foreign Key: PCTKEY (PCT_Key)
References:  ASG.PCT
Foreign Key: CTXNKEY (CICSTRANS Key)
References:  ASG.CICSTXN

ASG.PCT_IN_MBR Col 1: PCT Key Char(8)
Col 2: MBR_Key Char(8)
Primary Key: (PCT_Key, MBR_Key)
Foreign Key: PCTKEY (JOB_Key)
References:  ASG.PCT
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER

ASG.PGM_CALLS ENTRY Col I: PGM_Key Char(8)
Col 2: Entry Key Char(8)
Primary Key: (PGM_Key, Entry Key)
Foreign Key: PGMKEY (PGM_Key)
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References: ASG.PROGRAM
Foreign Key: ENTRYKEY (Entry Key)
References: ASG.ENTRY
ASG.PGM_EXEC FMT Col 1: PGM_Key Char(8)
Col 2: FMT Key Char(8)
Primary Key: (PGM _Key, FMT Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: FMTKEY (FMT Key)
References: ~ ASG.FORMAT
ASG.PGM_EXEC IMSTRANS Col 1: PGM_Key Char(8)
Col 2: IMSTRANS Key Char(8)
Primary Key: (PGM_Key, IMSTRANS Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: ITXNKEY (IMSTRANS Key)
References: ~ ASG.IMSTXN
ASG.PGM_EXEC TRANS Col 1: PGM_Key Char(8)
Col 2: TRANS Key Char(8)
Primary Key: (PGM_Key, TRANS Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: TRANSKEY (TRANS Key)
References: ~ ASG.CICSTXN
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ASG.PGM_EXECBY_CICSTXN Col 1: PGM_Key Char(8)
Col 2: CICSTRANS Key Char(8)
Primary Key: (PGM_Key, CICSTRANS Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: CITXNKEY (CICSTRANS Key)
References: ~ ASG.CICSTXN

ASG.PGM_HAS AREAS Col 1: PGM_Key Char(8)
Col 2: AREA Key Char(8)
Primary Key: (PGM_Key, AREA Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: AREAKEY (AREA Key)
References: ~ ASG.AREA

ASG.PGM_HAS_COLUMNS Col 1: PGM_Key Char(8)
Col 2: COLUMN Key Char(8)
Primary Key: (PGM_Key, COLUMN Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: COLKEY (COLUMN_Key)
References: ~ ASG.COLUMN

ASG.PGM_HAS _CURSOR Col I: PGM_Key Char(8)
Col 2: CURSOR_Key Char(8)
Primary Key: (PGM_Key, CURSOR Key)
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Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: CRSKEY (CURSOR_Key)
References: ASG.CURSOR
ASG.PGM_HAS DB Col 1: PGM_Key Char(8)
Col 2: DATABASE Key Char(8)
Primary Key: (PGM_Key, DATABASE Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: DBKEY (DATABASE Key)
References: ~ ASG.DATABASE
ASG.PGM_HAS ENTRY Col 1: PGM_Key Char(8)
Col 2: Entry Key Char(8)
Primary Key: (PGM_Key, Entry Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: ENTRYKEY (Entry Key)
References: ~ ASG.ENTRY
ASG.PGM_HAS FD Col 1: PGM_Key Char(8)
Col 2: FD Key Char(8)
Primary Key: (PGM _Key, FD Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
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Foreign Key: FDKEY (FD_Key)
References: ASG.FD
ASG.PGM_HAS IDMS Col 1: PGM_Key Char(8)
Col 2: IDMS_Key Char(8)
Primary Key: (PGM_Key, IDMS Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: IDMSKEY (IDMS_Key)
References: ~ ASG.IDMS
ASG.PGM_HAS IDMSMAP Col 1: PGM_Key Char(8)
Col 2: IDMSMAP_ Key Char(8)
Primary Key: (PGM_Key, IDMSMAP Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: IMAPKEY (IDMSMAP Key)
References: ~ ASG.IDMSMAP
ASG.PGM_HAS IDMSREC Col 1: PGM_Key Char(8)
Col 2: IDMSREC Key Char(8)
Primary Key: (PGM_Key, IDMSREC Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: IRECKEY (IDMSREC Key)
References: ~ ASG.IDMSRECORD
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ASG.PGM_HAS LREC Col 1: PGM_Key Char(8)
Col 2: LREC Key Char(8)
Primary Key: (PGM_Key, IDMS Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: LRECKEY (LREC Key)
References: ASG.LOGICALRECORD

ASG.PGM_HAS RECORDS Col 1: PGM_Key Char(8)
Col 2: RECORDS Key Char(8)
Primary Key: (PGM_Key, RECORDS Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: RECRDKEY (RECORDS Key)
References: ~ ASG.RECORD

ASG.PGM_HAS SCHEMA Col 1: PGM_Key Char(8)
Col 2: SCHEMA Key Char(8)
Primary Key: (PGM_Key, SCHEMA Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: SCHKEY (SCHEMA Key)
References: ~ ASG.SCHEMA

ASG.PGM_HAS SQL Col 1: PGM_Key Char(8)
Col 2: SQL Key Char(8)
Primary Key: (PGM_Key, SQL Key)

280



Appendix E - Export Language Reference

Table name Contents

Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: SQLKEY (SQL_Key)

References: ASG.SQL

ASG.PGM_HAS STOGROU Col 1: PGM_Key Char(8)
Col 2: STOGROUP_Key Char(8)
Primary Key: (PGM_Key, STOGROUP_Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: STGKEY (STRGROUP_Key)

References: ASG.STOGROUP

ASG.PGM_HAS SUBSCHEMA Col 1: PGM_Key Char(8)
Col 2: SUBSCHEMA_Key Char(8)
Primary Key: (PGM_Key,SUBSCHEMA Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: SUBKEY (SUBSCHEMA Key)

References: ASG.SUBSCHEMA

ASG.PGM_HAS TABLES Col 1: PGM Key Char(8)
Col 2: TABLE Key Char(8)
Primary Key: (PGM_Key,TABLE Key)
Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM

281



ASG-Alliance User’s Guide

Table name Contents

Foreign Key: TABLEKEY (TABLE Key)
References: ASG.TABLE

ASG.PGM_HAS TBLSP Col 1: PGM_Key Char(8)
Col 2: TABLESPACE Key Char(8)
Primary Key: (PGM_Key, TABLESPACE Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: TBLSPKEY (TABLESPACE Key)
References: ASG.TABLESPACE

ASG.PGM_HAS_VIEW Col 1: PGM_Key Char(8)
Col 2: VIEW Key Char(8)
Primary Key: (PGM_Key,VIEW Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: VIEWKEY (VIEW_Key)
References: ~ ASG.VIEW

ASG.PGM_IN MBR Col 1: PGM_Key Char(8)
Col 2: MBR Key Char(8)
Primary Key: (PGM_Key, MBR Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
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ASG.PGM_INCL_COPYMBR Col 1: PGM_Key Char(8)
Col 2: COPYMBR Key Char(8)
Primary Key: (PGM_Key, COPYMBR Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: CPYMBKEY (COPYMBR Key)
References: ~ ASG.COPYMBR

ASG.PGM_IS_CSECT Col 1: PGM_Key Char(8)
Col 2: CSECT Key Char(8)
Primary Key: (PGM_Key, CSECT Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: CSECTKEY (CSECT _Key)
References: ~ ASG.CSECT

ASG.PGM_LINK PGM Col 1: PGM _Key Char(8)
Col 2: PGM2 Key Char(8)
Primary Key: (PGM_Key, PGM2 Key)
Foreign Key: PGMKEY PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: PGM2KEY (PGM2_Key)
References: ~ ASG.PROGRAM

ASG.PGM_LINKEDBY PGM Col 1: PGM _Key Char(8)
Col 2: PGM2 Key Char(8)
Primary Key: (PGM_Key, PGM2 Key)
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Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: PGM2KEY (PGM_Key)
References: ASG.PROGRAM

ASG.PGM_USES CICSDD Col 1: PGM_Key Char(8)
Col 2: CICSDD_Key Char(8)
Primary Key: (PGM_Key, CICSDD Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: CIDDKEY (CICSDD_ Key)
References: ~ ASG.DD

ASG.PGM_USES_MAP Col 1: PGM_Key Char(8)
Col 2: MAP_ Key Char(8)
Primary Key: (PGM_Key, MAP Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: MAPKEY (MAP Key)
References: ~ ASG.MAP

ASG.PGM_USES_MAPSET Col 1: PGM_Key Char(8)
Col 2: MAPSET Key Char(8)
Primary Key: (PGM_Key, MAPSET Key)
Foreign Key: PGMKEY (PGM_Key)
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References: ASG.PROGRAM
Foreign Key: MAPSTKEY (MAPSET Key)
References: ASG.MAPSET
ASG.PGM_USES PSB Col 1: PGM_Key Char(8)
Col 2: PSB_Key Char(8)
Primary Key: (PGM_Key, PSB Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: PSBKEY (PSB_Key)
References: ~ ASG.PSB
ASG.PGM_USES_SEGMENT Col 1: PGM_Key Char(8)
Col 2: SEGMENT Key Char(8)
Primary Key: (PGM_Key, SEGMENT Key)
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
Foreign Key: SEGKEY (SEGMENT Key)
References: ~ ASG.SEGMENT
ASG.PPT IN MBR Col I: PPT Key Char(8)
Col 2: MBR_Key Char(8)
Primary Key: (PPT Key, MBR Key)
Foreign Key: PPTKEY (PPT Key)
References: ~ ASG.PPT
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER

285



ASG-Alliance User’s Guide

Table name Contents

ASG.PROC EXECBY_STEP Col 1: PROC_Key Char(8)
Col 2: STEP Key Char(8)
Primary Key: (PROC Key, STEP Key)
Foreign Key: PROCKEY (PROC_Key)
References: ASG.PROC
Foreign Key: STEPKEY (STEP Key)
References: ~ ASG.STEP

ASG.PROC HAS STEP Col 1: PROC Key Char(8)
Col 2: STEP Key Char(8)
Primary Key: (PROC Key, STEP Key)
Foreign Key: PROCKEY (PROC_Key)
References: ~ ASG.PROC
Foreign Key: STEPKEY (STEP_Key)
References: ~ ASG.STEP

ASG.PROC_IN_MBR Col 1: PROC_Key Char(8)
Col 2: MBR Key
Primary Key: (PROC Key, MBR Key)
Foreign Key: PROCKEY (REC Key)
References: ~ ASG.PROC
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER

ASG.PROGRAM HAS DATA Col 1: PROGRAM Key Char(8)
Col 2: DATA Key Char(8)
Primary Key: (PROGRAM Key,DATA Key)
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Foreign Key: PGMKEY (PROGRAM Key)
References: ASG.PROGRAM
Foreign Key: DATAKEY (DATA Key)
References: ASG.DATAITEM
ASG.PSB_HAS PCB Col 1: PSB_Key Char(8)
Col 2: PCB_Key Char(8)
Primary Key: (PSB_Key, PCB_Key)
Foreign Key: PSBKEY (PSB_Key)
References: ~ ASG.PSB
Foreign Key: PCBKEY (PCB_Key)
References:  ASG.PCB
ASG.PSB_IN MBR Col 1: PSB_Key Char(8)
Col 2: MBR_Key Char(8)
Primary Key: (PSB_Key, MBR Key)
Foreign Key: PSBKEY (PGM_Key)
References: ~ ASG.PSB
Foreign Key: MBRKEY (MBR Key)
References: ~ ASG.MEMBER
ASG.PSB_USDBY PGM Col 1: PSB_Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (PSB_Key, PGM_Key)
Foreign Key: PSBKEY (PSB_Key)
References: ~ ASG.PSB
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Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.REC_HAS DATAITEM Col 1: REC_Key Char(8)
Col 2: DATA Key Char(8)
Primary Key: (REC Key, DATA Key)
Foreign Key: RECKEY (REC Key)
References: ~ ASG.RECORD
Foreign Key: DATAKEY (DATA Key)
References: ~ ASG.DATAITEM
ASG.REC_REFBY MAPREC Col 1: RECORD_Key Char(8)
Col 2: MAPREC Key Char(8)
Primary Key: (RECORD_Key, MAPREC Key)
Foreign Key: RECRDKEY (RECORD_Key)
References: ~ ASG.RECORD
Foreign Key: MAPRCKEY (MAPREC Key)
References: ~ ASG.MAP
ASG.RECORD_IN_PGM Col 1: REC_Key Char(8)
Col 2: PROGRAM Key Char(8)
Primary Key: (REC_Key, PROGRAM Key)
Foreign Key: RECKEY (REC Key)
References: ~ ASG.RECORD
Foreign Key: PGMKEY (PROGRAM Key)
References: ~ ASG.PROGRAM

288



Appendix E - Export Language Reference

Table name Contents

ASG.RECORD USDBY_FD Col 1: RECORD_Key Char(8)
Col 2: FD Key Char(8)
Primary Key: (RECORD Key, FD Key)
Foreign Key: RECRDKEY (RECORD_Key)
References: ASG.RECORD
Foreign Key: FDKEY (FD Key)
References: ~ ASG.FD
ASG.RECORDS_IN_AREA Col 1: RECORDS_Key Char(8)
Col 2: AREA Key Char(8)
Primary Key: (RECORDS Key, AREA Key)
Foreign Key: RECRDKEY (RECORDS Key)
References: ~ ASG.RECORD
Foreign Key: AREAKEY (AREA Key)
References: ~ ASG.AREA
ASG.RECORDS_IN_LREC Col 1: RECORDS_Key Char(8)
Col 2: LREC Key Char(8)
Primary Key: (RECORDS Key, REC Key)
Foreign Key: RECRDKEY (RECORDS Key)
References: ~ ASG.RECORD
Foreign Key: LRECKEY (LREC Key)
References: ASG.LOGICALRECORD
ASG.RECORDS_IN_MAP Col 1: RECORDS_Key Char(8)
Col 2: MAP_ Key Char(8)
Primary Key: (RECORDS Key, MAP Key)
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Foreign Key: RECRDKEY (RECORDS Key)
References: ASG.RECORD
Foreign Key: MAPKEY (MAP_ Key)
References: ASG.MAP
ASG.SCHEMA HAS SUBSCHM Col 1: SCHEMA Key Char(8)
Col 2: SUBSCHEMA_Key Char(8)
Primary Key: (SCHEMA Key,
SUBSCHEMA Key)
Foreign Key: SCHEMKEY (SCHEMA Key)
References: ASG.SCHEMA
Foreign Key: SUBCKEY (SUBSCHEMA Key)
References: ASG.SUBSCHEMA
ASG.SCHEMA IN PGM Col 1: SCHEMA Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (SCHEMA Key, PGM_Key)
Foreign Key: SCHKEY (SCHEMA Key)
References: ASG.SCHEMA
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.SEGMENT HAS FIELD Col 1: SEGMENT Key Char(8)
Col 2: FIELD Key Char(8)
Primary Key: (SEGMENT Key, FIELD Key)
Foreign Key: SEGMTKEY (SEGMENT Key)
References: ASG.SEGMENT
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Foreign Key: FIELDKEY (FIELD Key)
References: ASG.SEGFIELD
ASG.SEGMENT HAS SEGMNT Col 1: SEGMENT Key Char(8)
Col 2: SEGMENT2 Key Char(8)
Primary Key: (SEGMENT Key,
SEGMENT2 Key)
Foreign Key: SEGMTKEY (SEGMENT Key)
References: ASG.SEGMENT
Foreign Key: SEGM2KEY (SEGMENT2 Key)
References: ASG.SEGMENT
ASG.SEGMENT IN DBD Col 1: SEGMENT Key Char(8)
Col 2: DBD Key Char(8)
Primary Key: (SEGMENT Key, DBD Key)
Foreign Key: SEGMTKEY (SEGMENT Key)
References: ASG.SEGMENT
Foreign Key: DBDKEY (DBD Key)
References: ASG.DBD
ASG.SEGMENT IN SEGMENT Col 1: SEGMENT Key Char(8)
Col 2: SEGMENT2 Key Char(8)
Primary Key: (SEGMENT Key,
SEGMENT2 Key)
Foreign Key: SEGMTKEY (SEGMENT Key)
References: ~ ASG.SEGMENT
Foreign Key: SEGM2KEY (SEGMENT2 Key)
References: ~ ASG.SEGMENT
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ASG.SEGMENT_USDBY_PGM Col 1: SEGMENT Key Char(8)

Col 2: PGM_Key Char(8)

Primary Key: (SEGMENT Key, PGM_Key)

Foreign Key: SEGKEY (SEGMENT Key)

References: ASG.SEGMENT

Foreign Key: PGMKEY (PGM_Key)

References: ~ ASG.PROGRAM
ASG.SENFLD_IN_SENSEG Col 1: SENFIELD Key Char(8)

Col 2: SENSEG Key Char(8)

Primary Key: (SENFIELD Key, SENSEG Key)

Foreign Key: SENFDKEY (SENFIELD Key)

References: ~ ASG.SENFIELD

Foreign Key: SENSGKEY (SENSEG_Key)

References: ~ ASG.SENSEG
ASG.SENSEG_HAS_SENFLD Col 1: SENSEG_Key Char(8)

Col 2: SENFIELD Key Char(8)

Primary Key: (SENSEG Key, SENFIELD Key)

Foreign Key: SENSG (SENSEG_Key)

References: ~ ASG.SENSEG

Foreign Key: SENFDKEY (SENFIELD Key)

References: ~ ASG.SENFIELD
ASG.SENSEG_HAS_SENSEG Col 1: SENSEG_Key Char(8)

Col 2: SENSEG2 Key Char(8)

Primary Key: (SENSEG_Key, SENSEG2 Key)
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Foreign Key: SENSGKEY (SENSEG Key)
References: ASG.SENSEG
Foreign Key: SENS2KEY (SENSEG2 Key)
References: ASG.SENSEG
ASG.SENSEG IN PCB Col 1: SENSEG Key Char(8)
Col 2: PCB_Key Char(8)
Primary Key: (SENSEG_Key, PCB Key)
Foreign Key: SENSGKEY (SENSEG_Key)
References: ~ ASG.SENSEG
Foreign Key: PCBKEY (PCB_Key)
References:  ASG.PCB
ASG.SENSEG_IN_SENSEG Col I: SENSEG_Key Char(8)
Col 2: SENSEG2 Key Char(8)
Primary Key: (SENSEG_Key, SENSEG2 Key)
Foreign Key: SENSGKEY (SENSEG_Key)
References: ~ ASG.SENSEG
Foreign Key: SENS2KEY (SENSEG2 Key)
References: ~ ASG.SENSEG
ASG.SOURCE INCL MEMBER Col 1: SOURCE_Key Char(8)
Col 2: MEMBER Key Char(8)
Primary Key: (SOURCE_Key, MEMBER Key)
Foreign Key: SRCKEY (SOURCE Key)
References: ~ ASG.MEMBER
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Foreign Key: MBRKEY (MEMBER Key)
References: ASG.COPYMEMBER
ASG.SQL_IN_PGM Col 1: SQL_Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (SQL_Key, PGM_Key)
Foreign Key: SQLKEY (SQL_Key)
References: ASG.SQL
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
ASG.STEP_EXECS LM Col 1: STEP Key Char(8)
Col 2: LM_Key Char(8)
Primary Key: (STEP Key, LM Key)
Foreign Key: STEPKEY (STEP_Key)
References: ~ ASG.STEP
Foreign Key: LMKEY (LM Key)
References: ~ ASG.LOADMODULE
ASG.STEP_EXECS PROC Col 1: STEP_Key Char(8)
Col 2: PROC Key Char(8)
Primary Key: (STEP_Key, PROC _Key)
Foreign Key: STEPKEY (STEP_Key)
References: ~ ASG.STEP
Foreign Key: PROCKEY (PROC_Key)
References: ~ ASG.PROC
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ASG.STEP_HAS DD Col 1: STEP Key Char(8)
Col 2: DD Key Char(8)
Primary Key: (STEP_Key, DD Key)
Foreign Key: STEPKEY (STEP_Key)
References: ASG.STEP
Foreign Key: DDKEY (DD Key)
References:  ASG.DD

ASG.STEP_IN JOB Col 1: STEP Key Char(8)
Col 2: JOB_Key Char(8)
Primary Key: (STEP_Key, JOB Key)
Foreign Key: STEPKEY (STEP_Key)
References: ~ ASG.STEP
Foreign Key: JOBKEY (JOB_Key)
References: ~ ASG.JOB

ASG.STEP_IN PROC Col 1: STEP Key Char(8)
Col 2: PROC Key Char(8)
Primary Key: (STEP_Key, PROC _Key)
Foreign Key: STEPKEY (STEP_Key)
References: ~ ASG.STEP
Foreign Key: PROCKEY (PROC_Key)
References: ~ ASG.PROC

ASG.STEP_USES_CATALOG Col I: STEP_Key Char(8)
Col 2: CATALOG Key Char(8)
Primary Key: (STEP_Key, CATALOG Key)
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Foreign Key: STEPKEY (STEP_Key)
References: ASG.STEP
Foreign Key: CATKEY (CATALOG Key)
References: ASG.CATALOG
ASG.STEP_USES LIBRARY Col 1: STEP Key Char(8)
Col 2: LIBRARY Key Char(8)
Primary Key: (STEP Key, LIBRARY Key)
Foreign Key: STEPKEY (STEP_Key)
References: ~ ASG.STEP
Foreign Key: LIBKEY (LIBRARY Key)
References: ~ ASG.LIBRARY
ASG.STOGP _HAS DATABASE Col 1: STOGRP_Key Char(8)
Col 2: DATABASE Key Char(8)
Primary Key: (STOGRP Key, DATABASE Key)
Foreign Key: STOGPKEY (STOGRP Key)
References: ~ ASG.STOGROUP
Foreign Key: DBASEKEY (DATABASE Key)
References: ~ ASG.DATABASE
ASG.STOGROUP_IN_PGM Col 1: STOGROUP_Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (STOGROUP_Key, PGM_Key)
Foreign Key: STGKEY (STOGROUP_Key)
References: ~ ASG.STOGROUP

296



Appendix E - Export Language Reference

Table name Contents

Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.SUBSCH_HAS AREAS Col 1: SUBSCHEMA_ Key Char(8)
Col 2: AREA Key Char(8)
Primary Key: SUBSCHEMA Key, AREA Key)
Foreign Key: SUBKEY (SUBSCHEMA Key)
References: ~ ASG.SUBSCHEMA
Foreign Key: AREAEKEY (AREA Key)
References: ~ ASG.AREA
ASG.SUBSCHEMA HAS_LREC Col 1: SUBSCHEMA Key Char(8)
Col 2: LREC Key Char(8)
Primary Key: (SUBSCHEMA Key, LREC Key)
Foreign Key: SUBSCKEY (SUBSCHEMA Key)
References: ~ ASG.SUBSCHEMA
Foreign Key: LRECKEY (LREC Key)
References: ASG.LOGICALRECORD
ASG.SUBSCHEMA IN PGM Col 1: SUBSCHEMA Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (SUBSCHEMA Key, PGM_Key)
Foreign Key: SUBKEY (SUBSCHEMA Key)
References: ~ ASG.SUBSCHEMA
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
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ASG.SUBSCHM_IN SCHEMA Col 1: SUBSCHEMA_Key Char(8)
Col 2: SCHEMA Key Char(8)
Primary Key: (SUBSCHEMA Key,

SCHEMA Key)

Foreign Key: SUBSCKEY (SUBSCHEMA Key)
References: ASG.SUBSCHEMA
Foreign Key: SCHEMKEY (SCHEMA Key)
References: ASG.SCHEMA

ASG.TABLE HAS COLUMNS Col 1: TABLE Key Char(8)
Col 2: COLUMNS Key Char(8)
Primary Key: (TABLE Key, COLUMNS Key)
Foreign Key: TABLEKEY (TABLE Key)
References: ASG.TABLE
Foreign Key: COLUMKEY (COLUMNS Key)
References: ASG.COLUMN

ASG.TABLES IN PGM Col 1: TABLE Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (TABLE Key, PGM Key)
Foreign Key: TABLEKEY (TABLE Key)
References: ASG.TABLE
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM

ASG.TABLES IN TBLSP Col 1: TABLES Key Char(8)
Col 2: TBLSP Key Char(8)
Primary Key: (TABLES Key, TBLSP Key)
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Foreign Key: TABLEKEY (TABLES Key)
References: ASG.TABLE
Foreign Key: TBLSPKEY (TBLSP Key)
References: ASG.TABLESPACE
ASG.TBLSP_HAS TABLES Col 1: TBLSP_Key Char(8)
Col 2: TABLES Key Char(8)
Primary Key: (TBLSP Key, TABLES Key)
Foreign Key: TBLSPKEY (TBLSP_Key)
References: ASG.TABLESPACE
Foreign Key: TABLEKEY (TABLES Key)
References:  ASG.TABLE
ASG.TBLSP_HAS VIEWS Col 1: TBLSP Key Char(8)
Col 2: VIEWS Key Char(8)
Primary Key: (TBLSP Key, TBLSP Key)
Foreign Key: TBLSPKEY (TBLSP_Key)
References: ASG.TABLESPACE
Foreign Key: VIEWSKEY (VIEWS Key)
References: ~ ASG.VIEW
ASG.TBLSP_IN DATABASE Col 1: TBLSP Key Char(8)
Col 2: DATABASE Key Char(8)
Primary Key: (TBLSP Key, DATABASE Key)
Foreign Key: TBLSPKEY (TBLSP_Key)
References: ASG.TABLESPACE
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Foreign Key: DBASEKEY (DATABASE Key)
References: ASG.DATABASE
ASG.TBLSP_IN PGM Col 1: TBLSP_Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (TBLSP Key, PGM_Key)
Foreign Key: TBLSPKEY (TBLSP_Key)
References: ASG.TABLESPACE
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
ASG.TRANS EXECBY PGM Col 1: TRANS_Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (TRANS Key, PGM Key)
Foreign Key: TRANSKEY (TRANS Key)
References:  ASG.CICSTXN
Foreign Key: PGMKEY (PGM_Key)
References: ~ ASG.PROGRAM
ASG.VIEW_HAS COLUMNS Col 1: VIEW_Key Char(8)
Col 2: COLUMNS Key Char(8)
Primary Key: (VIEW_Key, COLUMNS Key)
Foreign Key: VIEWKEY (VIEW_Key)
References:  ASG.VIEW
Foreign Key: COLUMKEY (COLUMNS Key)
References: ~ ASG.COLUMN
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ASG.VIEWS IN PGM Col 1: VIEW_ Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (VIEW_Key, PGM_Key)
Foreign Key: VIEWKEY (VIEW_Key)
References: ASG.VIEW
Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM

ASG.VIEWS IN TBLSP Col 1: VIEWS Key Char(8)
Col 2: TBLSP_Key Char(8)
Primary Key: (VIEWS Key, TBLSP_Key)
Foreign Key: VIEWSKEY (VIEWS Key)
References: ~ ASG.VIEW
Foreign Key: TBLSPKEY (TBLSP_Key)

References: ASG. TABLESPACE

Exporting to Transition Enablement Facility (TEF)

Alliance has an optional TEF export feature you can use to export a defined and analyzed
application to Texas Instruments Transition Enablement Facility (TI-TEF). The
application (that is, a group of programs and associated components) is created and stored
in the AKR. The application components and attributes are defined.

To export to TEF
1  Review and edit the defined application online.

For more information on these procedures see the ASG-Application Definition and
Analysis User’s Guide.
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Analyze the defined application, and review the results of the analyze.

For more information on these procedures see the ASG-Application Definition and
Analysis User’s Guide.

Export the analyzed information (including data model and control flow model)
exported to TEF.

. A batch job is submitted to build the input for TEF.

. The information is exported into three output files (Object, Association, and
Properties) that are suitable for TEF Release 2.0.

. TEF manipulates this information into a loadable model format for use in
Texas Instruments Composer Release 5.3 (for example, an Information
Engineering Facility product).

For additional information on these terms, see the Texas Instruments TEF and Composer

documentation:
Attribute (ATTRUSR) Entity type (HLENT)
Business system Expected effects
Common action block Function
CRUD Procedure (BUSPROC)
Dialog flow (DLGFLOW) Procedure step (BUSPRST)
Elementary process Subject area (SUBJ)

TEF Objects

Data Model

302

When you create TEF objects to represent information in the AKR and the TEF object
has a name property, the actual name of the object is used. You may modify the name
with descriptive text, but the name itself is that of the entity found in the AKR and
derived from the application. All other TEF properties are fully populated, except as
noted.

The TEF Export option provides you with data model information that is based on the
data structures and database activity within programs.

When CRUD (Create, Read, Update, Delete) activity is identified, TEF objects and
relationships are created to represent local records and database entities involved in
the activity.

TEF objects and relationships are created to represent the CRUD activity itself and
its association to the program.

Any remaining data structures defined to the program are also represented.



Record Analysis
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The TEF Export option includes detailed information on COBOL programs. A complete
analysis of COBOL records is performed that includes REDEFINES and OCCURS
clauses.

To determine file layout, you apply the buffering analysis to each record involved in
CRUD activity. The buffering analysis is performed when CRUD activity determines that
a TEF entity type should be created for a record.

Buffering analysis checks each record for a single field element. A single field
element can be a single description at the record level, for example, 01 XYZREC
PIC X (132).Ifthe record has a single field, direct assignments to and from the
record are processed and evaluated. This process continues until a multi-component
record is found or no other direct assignments are found.

TEF objects are created for multi-component records. When multiple TEF entity
types are created for a record, each entity type is linked to the same TEF subject
area. If no multi-component records are found, TEF objects are created for the
original record involved in the CRUD activity.

This is the data the exported field information for COBOL records includes:

Database Entities

Name

Length (memory size)
Number of decimal places
Domain

Permitted values (VALUE clause)

The TEF Export option creates a complete representation of DB (database) entities
involved in CRUD activity. These are the supported database models:

IMS (except IMS GSAM DB) . DB2
CICS . COBOL file operations
IDMS
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CRUD Activity/Expected Effects

IMS

CICS
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CRUD activity is generated for all supported DB entities: IMS segments, CICS files,
IDMS records, DB2 tables, and COBOL files. These are the expected effects:

. All programs encountered cause a function and elementary process TEF object to
be created.

. Only programs with CRUD activity generate expected effects.

. An expected effect is created for each unique DB entity when CRUD activity is
detected within the program.

. Each expected effect is linked to the appropriate function and elementary process
TEF objects.

The database instructions that determine CRUD activity/expected effects are outlined in
these tables for IMS, CICS, IDMS, DB2, and COBOL:

INSERT CREATE
GET READ

REPLACE UPDATE
DELETE DELETE

WRITE CREATE
READ, READNEXT, READPREV READ

REWRITE UPDATE
DELETE DELETE
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IDMS
Database Instruction CRUD Activity
STORE, MODIFY CREATE
GET, OBTAIN, MODIFY, FIND READ
STORE UPDATE
ERASE DELETE

DB2
Database Instruction CRUD Activity
INSERT CREATE
SELECT, FETCH READ
UPDATE UPDATE
DELETE, DROP DELETE

COBOL
Database Instruction CRUD Activity
WRITE CREATE
READ READ
REWRITE UPDATE
DELETE DELETE

Assembler Language Option

Database instruction CRUD activity
READ READ
PUT CREATE (UPDATE)*

GET READ (UPDATE)*
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Database instruction CRUD activity
PUTX CREATE (UPDATE)*
WRITE CREATE (UPDATE)*

* For these activities, the CREATE attribute is set, unless the open macro indicates that
the CRUD information should be UPDATE instead. The open parameters, indicating
UPDATE instead of CREATE, are INOUT and UPDATE.

Data Model Description

IMS Data Model Within the program, CRUD activity involving IMS entities is
detected. TEF objects are created for both the IMS entities
and local records. Expected effects are generated for the
entity type created for the IMS segment.

CICS Data Model Within the program, CRUD activity involving CICS files is
detected. TEF objects are created for both CICS entities and
local records. Expected effects are generated for entity types
that are created for local records.

IDMS Data Model Within the program, CRUD activity on IDMS records and
logical records is detected. When logical records are used,
the component records are resolved and used as the actual
record(s) of reference. TEF objects are created for both
IDMS records and local records. Expected effects are
generated for the entity types created for IDMS records or
logical records.

DB2 Data Model Within the program, CRUD activity involving DB2 Tables is
detected. TEF objects are created for both the DB2 entities
and local records. Expected effects are generated for the
entity types created for DB2.

COBOL File Operations  Within the program, CRUD activity involving COBOL file

Data Model operations is detected. TEF objects are created for both the
file and the records. Expected effects are generated for the
entity types created for local records.

Control Flow Model The TEF Export option provides control flow model
information for both batch and online processes. Batch
information is determined by JCL jobs, JCL procedures, and
JCL steps. Online information is determined by transactions
and screens. When analysis reaches the program level,
program control flow is established (see "Program Control
Flow" on page 311).

306



Appendix E - Export Language Reference

For each exported application, three business systems are created to represent the control
flow model:

Note:

BATCH JOB application name—This business system is a representation of
the batch jobs defined in the application.

BATCH PROC application name—This business system is a representation
of the JCL procedures executed by the jobs defined in the application.

ON-LINE application name—This Business System is a representation of
the IMS, CICS, and IDMS online activities defined in the application.

IMS BMP applications fall under the appropriate representation for batch activities.

Batch Control Flow
Batch control flow starts with each JCL job defined to the application.

To establish Batch control flow

1

From the JCL job, control flow goes to each of the JCL steps. A procedure is created
for the JCL job.

From each JCL step, control flow goes to the executed program or executed JCL
procedure.

. A procedure step is created for the program executed by the JCL step; the
procedure step is associated to the procedure created for the JCL job.

»  Appropriate TEF objects are created for the program, as determined by the
program control flow (see "Program Control Flow" on page 311).

. If the step executes a JCL procedure, a dialog flow object is created to the
procedure step that was created for the JCL procedure.

From each JCL procedure, the control flow goes to each step within the procedure.
A procedure and procedure step are created for the JCL procedure.

From each procedure step, the control flow goes to the executed program or executed
JCL procedure. Control flow at the program level is covered in "Program Control
Flow" on page 311 . The steps within the JCL procedure are processed in the same
manner as steps for a JCL job, except that the procedure steps created are associated
to the procedure created for the JCL procedure.

This process is repeated until all control flow paths are represented.
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Online Control Flow

Online control flow starts with transactions or screens. TEF objects are created to
represent the physical screen display.

To establish online control flow
1 From a transaction, control flow goes to the executed program.
2 From a screen, control flow goes to other screens and to transactions.

3 From a program, control flow goes to transactions and screens invoked by the
program (see "Program Control Flow" on page 311).

Screens Supported
These are the screens supported by the TEF Export option:
. BMS maps (CICS)
. IMS formats
. IDMS maps
For all screens (except IDMS Maps), information on the physical display attributes of the

fields is generated. This field information is supplied in TEF Screen Literal objects, and
includes this data:

. Row . Color
. Column . Intensity
. Literal value (if any) . Highlight

. Field length

Invoking a Screen From Multiple Programs

When a screen is invoked by a program, a procedure step (TEF object) is created to
represent the screen. The procedure step is linked to the procedure that contains the
invoking entity. These are the procedure rules:

. A procedure step can be linked to only one procedure.
. If the screen is used by more than one procedure:
—  One procedure and one procedure step are created for the screen.

—  All procedures using the screen have dialog flows created from their
respective procedure steps to the procedure step created for the screen.
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This information applies to these subsections:
—  IMS online control flow
—  CICS online control flow

— IDMS online control flow

IMS Online Control Flow

IMS formats are referenced generically within programs, but can have multiple device
definitions (with multiple pages) for each device. Because of the multiple device
definitions with multiple pages, a series of procedure steps are created for each IMS
format. These are the steps of the procedure created for each IMS format:

IMS Control Flow

Each MOD (Message Output Description) within the format is represented by a
procedure and procedure step. The procedure step created for the MOD is the origin
or destination for all control flows represented by dialog flows.

Within the MOD definitions, each DOF (Device Output Format) is searched for
device definitions.

A procedure step represents each page within the device definitions. The DFLD
(Defined Field) definitions within the device definition are used to create the screen
literal information.

Pages are associated to the procedure created for the MOD. Each device/page is
given a name in this format:

<device> "PAGE" <page number>

IMS control flow is controlled by the formats and transactions defined to the application.
Control flow is generated on these relationships:

IMS-FORMAT EXECUTES IMS-TRANSACTION

IMS-FORMAT EXECUTES IMS-FORMAT
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IMS-TRANSACTION (relationship) PROGRAM
PROGRAM EXECUTES IMS-FORMAT
PROGRAM EXECUTES IMS TRANSACTION

Note:

This is the relationship in the AKR:
IMS-TRANSACTION EXECUTES LOADMODULE
LOADMODULE HAS CSECT

CSECT IS PROGRAM

. IMS transactions and formats (as listed above) are represented by procedures.

. The program executed by the IMS transaction becomes the procedure step for the
transaction (except in cases explained in "Program Control Flow" on page 311 .).

. The relationships listed above and the program control flow analysis are used to
establish links between procedure steps.

CICS Online Control Flow

CICS online control flow is based on BMS map invocation, transaction execution on the
program level, and on the transactions defined to the application.

. Each transaction is represented by a procedure.
. The program executed by the transaction:
—  Becomes the procedure step, unless it invokes a BMS map.

—  Ifthe program executed invokes a BMS map, the BMS map is represented
by a procedure step and the program is represented by a Common Action
Block.

. A CALLs association is established to link the procedure step for the BMS map to
the Common Action Block for the program.

Program control flow is followed to establish links between procedure steps.
IDMS Online Control Flow
IDMS online control flow is based solely on IDMS map invocation.

. Program control flow, if transferred to other programs using the IDMS map, creates
a dialog flow object.

. The dialog flow object links the procedure steps created for the IDMS map.
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Program Control Flow

When any form of control flow (that is, batch or online) reaches a program, detailed
external control flow analysis of the program is represented by TEF objects and
relationships. Control flow from the program to screens, transactions, and other programs
is established.

TEF Objects Created for Programs

Depending on the activity of the program represented, the TEF object created may be a
procedure, procedure step, or Common Action Block.

Procedure Step and Procedure

. Procedure steps are always created for programs that contain these activities:
PROGRAM EXECUTES CICS-TRANSACTION
PROGRAM EXECUTES IMS-TRANSACTION

PROGRAM EXECUTES IMS-FORMAT

. Procedure steps are always created for programs that are the target of these
activities.
CICS-TRANSACTION EXECUTES PROGRAM
IMS-TRANSACTION (EXECUTES) PROGRAM

JCL STEP (EXECUTES) PROGRAM

Note:
This is the (EXECUTES) relationship in the AKR:
<ENTITY> EXECUTES LOADMODULE
LOADMODULE HAS CSECT

CSECT IS PROGRAM

. The procedure step created is linked to the procedure that initiated the control flow
path to the program, unless more than one control flow path reaches the program.

. If more than one control flow path reaches the program, a procedure is also created
for the program.

—  The procedure step created for the program is associated to the procedure
created for the program.

— Dialog flow is established from the procedure steps, in all invoking
control flow paths, to the procedure step created for the program.

311



ASG-Alliance User’s Guide

Common Action Block

All other known program activities (including batch execution) create a Common Action
Block to represent the program. Invoking TEF objects have a CALLSs association to the
Common Action Block created for the program.

Procedure Step Links

You can execute several programs from a procedure step object before another procedure
step object is encountered.

. Each intermediate program is represented by a Common Action Block with CALLs
association to subsequent programs.

. When a procedure step object is encountered, a dialog flow is created from the
encountered procedure step to the procedure step of origin.

Program Control Flow Path

These control flow paths are evaluated with Program Control Flow analysis:

PROGRAM EXECUTES IMS-TRANSACTION IDMS DC RETURN

PROGRAM EXECUTES CICS-TRANSACTION IDMS TRANSFER CONTROL

EXEC CICS XCTL BMS MAP INVOCATION

EXEC CICS LINK IDMS MAP INVOCATION

COBOL CALL PROGRAM EXECUTES IMS-FORMAT

Online TEF Export Procedure
To export application data to TEF
1 Start Alliance using the procedure defined for your site.

2 Select File » Open application and press Enter. The AMF panel displays as the
default.

3 Select File » Export application and press Enter.
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4  Select File - Export Definition pop-up » Export Data and press Enter. The
Data Export pop-up (see Figure 91) displays.

Figure 91 » Data Export Pop-up

Data Export
CoHHand ===

specify options and jobcard infornation. Then press PF key for action.

WARNING! Zelecting “Edit JCL" or "Eubdit JCL" will delete any edisting
edport files created under this userid.

Export Type __ 1. Flat Files DB2 ZubsysteH:
2. DB2 Load
I. COOLIGen EXport

Job statenent infornation:

“*NAHE JOE [ACCOUNT ). NAME,

o HEGCLAZE=A

<t INZERT *~ROUTE PRINT NODE.UZER' HERE IF NEEDED.
ok

PF4=COOLIGen Export Options PFS=E4it JCL  PFE=:ubmit JCL

5 In the Export Type field of the Data Export pop-up, type 3 to select TI-Export.
6  Under Job statement information, enter the information required for your site.

7 To edit the generated JCL file before submitting the export job, press the Edit JCL
key.

8  Add export parameters to the parm string specified for the extract step, as required
(Exec Pgm = VIABTIEF). For a definition of the available export parameters, see
"TEF Export Parameters" on page 314. Add these parameters after the existing
application parameter. Include export parameters in any order, as shown:

PARM= (' APPL=applicationname, NOWORKSET, NOPERMVAL, NOBSD, LEN254 ")
9 After editing the JCL, submit the job using the TSO/ISPF SUBMIT command.

10 To execute the export request without editing the generated JCL, press PF6 to submit
the JCL.

Note:
If an unresolvable entity is detected during the export, a message is sent to the VIALOG
file. You should review the VIALOG file after each export to identify any entities not
represented with corresponding TEF objects.
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TEF Export Parameters

Add these TEF export parameters to the parm string specified for extract step
(Exec Pgm = VIABTIEF):

Parameter Description

NOWORKSET Suppresses the generation of data model information,
SUBJECT, HLENT, ATTRIBUTE, etc., for records that are
not involved in CRUD activity.

NOPERMVAL Suppresses the generation of the permitted values property for
attributes.
NOBSD Suppresses the generation of the control flow model

information, such as Business System Design (BSD).

LEN254 Specifies a maximum length of 254 bytes, for any textual field
in the model.
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